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Introduction

The Adafruit Feather nRF52 Bluefruit is our latest easy-to-use all-in-one Bluetooth Low Energy board, with a native-
bluetooth chip, the nRF52832! It's our take on an 'all-in-one' Arduino-compatible + Bluetooth Low Energy with built in
USB and battery charging.

This chip has twice the flash, SRAM and performance of the earlier nRF51-based Bluefruit modules. Best of all it has
Arduino IDE support so there is no 'helper' chip like the ATmega32u4 or ATSAMDZ21. Instead, this chip is programmed
directly! It's got tons of awesome peripherals: plenty of GPIO, analog inputs, PWM, timers, etc. Leaving out the extra
microcontroller means the price, complexity and power-usage are all lower/better. It allows you to run code directly on
the nRF52832, straight from the Arduino IDE as you would with any other MCU or Arduino compatible device. A single
MCU means better performance, lower overall power consumption, and lower production costs if you ever want to
design your own hardware based on your Bluefruit nRF52 Feather project!

The chips are pre-programed with an auto-resetting bootloader so you can upload quickly in the Arduino IDE with no
button-pressing. Want to program the chip directly? You can use our command line tools with your favorite editor and
toolchain.

And to get you up and running quickly, we've done all the heavy lifting of getting the low level BLE stack into shape so
that you can focus on your project from day one!

NRF52832 Technical Details

ARM Cortex M4F (with HW floating point acceleration) running at 64MHz

512KB flash and 64KB SRAM

Built in USB Serial converter for fast and efficient programming and debugging

Bluetooth Low Energy compatible 2.4GHz radio (Details available in the nRF52832 product specification)
FCC /IC / TELEC certified module

Up to +4dBm output power

1.7v to 3.3v operation with internal linear and DC/DC voltage regulators

19 GPIO, 8 x 12-bit ADC pins, up to 12 PWM outputs (3 PWM modules with 4 outputs each)

Pin #17 red LED for general purpose blinking

Power/enable pin

Measures 2.0" x 0.9" x 0.28" (51mm x 23mm x 8mm) without headers soldered in

Light as a (large?) feather - 5.7 grams

4 mounting holes

Reset button

Optional SWD connector for debugging

Works out of the box with just about all of our Adafruit FeatherWings! (Wings that require the UART like the GPS
FeatherWing won't work)

Further technical details available in the nRF52832 product specification.

Like all of our Feather boards, the Bluefruit NnRF52 Feather includes on board USB-based LIPO charging, and

has a standard LIPO battery connector to make your wireless projects genuinely 'wireless' at no additional
cost (aside from the LIPO cell itself).
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NRF51 or nRF52 Bluefruit Devices?

The Bluefruit NnRF52 Feather (based on the nRF52832 SoC) is quite different from the earlier nRF51822 based Bluefruit
products (Bluefruit MO Feather, etc.), both of which will continue to exist.

From a hardware perspective, the nRF52 Feather is based on a much more powerful ARM Cortex M4F processor, with
512KB flash, 64KB SRAM and hardware floating point acceleration ... whereas the earlier nRF51822 is based on the
smaller ARM Cortex MO core (fewer internal instructions), with 256KB flash and either 16KB or 32KB SRAM.

More importantly, the design approach that we took with the nRF52 is completely different:
e nRF51 based Bluefruit boards run as modules that you connect to via an external MCU (typically an Atmel 32u4 or
a SAMD21), sending AT style commands over SPI or UART.

e With the nRF52, you run all of your code directly on the nRF52832 and no external MCU is used or required!

This change of design helps keep the overall costs lower, allows for far better performance since you aren't limited by
the SPI or UART transport channel, and can help improve overall power consumption.

As a tradeoff, it also means a completely different APl and development process, though!

nRF51 Bluefruit sketches won't run on nRF52 Bluefruit hardware without modification! The two device families

have different APIls and programming models, and aim to solve your wireless problems in two different ways.
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Device Pinout
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BLUEFRUIT NRF52 FEATHER PINOUT

PIN_LED1/ P07

RESET
3.3V OUTPUT
3.3V OUTPUT
GND
AO / P0.02 LIPO INPUT (VBAT)
A1/ P0.03 ] VREG ENABLE
A2 / P0.04 E ] USB POWER (VBUS)
A3/ P0.05 =L ] P0.16
A4/ P0.28 | |5 ] P0I5
A5 / P0.29 LAY Po.07
SCK / P0.12 LX) PO
MOSI/P013 [ ITEE i, :‘;: ™Y P0.31/ A7 (VBAT ADC)
MISO/P014 [ IGEIE 1_EY ] Po.30/A6
< TXD/P0.08 [ RET =L ] Po.27
> RXD/P0.06 PN 3 PP scL/Po.26
PIN_DFU / P0.20 ‘| . : "N SDA / P.025
1

FRST / P0.22 (TP2)
ON BOTTOM

|

PIN_LED2 / P0.19

Special Notes

The following pins have some restrictions that need to be taken into account when using them:

e PIN_DFU / P0.20: If this pin is detected to be at GND level at startup, the board will enter a special serial
bootloader mode and will not execute any user code, going straight into bootloader mode. If you wish to use this
pin as a standard GPIO, make sure that it is pulled high with a pullup resistor so that your code will execute
normally when the MCU starts up.

e PO0.31/ A7: This pin is hard wired to a voltage-divider on the LIPO battery input, allow you to safely measure the
LIPO battery level on your device. If possible, you should avoid using this pin directly.

e FRST/P0.22: Setting this pin to GND at startup will cause the device to perform a factory reset at startup, erasing
and config data as well as the user sketch. At the next reset, you should enter serial bootloader mode by default,
since no user sketch will be present. You can use this to recover 'bricked' boards, but if you don't wish to do this
be careful not to have FRST low at startup. By default, a weak internal pull-up resistor is enabled on this pin
during the bootloader phase.

Power Pins

e 3.3V Output: This two pins are connected to the output of the on board 3.3V regulator. They can be used to
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supply 3.3V power to external sensors, breakouts or Feather Wings.

e LIPO Input (VBAT): This is the voltage supply off the optional LIPO cell that can be connected via the JST PH
connector. It is nominally V3.5-4.2V.

e VREG Enable: This pin can be set to GND to disable the 3.3V output from the on board voltage regulator. By
default it is set high via a pullup resistor.

e USB Power (VBUS): This is the voltage supply off USB connector, nominally 4.5-5.2V.

Analog Inputs

The 8 available analog inputs can be configured to generate 8, 10 or 12-bit data (or 14-bits with over-sampling), at
speeds up to 200kHz (depending on the bit-width of the values generated), based on either an internal 0.6V reference
or the external supply.

The following default values are used:

e Default voltage range: 0-3.6V (uses the internal 0.6V reference with 1/6 gain)
e Default resolution: 10-bit (0..4095)

Unlike digital functions, which can be remapped to any GPIO/digital pin, the ADC functionality is tied to

specified pins, labelled as A* in the image above (A0, A1, etc.).

PWM Outputs

Any GPIO pin can be configured as a PWM output, using the dedicated PWM block.

Three PWM modules can provide up to 12 PWM channels with individual frequency control in groups of up to four
channels.

Please note that DMA based PWM output is still a work in progress in the initial release of the nR52 BSP, and

further improvements are planned here.

[2C Pins

12C pins on the nRF52832 require external pullup resistors to function, which are not present on the Adafruit nRF52
Feather by default. You will need to supply external pullups to use these. All Adafruit I12C breakouts have appropriate
pullups on them already, so this normally won't be an issue for you.
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Assembly
We ship Feathers fully tested but without headers attached - this gives you the most flexibility on choosing how to use
and configure your Feather

Header Options!
Before you go gung-ho on soldering, there's a few options to consider!
The first option is soldering in plain male headers, this

lets you plug in the Feather into a solderless
breadboard

HEHHHHHIMH!

IIIHHI HHHHHHHH

HEIHI!H ﬂfqlfﬂf

11 |‘\IH'I|\'|'J||I'
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Another option is to go with socket female headers. This
won't let you plug the Feather into a breadboard but it
will let you attach featherwings very easily
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We also have 'slim' versions of the female headers, that
are a little shorter and give a more compact shape

iw?i - i#si.-“lti*i-?_-iﬁ.l R s o
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Finally, there's the "Stacking Header" option. This one is
sort of the best-of-both-worlds. You get the ability to
plug into a solderless breadboard and plug a
featherwing on top. But its a little bulky

Soldering in Plain Headers
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Prepare the header strip:
EamEs sasEw sEsss sssss | Cut the strip to length if necessary. It will be easier to

e e e S solder if you insert it into a breadboard - long pins down

SN REETEIE S Ea s ]
- .. L - .o
LN B | B -

Tna Wwn

BA RN e EE RN G

EE N R E NN N RN ENa

= @ W W W EEEWE Y EEEEEE W -
=E R W W R EEFEE AW LI I
L ] e =
= ; T Ea
- TEEEELEE NN [
EdUYEBRREORYEIsAARRs a2 -
+ +

o

© Adafruit Industries https://learn.adafruit.com/bluefruit-nrf52-feather-learning-guide Page 16 of 158


https://learn.adafruit.com/assets/30183

Add the breakout board:

Place the breakout board over the pins so that the short
pins poke through the breakout pads

And Solder!

Be sure to solder all pins for reliable electrical contact.

(For tips on soldering, be sure to check out our Guide to
Excellent Soldering (https://adafru.it/aTk)).
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Solder the other strip as well.
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You're done! Check your solder joints visually and
" continue onto the next steps

.
epaQo

immmaw

smmE

|mm .
u

Soldering on Female Header

Tape In Place
For sockets you'll want to tape them in place so when

you flip over the board they don't fall out
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Flip & Tack Solder

After flipping over, solder one or two points on each
strip, to 'tack' the header in place

=
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And Solder!

Be sure to solder all pins for reliable electrical contact.

(For tips on soldering, be sure to check out our Guide to
Excellent Soldering (https://adafru.it/aTk)).
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You're done! Check your solder joints visually and
continue onto the next steps
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Arduino BSP Setup

You can install the Adafruit Bluefruit nRF52 BSP in two steps:

NRF52 support requires at least Arduino IDE version 1.6.12! Please make sure you have an up to date version
before proceeding with this guide!

Please consult the FAQ section at the bottom of this page if you run into any problems installing or using this
BSP!

1. BSP Installation

Recommended: Installing the BSP via the Board Manager

Download and install the Arduino IDE (At least v1.6.12)

Start the Arduino IDE

Go into Preferences

Add https://www.adafruit.com/package_adafruit_index.json as an 'Additional Board Manager URL' (see image below)

@ Praferences
Network

Sketchbook location:

[Users [ktown/Documents/Arduino Browse
Editor language: System Default {requires restart of Arduino)
Editor font size: 12
Interface scale: Automatic 100 2% (requires restart of Arduino)

Show verbose output during: compilation upload
Compiler warnings: Mone B

Display line numbers
Enable Code Folding
Verify code after upload
Use external editor
Check for updates on startup
Update sketch files to new extension on save (pde -> _ino)
Save when verifying or uploading
Additional Boards Manager URLs:  https:/ fwww.adafruit.com/package_adafruit_index.json [ =]
More preferences can be edited directly in the file
fUsers [ktown /Library /Arduino 15 /preferences.txt
{edit only when Arduino is not running)

OK Cancel

® Restart the Arduino IDE
e Open the Boards Manager option from the Tools -> Board menu and install 'Adafruit nRF52 by Adafruit' (see
image below)
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Type Al s nrf

Adafruit nRF52 by Adafruit
Boards included in this package:
Adafruit Bluefruit nRFS2 Feather.

Installing...

It will take up to a few minutes to finish installing the cross-compiling toolchain and tools associated with this BSP.

The delay during the installation stage shown in the image below is normal, please be patient and let the installation
terminate normally:

———————————s|nstalimgeools (1/1)... | Cancel

® Once the BSP is installed, select 'Adafruit Bluefruit nRF52 Feather' from the Tools -> Board menu, which will
update your system config to use the right compiler and settings for the nRF52:

Adafruit Boards

2. Third Party Tool Installation

The following third party tools must also be installed on your system to allow you to work with the Bluefruit nRF52
Feather:

This step is only required on OS X and Linux. If you are using Windows, a pre-built 32-bit binary of nrfutil is

already included in the BSP that should work out of the box for most setups.

You will need to have both Python and pip available on your system to use the tools below!

nrfutil (OS X and Linux Only)

This is a python wrapper for Nordic's nrfutil, which is used to flash boards using the built in serial bootloader.

To install this tool, open a terminal or command prompty window and go into the folder where the BSP was installed in
step one above.

Depending on your operating system. The BSP should be located in one of the following paths:

o Windows: %APPDATA%\Local\Arduino15\packages\adafruit\hardware\nrf52
® OS X: ~/Library/Arduinoi5/packages/adafruit/hardware/nrf52
e Linux: ~/.arduino15/packages/adafruit/hardware/nrf52

The path above will also include a sub-folder with the version number (ex. "0.6.0°). Be sure to enter that sub-folder as
well, for example:
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$ cd ~/Library/Arduinol5/packages/adafruit/hardware/nrf52
$ 1s

0.6.0/

$ cd 0.6.0

Next go into the tools/nrfutil-0.5.2 folder in the path above, and run the following commands to make nrfutil available to
the Arduino IDE:

$ cd tools/nrfutil-0.5.2
$ sudo pip install -r requirements.txt
$ sudo python setup.py install

Don't install nrfutil from the pip package (ex. 'sudo pip install nrfutil’). The latest nrfutil does not support DFU
via Serial, and you should install the local copy of 0.5.2 included with the BSP via the "python setup.py install’
command above.

If you get a 'sudo: pip: command not found' error running 'sudo pip install', you can install pip via 'sudo
easy_install pip'

3. Advanced Option: Manually Install the BSP via 'git'

If you wish to do any development against the core codebase (generate pull requests, etc.), you can also optionally
install the Adafruit nRF52 BSP manually using 'git', as decribed below:

Adafruit nRF52 BSP via git (for core development and PRs only)

1. Install BSP via Board Manager as above to install compiler & tools.
2. Delete the core folder nrf52 installed by Board Manager in Adruino15, depending on your OS. It could be
OS X: ~/Library/Arduino15/packages/adafruit/hardware/nrf52
Linux: ~/.arduino15/packages/adafruit/hardware/nrf52
Windows: %APPDATA%\Local\Arduino15\packages\adafruit\hardware\nrf52
3. Go to the sketchbook folder on your command line, which should be one of the following:
OS X: ~/Documents/Arduino
Linux: ~/Arduino
Windows: ~/Documents/Arduino
4. Create a folder named hardware/Adafruit , if it does not exist, and change directories into it.
5. Clone the Adafruit_nRF52_Arduino repo in the folder described in step 2:
git clone git@github.com:adafruit/Adafruit_nRF52_Arduino.git
6. This should result in a final folder name like ~/Documents/Arduino/hardware/Adafruit/Adafruit_nRF52_Arduino ' (OS X).
7. Restart the Arduino IDE

BSP FAQs

The following FAQs may be useful if you run into any problems:
Windows Related
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If you are using BSP 0.6.0 or greater, there are no known issues with the BSP installation process on Windows. Please
update to the latest version if you currently have an earlier release.

OS X Related

I can compile and link sketches on OS X, but nrfutil gives me the following error: 'AttributeError: 'int' object has no
attribute 'value"?

Depending on your system setup and Python version, you may need to make a manual adjustment to a file in nrfutil,
which is used when compiling and flashing files from the Arduino IDE.

Open the following file (please note that the BSP version number in the path may be different!):
~/Library/Arduino15/packages/adafruit/hardware/nrf52/0.5.1/tools/nrfutil-0.5.2/nordicsemi/dfu/init_packet.py ... and make the
following changes:

@@ -79,7 +79,7 @@
- for key in sorted(self.init packet fields.keys(), key=lambda x: x.value):
+ for key in sorted(self.init packet fields.keys(), key=lambda x: x):

@@ -94,7 +94,8 @@
- for key in sorted(self.init _packet fields.keys(), key=lambda x: x.value):
+ for key in sorted(self.init packet fields.keys(), key=lambda x: x):

Linux Related

On Linux I'm getting 'arm-none-eabi-g++: no such file or directory', even though 'arm-none-eabi-g++' exists in the
path specified. What should | do?

This is probably caused by a conflict between 32-bit and 64-bit versions of the compiler, libc and the IDE. The
compiler uses 32-bit binaries, so you also need to have a 32-bit version of libc installed on your system (details). Try
running the following commands from the command line to resolve this:

sudo dpkg --add-architecture 1386
sudo apt-get update
sudo apt-get install libc6:1386
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Arduino Board Setup

Once you have the Bluefruit nRF52 BSP setup on your system, you need to select the appropriate board, which will
determine the compiler and expose some new menus options:

1. Select the Board Target

® Go to the Tools menu
® Select Tools > Board > Adafruit Bluefruit nRF52 Feather

+ Adafruit Bluefruit nRF52 Feather

2. Select the USB CDC Serial Port

Finally, you need to set the serial port used by Serial Monitor and the serial bootloader:

® Go to Tools > Port and select the appropriate SiLabs device

SLAB_USBtolJART (Adafruit Bluefruit nRF52 F...

fo e P

Non OS X Operating Systems

If you don't see the SiLabs device listed, you may need to install the SiLabs CP2104 driver on your system.

0S X Only

Depending on the version of OS X you are running, you may need to select a different driver. See the link below for
details:

Click here to download the CP2104 USB Driver

for OS X

https://adafru.it/yna

If you are using Mac OS 10.12.6 (Sierra) and you cannot upload with the latest Mac OS VCP driver, please try
the legacy v4 driver below. Note you will need to uninstall the v5 driver using uninstall.sh (in the driver
package)

Download the CP2104 Legacy USB Driver

https://adafru.it/'ymF

3. Run a Test Sketch

At this point, you should be able to run a test sketch from the Examples folder, or just flash the following blinky code
from the Arduino IDE:
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void setup() {
pinMode(LED BUILTIN, OUTPUT);
}

void loop() {
digitalWrite(LED BUILTIN, HIGH); // turn the LED on (HIGH is the voltage level)

delay(1000); // wait for a second
digitalWrite(LED BUILTIN, LOW); // turn the LED off by making the voltage LOW
delay(1000); // wait for a second

This will blink the pin #17 red LED on the Feather
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Using the Bootloader

This page is for information purposes only. Normally the bootloader will work transparently and automatically

from the Arduino IDE, requiring no manual intervention on your behalf.

The Bluefruit nRF52 Feather includes a customized version of the Nordic bootloader that enables serial support, over
the air (OTA) DFU support, and various fail safe features like factory reset when the FRST pin is grounded at startup.

The bootloader that all Bluefruit nRF52 Feathers ships with allows you to flash user sketches to the nRF52832 using
only the CP2104 USB to serial adapter populated on the board.

Forcing Serial Boot Mode

The Bluefruit nRF52 Feather is designed to briefly enter serial bootloader mode for a short delay every time the device
comes out of reset, and the DTR line on the CP2104 USB to Serial adapter will trigger a reset every time the Serial
Monitor is opened. This means that you can normally flash a user sketch to the nRF52 with no manual intervention on
your part at a HW level.

If you need to force the serial bootloader mode, however, you can connect the DFU pin to GND at startup, which will
force you to enter serial bootloader mode and stay in that mode until you reset or power cycle the board.

This can be used to recover bricked boards where a bad user sketch has been uploaded, since you will enter serial
bootloader mode without executing the user sketch, and you can flash a new sketch directly from the Arduino IDE.

Forcing the serial bootloader can often be used to recover bricked devices.

* ¢ & & & & 9 0 " " " B e 0D

Factory Reset
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The Bluefruit NnRF52 Feather has an optional FRST pad on the bottom of the PCB.

If you brick your device, you can solder a wire to the FRST pad, connecting it to GND. When a GND state is detected at
power up the following actions will be performed:

® The user application flash section will be erased
e The user 'App Data' section that stores non volatile config data will be erased

This will cause the device to enter serial bootloader mode at startup, and the user sketch or config data that caused
the device to stop responding should be removed.

Be sure to disconnect the pin from GND after a successful factory reset!

Advanced: OTA DFU Bootloader

While this is only recommended for advanced users, you can also force OTA (Over The Air) DFU bootloader mode to
enable OTA updates using BLE and Nordic's proprietary update protocol (which is support by both Nordic mobile apps,
and out own Bluefruit LE Connect).

To force OTA DFU mode, set both FRST and DFU to GND at startup. Power cycling the board will cause the device to
boot up into OTA DFU mode.

This option is not actively support nor recommended by Adafruit, and we are still working on making this as

safe as possible for users via our Bluefruit LE Connect application. Use OTA DFU at your own risk knowing
you can brick your device and may need a Segger J-Link or similar device to regain control of it!

Advanced: Upgrading an Existing Bootloader

The Adafruit Feather nRF52 Bootloader binary contains not only the DFU code, but also the Bluetooth stack

(a.k.a SoftDevice) to make sure they work together reliably. To get the latest and greatest features from the stack such
as Bluetooth 5.0 with higher throughput, increased broadcast capacities or larger MTU it is necessary to upgrade
Bootloader to get the latest stack.

Luckily the Bluefruit nRF52 Bootloader can be upgraded/downgraded without any additional hardware, and we can
even do that right in Arduino IDE without at risk of typos or common user errors.

Upgrading the Bootloader is only possible from BSP release 0.8.0 and higher.

Once you click "Burn Bootloader", you shouldn't close the Arduino IDE, unplug the Feather, or abort the

process. There is a high chance it will brick your device! Do this with care and caution.

First select the Bootloader version that you want to upgrade under Tools->Bootloader. Then select "Bootloader DFU
for Bluefruit nRF52"
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Select Tools->Burn Bootloader to start the upgrade. After receiving the new Bootloader over the serial connection, the
old Bootloader will erase itselfl The new bootloader will then be flashed. The process typically takes 30-60 seconds to
complete. Make sure you see the "Device programmed" in the output log before launching Serial monitor or
uploadinga new sketch.

| Arduino 1.8.3

m HF'_'|_|::|

Auto Format Cerl+T
Archive Sketch

Fix Encoding & Reload

Serial Monitor Cerl+Shift+m
Serial Plotter Cerl+Shift+L
WiFi101 Firmware Updater

Board: "Adafruit Bluefruit nRF52 Feather” ’
Bootloader: "5.1.0 dual, 5132 5.1.0" v
Debug Mode: "Level 1 (Errar Message)" v
Port: "/dev/ttylUSBD" v

Get Board Info

Programmer: "Bootloader DFU For Bluefruit nrFs2" ’
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Flashing the Bootloader

All Adafruit nRF52 boards chip with the bootloader pre-flashed. This page is provided for information

purposes only!

All Bluefruit nRF52 Feather boards and Bluefruit nRF52 modules ship with the serial bootloader pre-flashed, so this
page is normally not required when setting your device and system up.

The information provided here is only intended for for rare cases where you may want or need to reflash the
bootloader yourself, and have access to the HW required to do so.

You will need a Segger J-Link to flash the bootloader to the nRF52832 SoC!

Third Party Tool Requirements

To burn the bootloader from within the Arduino IDE, you will need the following tools installed
on your system and available in the system path:

JLink Drivers and Tools

Download and install the JLink Software and Documentation Pack from Segger, which will also install a set of
command line tools.

Burning the Bootloader from the Arduino IDE

Once the tools above have been installed and added to your system path, from the Arduino IDE:

® Select "Tools > Board > Adafruit Bluefruit Feather52
® Select Tools > Programmer > J-Link for Feather52’
® Select "Tools > Burn Bootloader with the board and J-Link connected

The appropriate Programmer target and Burn Bootloader button can be seen below:
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Programmer: "J-Link for Feather52" > AVR ISP

AVRISP
USBtinylSP
ArduinolSP
ArduinolSP.org
USBasp
Parallel Programmer
Arduino as ISP
Arduino Gemma
Atmel STKS500 development board
BusPirate as ISP
Atmel EDBG
Atmel-ICE
Atmel SAM-ICE
JLink with Adalink
STlinkV2 with Adalink
J-Link
ST-Link V2
CMSIS-DAP

+/ J-Link for Feather52

Manually Burning the Bootloader via nrfjprog

You can also manually burn the bootloader from the command line, using "nrfjprog” from Nordic.

You can either download nRF5x-Command-Line-Tools for OSX/Linux/Win32, or use the version that ships with the BSP
in the tools/nrf5x-command-line-tools folder.

Run the folllwing commands, updating the path to the .hex file as appropriate:
$ nrfjprog -e -f nrf52

$ nrfjprog --program bootloader_with_s132.hex -f nrf52
$ nrfjprog --reset -f nrf52

You should see something similar to the following output, followed by a fast blinky on the status LED to indicate that
you are in DFU/bootloader mode since no user sketch was found after the device reset:

All commands below were run from 'tools/nrf5x-command-line-tools/osx/nrfjprog’

$ ./nrfjprog -e -f nrf52
Erasing code and UICR flash areas.
Applying system reset.

$ ./nrfjprog --program ../../../../bin/bootloader/bootloader v050 s132 v201l.hex -f nrf52
Parsing hex file.

Reading flash area to program to guarantee it is erased.

Checking that the area to write is not protected.

Programing device.

$ ./nrfjprog --reset -f nrf52

Applying system reset.
Run.
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OS X Note: You may need to create a symlink in /usr/local/bin” to the
‘nrfjprog” tool wherever you have added it. You can run the following command, for example:

$ In -s $HOME/prog/nordic/nrfjprog/nrfjprog /usr/local/bin/nrfjprog

Manually Burning the Bootloader via AdalLink

Alternatively, you can use Adalink to flash the bootloader with a Segger J-Link:

# First erase the device's flash contents
$ adalink nrf52832 -p jlink -w

# Then flash the bootloader and SoftDevice .hex file
$ adalink nrf52832 -p jlink -h feather52 bootloader v050 s132 v201.hex
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Examples

There are numerous examples available for the Bluefruit nRF52 Feather in the Examples menu of the nRF52 BSP, and
these are always up to date. You're first stop looking for example code should be there:

Adafruit BLE Libraries for Bluefruit52

> Central 13
Newt Newtron Flash Filesystem > Hardware >
S - beacon
Wire > " blemidi
_ blemidi_callback
Adafruit AHRS L blinky_ota
Adafruit BLEFirmata > clearbonds
Adafruit BluefruitLE nRF51 > controller
Adafruit BME280 Library > custom_hrm
Adafruit BMPOBS Library > hid_keyboard
Adafruit BMP280 Library > hid_mouse

*

Adafruit BNOOSS

neopixel_picker

Example Source Code

The latest example source code is always available and visible on Github, and the public git repository should be
considered the definitive source of example code for this board.

Click here to browse the example source code

on Github

https://adafru.it/vaK

Documented Examples

To help explain some common use cases for the nRF52 BLE API, feel free to consult the example documentation in
this section of the learning guide:

e Advertising: Beacon - Shows how to use the BLEBeacon helper class to configure your Bleufruit NnRF52 Feather
as a beacon

e BLE UART: Controller - Shows how to use the Controller utility in our Bluefruit LE Connect apps to send basic
data between your peripheral and your phone or tablet.

® Custom: HRM - Shows how to defined and work with a custom GATT Service and Characteristic, using the
officially adopted Heart Rate Monitor (HRM) service as an example.

e BLE Pin I/O (StandardFirmataBLE) Shows how to control Pin I/0O of nRF52 with Firmata protocol
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Advertising: Beacon

This example shows how you can use the BLEBeacon helper class and advertising API to configure your Bluefruit
nRF52 board as a 'Beacon'.

Complete Code

The code below may be out of sync with the latest examples on Github. You should always consult Github for

the latest version.

The latest version of this code is available on Github and in the Examples menu.
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#include <bluefruit.h>

// Beacon uses the Manufacturer Specific Data field in the advertising
// packet, which means you must provide a valid Manufacturer ID. Update
// the field below to an appropriate value. For a list of valid IDs see:

// https://www.bluetooth.com/specifications/assigned-numbers/company-identifiers

// 0x004C is Apple (for example)
#define MANUFACTURER ID  0x004C

// AirLocate UUID: E2C56DB5-DFFB-48D2-B060-DOF5A71096E0
uint8 t beaconUuid[16] =
{
OxE2, OxC5, Ox6D, 0xB5, OxDF, OxFB, 0x48, 0xD2,
0xB0O, 0x60, 0xDO, OxF5, OxA7, 0x10, 0x96, OxEO,
b

// A valid Beacon packet consists of the following information:
// UUID, Major, Minor, RSSI @ 1M
BLEBeacon beacon(beaconUuid, 0x0001, 0x0000, -54);

void setup()

{
Serial.begin(115200);

Serial.println("Bluefruit52 Beacon Example");

Bluefruit.begin();
Bluefruit.setName("Bluefruit52");

// Manufacturer ID is required for Manufacturer Specific Data
beacon.setManufacturer(MANUFACTURER ID);

// Setup the advertising packet
setupAdv();

// Start advertising
Bluefruit.Advertising.start();

void setupAdv(void)

{
// Set the beacon payload using the BLEBeacon class populated
// earlier in this example
Bluefruit.Advertising.setBeacon(beacon);

// char* adv = Bluefruit.Advertising.getData();

// There is no room left for 'Name' in the advertising packet
// Use the optinal secondary Scan Response packet for 'Name' instead
Bluefruit.ScanResponse.addName();

void loop()

{
// Toggle both LEDs every second
digitalToggle(LED BUILTIN);
delay(1000);

}
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Output

You can use the nRF Beacons application from Nordic Semiconductors to test this sketch:

® nRF Beacons for iOS
® nRF Beacons for Android

Make sure that you set the UUID, Major and Minor values to match the sketch above, and then run the sketch at the
same time as the nRF Beacons application.

With the default setup you should see a Mona Lisa icon when the beacon is detected. If you don't see this, double
check the UUID, Major and Minor values to be sure they match exactly.

€ Beacons Configuration Llf Beacons

Apple Beacon

Apple Beacon

Near

IDENTITY

UUID Ezcsepes-DFFB-48D2-BO60-DOFSAT10

Major 1
Minor 0
Event At beacon
Action Show Mona Lisa

STATUS

m
=,
4i]
g
o

‘Wirelass by Nordic Wireless by MNordic

N M N U

Beacons Update Beacons Update
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BLE UART: Controller

This examples shows you you can use the BLEUart helper class and the Bluefruit LE Connect applications to send
based keypad and sensor data to your nRF52.

Setup

In order to use this sketch, you will need to open Bluefruit LE Connect on your mobile device using our free iOS,
Android or OS X applications.

Load the Controller example sketch in the Arduino IDE

Compile the sketch and flash it to your nRF52 based Feather

Once you are done uploading, open the Serial Monitor (Tools > Serial Monitor)

Open the Bluefruit LE Connect application on your mobile device

Connect to the appropriate target (probably 'Bluefruit52')

Once connected switch to the Controller application inside the app

Enable an appropriate control surface. The Color Picker control surface is shown below, for example (screen shot
taken from the iOS application):

Color Picker

R: 255 G:18 B:48

Hex: #ff1230
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As you change the color (or as other data becomes available) you should receive the data on the nRF52, and see it in
the Serial Monitor output:

Adafruit Bluefruit52 Controller App Example

RGB #FF5@4E

Complete Code

The latest version of this code is always available on Github, and in the Examples folder of the nRF52 BSP.

The code below is provided for convenience sake, but may be out of date! See the link above for the latest

code.

#include <bluefruit.h>
BLEUart bleuart;

// Function prototypes for packetparser.cpp

uint8 t readPacket (BLEUart *ble uart, uintl6e t timeout);

float parsefloat (uint8 t *buffer);

void printHex (const uint8 t * data, const uint32 t numBytes);

// Packet buffer
extern uint8 t packetbuffer[];

void setup(void)

{
Serial.begin(115200);
Serial.println(F("Adafruit Bluefruit52 Controller App Example"));
Serial.println(F("------mmmmmm e "));

Bluefruit.begin();
Bluefruit.setName("Bluefruit52");

// Configure and start the BLE Uart service
bleuart.begin();

// Set up the advertising packet
setupAdv();

// Start advertising
Bluefruit.Advertising.start();

void setupAdv(void)

{
Bluefruit.Advertising.addFlags (BLE GAP_ADV FLAGS LE ONLY GENERAL DISC MODE);
Bluefruit.Advertising.addTxPower();

// Include the BLE UART (AKA 'NUS') 128-bit UUID
Bluefruit.Advertising.addService(bleuart);
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}

/**************************************************************************/

/*

*/

/**************************************************************************/

//

There is no room for 'Name' in the Advertising packet

// Use the optional secondary Scan Response packet for 'Name' instead

Bl

uefruit.ScanResponse.addName();

@brief Constantly poll for new command or response data

void loop(void)

{

© Adafruit Industries

//
ui
if

//
//

//
if

Wait for new data to arrive

nt8 t len = readPacket(&bleuart, 500);
(len == 0) return;

Got a packet!

printHex(packetbuffer, len);

Color

(packetbuffer[1] == 'C') {

uint8 t red = packetbuffer[2];
uint8 t green = packetbuffer[3];
uint8 t blue = packetbuffer[4];
Serial.print ("RGB #");

if (red < 0x10) Serial.print("0");
Serial.print(red, HEX);

if (green < 0x10) Serial.print("0");
Serial.print(green, HEX);

if (blue < 0x10) Serial.print("0");
Serial.println(blue, HEX);

// Buttons
if (packetbuffer[1l] == 'B') {

}

uint8 t buttnum = packetbuffer[2] - '0';
boolean pressed = packetbuffer[3] - '0';
Serial.print ("Button "); Serial.print(buttnum);
if (pressed) {

Serial.println(" pressed");
} else {

Serial.println(" released");

}

// GPS Location
if (packetbuffer[1l] == 'L') {

float lat, lon, alt;

lat = parsefloat(packetbuffer+2);
lon = parsefloat(packetbuffer+6);
alt = parsefloat(packetbuffer+10);

Serial.print("GPS Location\t");

Serial.print("Lat: "); Serial.print(lat, 4); // 4 digits of

Serial.print('\t');

precision!

Serial.print("Lon: "); Serial.print(lon, 4); // 4 digits of precision!

Serial.print('\t');
Serial.print(alt, 4); Serial.println(

meters");

// Accelerometer
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if (packetbuffer[l] == 'A") {
float x, vy, z;
x = parsefloat(packetbuffer+2)
y = parsefloat(packetbuffer+6)
z = parsefloat(packetbuffer+10
Serial.print("Accel\t");
Serial.print(x); Serial.print('\t');
Serial.print(y); Serial.print('\t');
Serial.print(z); Serial.println();

’

)

// Magnetometer

if (packetbuffer[l] == 'M') {
float x, vy, z;
X parsefloat(packetbuffer+2)
y = parsefloat(packetbuffer+6)
z = parsefloat(packetbuffer+10
Serial.print("Mag\t");
Serial.print(x); Serial.print('\t');
Serial.print(y); Serial.print('\t');
Serial.print(z); Serial.println();

’

)

// Gyroscope

if (packetbuffer[1] == 'G') {
float x, vy, z;
X parsefloat(packetbuffer+2)
y = parsefloat(packetbuffer+6)
z = parsefloat(packetbuffer+10
Serial.print("Gyro\t");
Serial.print(x); Serial.print('\t');
Serial.print(y); Serial.print('\t');
Serial.print(z); Serial.println();

’

)s

// Quaternions

if (packetbuffer[1] == 'Q') {
float x, vy, z, w;
x = parsefloat(packetbuffer+2);
y = parsefloat(packetbuffer+6);
z parsefloat(packetbuffer+10);
w = parsefloat(packetbuffer+14)
Serial.print("Quat\t");
Serial.print(x); Serial.print('\t');
Serial.print(y); Serial.print('\t');
Serial.print(z); Serial.print('\t');
Serial.print(w); Serial.println();

You will also need the following helper class in a file called packetParser.cpp:

#include <string.h>
#include <Arduino.h>
#include <bluefruit.h>

#define PACKET ACC LEN (15)
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#define PACKET GYRO LEN (15)

#define PACKET MAG LEN (15)
#define PACKET QUAT LEN (19)
#define PACKET BUTTON_ LEN (5)
#define PACKET COLOR LEN (6)
#define PACKET LOCATION LEN (15)
// READ BUFSIZE Size of the read buffer for incoming packets
#define READ BUFSIZE (20)

/* Buffer to hold incoming characters */
uint8 t packetbuffer[READ BUFSIZE+1];

/**************************************************************************/
/*!
@brief Casts the four bytes at the specified address to a float

*/
/**************************************************************************/
float parsefloat(uint8 t *buffer)
{

float f;

memcpy (&f, buffer, 4);

return f;

/**************************************************************************/
/*!
@brief Prints a hexadecimal value in plain characters
@param data Pointer to the byte data
@param numBytes Data length in bytes
*/
/**************************************************************************/
void printHex(const uint8 t * data, const uint32 t numBytes)
{
uint32 t szPos;
for (szPos=0; szPos < numBytes; szPos++)
{
Serial.print(F("0x"));
// Append leading 0 for small values
if (data[szPos] <= 0OxF)
{
Serial.print(F("0"));
Serial.print(datal[szPos] & 0xf, HEX);
}
else
{
Serial.print(data[szPos] & Oxff, HEX);
}
// Add a trailing space if appropriate
if ((numBytes > 1) && (szPos != numBytes - 1))
{
Serial.print(F(" "));
}
}
Serial.println();
}

/**************************************************************************/
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/!
@brief Waits for incoming data and parses it
*/

/**************************************************************************/

uint8 t readPacket(BLEUart *ble uart, uintl6e t timeout)
{

uintl6e t origtimeout = timeout, replyidx = 0;

memset (packetbuffer, 0, READ BUFSIZE);

while (timeout--) {
if (replyidx >= 20) break;

if ((packetbuffer[1l] == 'A') && (replyidx == PACKET ACC LEN))
break;

if ((packetbuffer[1l] == 'G') && (replyidx == PACKET GYRO LEN))
break;

if ((packetbuffer[1l] == 'M') && (replyidx == PACKET MAG LEN))
break;

if ((packetbuffer[1l] == 'Q') && (replyidx == PACKET QUAT LEN))
break;

if ((packetbuffer[1l] == 'B') && (replyidx == PACKET BUTTON LEN))
break;

if ((packetbuffer[1l] == 'C') && (replyidx == PACKET COLOR LEN))
break;

if ((packetbuffer[1l] == 'L') && (replyidx == PACKET LOCATION LEN))
break;

while (ble uart->available()) {

char ¢ = ble uart->read();
if (¢ == '1") {
replyidx = 0;
}
packetbuffer[replyidx] = c;
replyidx++;
timeout = origtimeout;
}
if (timeout == 0) break;
delay(1);

packetbuffer[replyidx] = 0; // null term

if (!replyidx) // no data or timeout
return 0;

if (packetbuffer[0] != '!') // doesn't start with '!' packet beginning
return 0;

// check checksum!
uint8 t xsum = 0;
uint8 t checksum = packetbuffer[replyidx-1];

for (uint8 t i=0; i<replyidx-1; i++) {
xsum += packetbuffer[i];

}

Xsum = ~Xsum;

// Throw an error message if the checksum's don't match
if (xsum != checksum)

{
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Serial.print("Checksum mismatch in packet : ");
printHex(packetbuffer, replyidx+1l);
return 0;

// checksum passed!
return replyidx;
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Custom: HRM

The BLEService and BLECharacteristic classes can be used to implement any custom or officially adopted BLE service
of characteristic using a set of basic properties and callback handlers.

The example below shows how to use these classes to implement the Heart Rate Monitor service, as defined by the
Bluetooth SIG.

HRM Service Definition

UUID: 0x180D

Characteristic Name uuiD Requirement Properties
Heart Rate Measurement Ox2A37 Mandatory Notify
Body Sensor Location Ox2A38 Optional Read
Heart Rate Control Point Ox2A39 Conditional Write

Only the first characteristic is mandatory, but we will also implement the optional Body Sensor Location characteristic.
Heart Rate Control Point won't be used in this example to keep things simple.

Implementing the HRM Service and Characteristics

The core service and the first two characteristics can be implemented with the following code:

First, define the BLEService and BLECharacteristic variables that will be used in your project:

/* HRM Service Definitions
* Heart Rate Monitor Service: 0x180D
* Heart Rate Measurement Char: 0x2A37
* Body Sensor Location Char: 0x2A38
*/
BLEService hrms
BLECharacteristic hrmc
BLECharacteristic bslc

BLEService(UUID16 SVC HEART RATE);
BLECharacteristic(UUID16 CHR HEART RATE _MEASUREMENT);
BLECharacteristic(UUID16 CHR BODY SENSOR LOCATION);

Then you need to 'populate’ those variables with appropriate values. For simplicity sake, you can define a custom
function for your service where all of the code is placed, and then just call this function once in the 'setup' function:

void setupHRM(void)

{
// Configure the Heart Rate Monitor service
// See: https://www.bluetooth.com/specifications/gatt/viewer?attributeXmlFile=org.bluetooth.service.hee
// Supported Characteristics:

// Name uuIib Requirement Properties
VA

// Heart Rate Measurement 0x2A37 Mandatory Notify

// Body Sensor Location 0x2A38 Optional Read

// Heart Rate Control Point 0x2A39 Conditional Write <-- Not used here

hrms.begin();
// Note: You must call .begin() on the BLEService before calling .begin() on

// any characteristic(s) within that service definition.. Calling .begin() on
// a BLECharacteristic will cause it to be added to the last BLEService that
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// wWas ‘'pbegin() - eaqa!

// Configure the Heart Rate Measurement characteristic
// See: https://www.bluetooth.com/specifications/gatt/viewer?attributeXmlFile=org.bluetooth.characteris
// Permission = Notify

// Min Len =1

// Max Len =8

// BO = UINT8 - Flag (MANDATORY)

// b5:7 = Reserved

// b4 = RR-Internal (0 = Not present, 1 = Present)

// b3 = Energy expended status (0 = Not present, 1 = Present)
// bl:2 = Sensor contact status (0+1 = Not supported, 2 = Supported but contact not detected, 3 =
// bo = Value format (0 = UINT8, 1 = UINT16)

// B1 = UINT8 - 8-bit heart rate measurement value in BPM
// B2:3 = UINT16 - 16-bit heart rate measurement value in BPM
// B4:5 = UINT16 - Energy expended in joules

// B6:7 = UINT16 - RR Internal (1/1024 second resolution)

hrmc.setProperties(CHR PROPS NOTIFY);

hrmc.setPermission (SECMODE OPEN, SECMODE NO ACCESS);

hrmc.setFixedLen(2);

hrmc.setCccdWriteCallback(cccd callback); // Optionally capture CCCD updates

hrmc.begin();

uint8 t hrmdata[2] = { 0b0O0O00110, 0x40 }; // Set the characteristic to use 8-bit values, with the sen:
hrmc.notify(hrmdata, 2); // Use .notify instead of .write!

// Configure the Body Sensor Location characteristic
// See: https://www.bluetooth.com/specifications/gatt/viewer?attributeXmlFile=org.bluetooth.characteris
// Permission = Read

// Min Len =1

// Max Len =1

// BO = UINT8 - Body Sensor Location
// 0 = Other

// 1 = Chest

// 2 = Wrist

// 3 = Finger
// 4 = Hand

// 5 = Ear Lobe
// 6 = Foot

// 7:255 = Reserved

bslc.setProperties (CHR _PROPS_READ);
bslc.setPermission (SECMODE OPEN, SECMODE NO ACCESS);
bslc.setFixedLen(1);

bslc.begin();

bslc.write8(2); // Set the characteristic to 'Wrist' (2)

Service + Characteristic Setup Code Analysis

1. The first thing to do is to call .begin() on the BLEService (hrms above). Since the UUID is set in the object declaration
at the top of the sketch, there is normally nothing else to do with the BLEService instance.

You MUST call .begin() on the BLEService before adding any BLECharacteristics. Any BLECharacteristic will

automatically be added to the last BLEService that was "begin()'ed!

2. Next, you can configure the Heart Rate Measurement characteristic (hrmc above). The values that you set for this
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will depend on the characteristic definition, but for convenience sake we've documented the key information in the
comments in the code above.

® 'hrmc.setProperties(CHR_PROPS_NOTIFY); ' - This sets the PROPERTIES value for the characteristic, which
determines how the characteristic can be accessed. In this case, the Bluetooth SIG has defined the characteristic
as Notify, which means that the peripheral will receive a request ('notification') from the Central when the Central
wants to receive data using this characteristic.

® " hrmc.setPermission(SECMODE_OPEN, SECMODE_NO_ACCESS); " - This sets the security for the characteristic, and
should normally be set to the values used in this example.

e " hrmc.setFixedLen(2); " - This tells the Bluetooth stack how many bytes the characteristic contains (normally a value
between 1and 20). In this case, we will use a fixed size of two bytes, so we call .setFixedLen. If the characteristic
has a variable length, you would need to set the max size via .setMaxLen.

® 'hrmc.setCccdWriteCallback(cced_callback); ' - This optional code sets the callback that will be fired when the CCCD
record is updated by the central. This is relevant because the characteristic is setup with the NOTIFY property.
When the Central sets to 'Notify' bit, it will write to the CCCD record, and you can capture this write even in the
CCCD callback and turn the sensor on, for example, allowing you to save power by only turning the sensor on
(and back off) when it is or isn't actually being used. For the implementation of the CCCD callback handler, see
the full sample code at the bottom of this page.

e 'hrmc.begin(); ' Once all of the properties have been set, you must call .begin() which will add the characteristic
definition to the last BLEService that was '.begin()ed".

3. Optionally set an initial value for the characteristic(s), such as the following code that populates 'hrmc' with a correct
values, indicating that we are providing 8-bit heart rate monitor values, that the Body Sensor Location characteristic is
present, and setting the first heart rate value to Ox04:

Note that we use .notify() in the example above instead of .write(), since this characteristic is setup with the

NOTIFY property which needs to be handled in a slightly different manner than other characteristics.

// Set the characteristic to use 8-bit values, with the sensor connected and detected
uint8 t hrmdata[2] = { 0b00000110, 0x40 };

// Use .notify instead of .write!
hrmc.notify(hrmdata, 2);

The CCCD callback handler has the following signature:
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void cccd callback(BLECharacteristic& chr, uintl6é t cccd value)
{

// Display the raw request packet

Serial.print("CCCD Updated: ");

Serial.print(cccd value);

Serial.println("");

// Check the characteristic this CCCD update is associated with in case
// this handler is used for multiple CCCD records.
if (chr.uuid == hrmc.uuid) {
if (chr.notifyEnabled()) {
Serial.println("Heart Rate Measurement 'Notify' enabled");
} else {
Serial.println("Heart Rate Measurement 'Notify' disabled");

4. Repeat the same procedure for any other BLECharacteristics in your service.

Full Sample Code

The full sample code for this example can be seen below, but this maybe be out of sync with the latest code available
on Github. Please consult the Github code if you have any problems with the code below.

#include <bluefruit.h>

#define STATUS_LED (17)
#define BLINKY_ MS (2000)

/* HRM Service Definitions
* Heart Rate Monitor Service: 0x180D
* Heart Rate Measurement Char: 0x2A37
* Body Sensor Location Char: 0x2A38
*/
BLEService hrms
BLECharacteristic hrmc
BLECharacteristic bslc

BLEService(UUID16_SVC HEART_RATE);
BLECharacteristic(UUID16_CHR HEART_RATE_MEASUREMENT) ;
BLECharacteristic(UUID16_CHR BODY_ SENSOR_LOCATION);

BLEDis bledis; // DIS (Device Information Service) helper class instance
BLEBas blebas; // BAS (Battery Service) helper class instance

uint32 t blinkyms;
uint8 t bps = 0;

// Advanced function prototypes

void setupAdv(void);

void setupHRM(void);

void connect callback(void);

void disconnect_callback(uint8 t reason);

void cccd callback(BLECharacteristic& chr, ble gatts evt write t* request);

void setup()

{
Serial.begin(115200);
Serial.println("Bluefruit52 HRM Example");
Serial.println("----------------------- "),
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// Setup LED pins and reset blinky counter
pinMode(STATUS LED, OUTPUT);
blinkyms = millis();

// Initialise the Bluefruit module
Serial.println("Initialise the Bluefruit nRF52 module");
Bluefruit.begin();

// Set the advertised device name (keep it short!)
Serial.println("Setting Device Name to 'Feather52 HRM'");
Bluefruit.setName("Feather52 HRM");

// Set the connect/disconnect callback handlers
Bluefruit.setConnectCallback(connect callback);
Bluefruit.setDisconnectCallback(disconnect callback);

// Configure and Start the Device Information Service
Serial.println("Configuring the Device Information Service");
bledis.setManufacturer("Adafruit Industries");
bledis.setModel("Bluefruit Feather52");

bledis.begin();

// Start the BLE Battery Service and set it to 100%
Serial.println("Configuring the Battery Service");
blebas.begin();

blebas.update(100);

// Setup the Heart Rate Monitor service using

// BLEService and BLECharacteristic classes
Serial.println("Configuring the Heart Rate Monitor Service");
setupHRM() ;

// Setup the advertising packet(s)
Serial.println("Setting up the advertising payload(s)");
setupAdv();

// Start Advertising
Serial.println("Ready Player One!!!");
Serial.println("\nAdvertising");
Bluefruit.Advertising.start();

void setupAdv(void)

{
Bluefruit.Advertising.addFlags (BLE GAP ADV FLAGS LE ONLY GENERAL DISC MODE);
Bluefruit.Advertising.addTxPower();

// Include HRM Service UUID
Bluefruit.Advertising.addService(hrms);

// There isn't enough room in the advertising packet for the
// name so we'll place it on the secondary Scan Response packet
Bluefruit.ScanResponse.addName();

void setupHRM(void)
{

// Configure the Heart Rate Monitor service

// Qaa+ httnc://unna hliuatnnth ram/cnarificatinnc/aatt /viocwar?attrihntaY¥YmlFila—nra hluatnnth carvira ha=z
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//
//
//
//
//
//
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Supported Characteristics:

Name uuID Requirement Properties

Heart Rate Measurement 0x2A37 Mandatory  Notify

Body Sensor Location 0x2A38 Optional Read

Heart Rate Control Point 0x2A39 Conditional Write <-- Not used here

hrms.begin();

Note: You must call .begin() on the BLEService before calling .begin() on
any characteristic(s) within that service definition.. Calling .begin() on
a BLECharacteristic will cause it to be added to the last BLEService that

Configure the Heart Rate Measurement characteristic
See: https://www.bluetooth.com/specifications/gatt/viewer?attributeXmlFile=org.bluetooth.characteris

Notify

1

8

UINT8 - Flag (MANDATORY)

Reserved

RR-Internal (0 = Not present, 1 = Present)

Energy expended status (0 = Not present, 1 = Present)
Sensor contact status (0+1 = Not supported, 2 = Supported but contact not detected, 3 =
Value format (0 = UINT8, 1 = UINT16)

UINT8 - 8-bit heart rate measurement value in BPM
UINT16 - 16-bit heart rate measurement value in BPM
UINT16 - Energy expended in joules

UINT16 - RR Internal (1/1024 second resolution)

setProperties(CHR PROPS NOTIFY);
.setPermission (SECMODE OPEN, SECMODE NO ACCESS);
setFixedLen(2);

//

//

//

// was 'begin()'ed!
//

//

// Permission
// Min Len
// Max Len
// BO

// b5:7
// b4
// b3
// bl:2
// b0
// B1

// B2:3
// B4:5
// B6:7
hrmc.

hrmc

hrmc.

hrmc.

hrmc.begin();
uint8 t hrmdata[2] = { 0b00000110, 0x40 }; // Set the characteristic to use 8-bit values, with the sen:
hrmc.notify(hrmdata, 2); // Use .notify instead of .write!

setCccdWriteCallback(cccd callback); // Optionally capture CCCD updates

// Configure the Body Sensor Location characteristic
// See: https://www.bluetooth.com/specifications/gatt/viewer?attributeXmlFile=org.bluetooth.characteris

// Permission
// Min Len

// Max Len

// BO

// 0

// 1

// 2

// 3

// 4

// 5

// 6

// 7:255
bslc.

bslc.

bslc.
bslc.begin();
bslc.write8(2);

Read

1

1

UINT8 - Body Sensor Location
Other
Chest
Wrist
Finger
Hand

Ear Lobe
Foot
Reserved

setProperties (CHR PROPS READ);
setPermission (SECMODE OPEN, SECMODE NO ACCESS);
setFixedLen(1);

// Set the characteristic to 'Wrist' (2)

void connect callback(void)

{
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Serial.println("Connected");

}

void disconnect callback(uint8 t reason)

{

(void) reason;

Serial.println("Disconnected");
Serial.println("Advertising!");

}

void cccd callback(BLECharacteristic& chr, uintl6é t cccd value)
{
// Display the raw request packet
Serial.print("CCCD Updated: ");
//Serial.printBuffer(request->data, request->len);
Serial.print(cccd value);
Serial.println("");

// Check the characteristic this CCCD update is associated with in case
// this handler is used for multiple CCCD records.
if (chr.uuid == hrmc.uuid) {
if (chr.notifyEnabled()) {
Serial.println("Heart Rate Measurement 'Notify' enabled");
} else {
Serial.println("Heart Rate Measurement 'Notify' disabled");

void loop()
{
// Blinky!
if (blinkyms+BLINKY MS < millis()) {
blinkyms = millis();
digitalToggle (STATUS LED);

if (Bluefruit.connected()) {
uint8 t hrmdata[2] = { 0b00000110, bps++ }; // Sensor connected, increment BPS value
err t resp = hrmc.notify(hrmdata, sizeof(hrmdata)); // Note: We use .notify instead of .write!

// This isn't strictly necessary, but you can check the result
// of the .notify() attempt to see if it was successful or not
switch (resp) {
case ERROR_NONE:
// Value was written correctly!
Serial.print("Heart Rate Measurement updated to: "); Serial.println(bps);
break;
case NRF_ERROR INVALID PARAM:
// Characteristic property not set to 'Notify'
Serial.println("ERROR: Characteristic 'Property' not set to Notify!");
break;
case NRF_ERROR INVALID STATE:
// Notify bit not set in the CCCD or not connected
Serial.println("ERROR: Notify not set in the CCCD or not connected!");
break;
default:
// Unhandled error code
Serial.print("ERROR: 0x"); Serial.println(resp, HEX);

hreak:
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BLE Pin I/O

Firmata is a generic protocol for communicating with microcontrollers and controlling the board's pins such as setting
the GPIO outputs and inputs, PWM output, analog reads, etc....

Setup

In order to run this demo, you will need to open Bluefruit LE Connect on your mobile device using our freeiOS,
Android or OS X applications.

Load the StandardFirmataBLE example sketch in the Arduino IDE

Compile the sketch and flash it to your nRF52 based Feather

Once you are done uploading, open the Serial Monitor (Tools > Serial Monitor)
Open the Bluefruit LE Connect application on your mobile device

Connect to the appropriate target (probably 'Bluefruit52')

Once connected switch to the Pin I/0 application inside the app

For more information using Pin I/O module, you could check out this tutorial here https://learn.adafruit.com/bluefruit-le-
connect-for-ios/pin-i-o

Bluefruit52 Pin 2, Analog 0 High

all -61dm bt
Pin 3, Analog 1 .
il 9 High
Pin 4, Analog 2 :
Input g ngh

i= Info Pin 5, Analog 3 High
Input

M), UART Pin 6 :

-I Input ngh

~/ Plotter Pin7 High
Input

3% Pinijo Pin 8 High
Input

-:- Controller ﬁl? 19 Low
npu

Q Neopixels Pin 10

- i Input Low

() AHRS/Calibration Pin 11 High

Input

Complete Code

The latest version of this code is always available on Github, and in the Examples folder of the nRF52 BSP.

The code below is provided for convenience sake, but may be out of date! See the link above for the latest
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// Adafruit nRF52 Boards require Firmata at least 2.5.7

#include <bluefruit.h>
#include <Servo.h>
#include <Wire.h>
#include <Firmata.h>

#define I2C_WRITE BOOOOOOOO
#define I2C READ B00001000
#define I2C_READ_CONTINUOUSLY B00010000
#define I2C_STOP_READING B00011000

#define 12C_READ WRITE MODE MASK  B00011000
#define 12C_10BIT ADDRESS MODE MASK B00100000

#define I2C END TX MASK B01000000
#define I2C STOP_TX 1
#define I2C RESTART TX 0
#define I2C_MAX QUERIES 8

#define I2C_REGISTER NOT SPECIFIED -1

// the minimum interval for sampling analog input
#define MINIMUM SAMPLING INTERVAL 1

// Adafruit
uint8 t ANALOG TO PIN(uint8 t n)

{
switch (n)
{
case 0 : return PIN AO;
case 1 : return PIN Al;
case 2 : return PIN A2;
case 3 : return PIN A3;
case 4 : return PIN A4;
case 5 : return PIN A5;
case 6 : return PIN A6;
case 7 : return PIN A7;
}
return 127;
}
/*
* GLOBAL VARIABLES
* */

#1ifdef FIRMATA SERIAL FEATURE
SerialFirmata serialFeature;
#endif

BLEUart bleuart;

/* analog inputs */
int analogInputsToReport = 0; // bitwise array to store pin reporting

/* digital input ports */
byte reportPINs[TOTAL PORTS]; // 1 = report this port, 0 = silence
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byte previousPINs[TOTAL PORTS]; // previous 8 bits sent

/* pins configuration */
byte portConfigInputs[TOTAL PORTS]; // each bit: 1 = pin in INPUT, 0 = anything else

/* timer variables */

unsigned long currentMillis; // store the current value from millis()
unsigned long previousMillis; // for comparison with currentMillis
unsigned int samplingInterval = 19; // how often to run the main loop (in ms)

/* i2c data */
struct i2c device info {
byte addr;
int reg;
byte bytes;
byte stopTX;
+i

/* for i2c read continuous more */
i2c device info query[I2C MAX QUERIES];

byte i2cRxData[64];

boolean isI2CEnabled = false;

signed char queryIndex = -1;

// default delay time between i2c read request and Wire.requestFrom()
unsigned int i2cReadDelayTime = 0;

Servo servos[MAX SERVOS];

byte servoPinMap[TOTAL PINS];
byte detachedServos[MAX SERVOS];
byte detachedServoCount = 0;
byte servoCount = 0;

boolean isResetting = false;

// Forward declare a few functions to avoid compiler errors with older versions
// of the Arduino IDE.

void setPinModeCallback(byte, int);

void reportAnalogCallback(byte analogPin, int value);

void sysexCallback(byte, byte, byte*);

/* utility functions */
void wireWrite(byte data)
{
#1f ARDUINO >= 100
Wire.write((byte)data);
#else
Wire.send(data);
#endif

}

byte wireRead(void)
{
#if ARDUINO >= 100
return Wire.read();
#else
return Wire.receive();
#endif
}
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/

*

* FUNCTIONS

*

void attachServo(byte pin, int minPulse, int maxPulse)

{

if (servoCount < MAX SERVOS) {
// reuse indexes of detached servos until all have been reallocated
if (detachedServoCount > 0) {
servoPinMap[pin] = detachedServos[detachedServoCount - 1];
if (detachedServoCount > 0) detachedServoCount--;
} else {
servoPinMap[pin] = servoCount;
servoCount++;
}
if (minPulse > 0 && maxPulse > 0) {

*/

servos[servoPinMap[pin]].attach(PIN TO DIGITAL(pin), minPulse, maxPulse);

} else {
servos[servoPinMap[pin]].attach(PIN TO DIGITAL(pin));
}
} else {
Firmata.sendString("Max servos attached");

}

void detachServo(byte pin)

{

servos|[servoPinMap[pin]].detach();

// if we're detaching the last servo, decrement the count

// otherwise store the index of the detached servo

if (servoPinMap[pin] == servoCount && servoCount > 0) {
servoCount--;

} else if (servoCount > 0) {
// keep track of detached servos because we want to reuse their indexes
// before incrementing the count of attached servos
detachedServoCount++;
detachedServos[detachedServoCount - 1] = servoPinMap[pin];

servoPinMap[pin] = 255;

void enableI2CPins()

{

byte 1i;
// is there a faster way to do this? would probaby require importing
// Arduino.h to get SCL and SDA pins
for (i = 0; 1 < TOTAL PINS; i++) {
if (IS PIN I2C(i)) {
// mark pins as i2c so they are ignore in non i2c data requests
setPinModeCallback (i, PIN MODE I2C);
b
}

isI2CEnabled = true;

Wire.begin();
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/* disable the i2c pins so they can be used for other functions */
void disableI2CPins() {

isI2CEnabled = false;

// disable read continuous mode for all devices

queryIndex = -1;

}

void readAndReportData(byte address, int theRegister, byte numBytes, byte stopTX) {
// allow I2C requests that don't require a register read
// for example, some devices using an interrupt pin to signify new data available
// do not always require the register read so upon interrupt you call Wire.requestFrom()
if (theRegister != I2C REGISTER NOT SPECIFIED) {
Wire.beginTransmission(address);
wireWrite((byte)theRegister);
Wire.endTransmission(stopTX); // default = true
// do not set a value of 0
if (i2cReadDelayTime > 0) {
// delay is necessary for some devices such as WiiNunchuck
delayMicroseconds (i2cReadDelayTime) ;
}
} else {
theRegister = 0; // fill the register with a dummy value
}

Wire.requestFrom(address, numBytes); // all bytes are returned in requestFrom

// check to be sure correct number of bytes were returned by slave
if (numBytes < Wire.available()) {

Firmata.sendString("I2C: Too many bytes received");
} else if (numBytes > Wire.available()) {

Firmata.sendString("I2C: Too few bytes received");

}
i2cRxData[0] = address;
i2cRxData[l] = theRegister;

for (int 1 = 0; i < numBytes && Wire.available(); i++) {
i2cRxData[2 + i] = wireRead();

// send slave address, register and received bytes
Firmata.sendSysex(SYSEX I2C_REPLY, numBytes + 2, i2cRxData);

void outputPort(byte portNumber, byte portValue, byte forceSend)
{
// pins not configured as INPUT are cleared to zeros
portValue = portValue & portConfigInputs[portNumber];
// only send if the value is different than previously sent
if (forceSend || previousPINs[portNumber] != portValue) {
Firmata.sendDigitalPort(portNumber, portValue);
previousPINs[portNumber] = portValue;

}

/* _____________________________________________________________________________
* check all the active digital inputs for change of state, then add any events
* to the Serial output queue using Serial.print() */

void checkDigitalInputs(void)

r
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* to readPort() are compile-time constants. */

if (TOTAL PORTS > 0 && reportPINs[O])
if (TOTAL PORTS > 1 && reportPINs[1])
if (TOTAL PORTS > 2 && reportPINs[2])
if (TOTAL PORTS > 3 && reportPINs[3])
if (TOTAL PORTS > 4 && reportPINs[4])
if (TOTAL PORTS > 5 && reportPINs[5])
if (TOTAL PORTS > 6 && reportPINs[6])
if (TOTAL PORTS > 7 && reportPINs[7])
if (TOTAL PORTS > 8 && reportPINs[8])
if (TOTAL PORTS > 9 && reportPINs[9])
if (TOTAL PORTS > 10 && reportPINs[10]
if (TOTAL PORTS > 11 && reportPINs[11]
if (TOTAL PORTS > 12 && reportPINs[12]
if (TOTAL PORTS > 13 && reportPINs[13]
if (TOTAL PORTS > 14 && reportPINs[14]
if (TOTAL PORTS > 15 && reportPINs[15]

}

//

outputPort(
outputPort(
outputPort(
outputPort(
outputPort(
outputPort(
outputPort(
outputPort(
outputPort(
outputPort(
outputPort
outputPort
outputPort
outputPort
outputPort
outputPort

—_—— — — — —

10, readPort
11, readPort
12, readPort
13, readPort
14,
15, readPort

—_~ e~~~ o~~~

Using non-looping code allows constants to be given to readPort().
* The compiler will apply substantial optimizations if the inputs

readPort(0,
readPort(1,
readPort(2,
readPort(3,
readPort (4,
readPort(5,
readPort(6,
readPort(7,
readPort (8

readPort(9,

readPort

—_~ e~~~ o~~~

portConfigInputs[0])
portConfigInputs[1])
portConfigInputs[2])
portConfigInputs[3])
portConfigInputs[4])
portConfigInputs[5])
portConfigInputs[6])
portConfigInputs[7])
, portConfigInputs[8])
portConfigInputs[9]),
, portConfigInputs[10]),
, portConfigInputs[11])
, portConfigInputs[12])
, portConfigInputs[13])

)

)

/* sets the pin mode to the correct state and sets the relevant bits in the
* two bit-arrays that track Digital I/0 and PWM status

*/
void setPinModeCallback(byte pin,
{

if (Firmata.getPinMode(pin) ==
return;

if (Firmata.getPinMode(pin) ==

int mode)

PIN MODE_IGNORE)

PIN_MODE I2C && isI2CEnabled && mode !=

// disable i2c so pins can be used for other functions

// the following if statements should reconfigure the pins properly

disableI2CPins();

}
if (IS PIN DIGITAL(pin) && mode !=

PIN MODE_SERVO) {

PIN MODE I2C)

if (servoPinMap[pin] < MAX SERVOS && servos[servoPinMap[pin]].attached()) {

detachServo(pin);
}

}
if (IS_PIN ANALOG(pin)) {

reportAnalogCallback (PIN TO ANALOG(pin),

}
if (IS PIN DIGITAL(pin)) {

if (mode == INPUT || mode == PIN MODE PULLUP) {
(1 << (pin & 7))

portConfigInputs[pin / 8] |=
} else {

portConfigInputs[pin / 8] & ~(1 << (pin & 7));

}
}
Firmata.setPinState(pin,
switch (mode) {

case PIN MODE ANALOG:

if (IS _PIN ANALOG(pin)) {
if (IS PIN DIGITAL(pin)) {
pinMode (PIN TO DIGITAL(pin),
#if ARDUINO <= 100

0);

INPUT);

’

mode == PIN _MODE ANALOG ? 1 :

// disable output driver

// deprecated since Arduino 1.0.1 - TODO: drop support in Firmata 2.6

digitalWrite(PIN_TO DIGITAL(pin),
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LOW); // disable internal pull-ups
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’

’

’

’

’

’

, false);

{

false);
false);

false);

)
)
)
)
false);
)
)
)
)

’
’
’

’
’
’

’

false);

, portConfigInputs[14]
, portConfigInputs[15]

false);

’

, false);

)
)
, false);
, false);
)
)

, false);

’

, false);

0); // turn on/off reporting
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#endif
}
Firmata.setPinMode(pin, PIN MODE ANALOG);
}
break;
case INPUT:
// Adafruit: Input without pull up cause pin state changes randomly --> lots of transmission data
// if (IS PIN DIGITAL(pin)) {

// pinMode (PIN TO DIGITAL(pin), INPUT); // disable output driver
//#if ARDUINO <= 100

// // deprecated since Arduino 1.0.1 - TODO: drop support in Firmata 2.6
// digitalWrite(PIN TO DIGITAL(pin), LOW); // disable internal pull-ups
//#endif

// Firmata.setPinMode(pin, INPUT);

// }

// break;

case PIN MODE PULLUP:
if (IS PIN DIGITAL(pin)) {
pinMode(PIN TO DIGITAL(pin), INPUT PULLUP);
Firmata.setPinMode(pin, PIN MODE PULLUP);
Firmata.setPinState(pin, 1);
}
break;
case OUTPUT:
if (IS PIN DIGITAL(pin)) {
if (Firmata.getPinMode(pin) == PIN MODE PWM) {
// Disable PWM if pin mode was previously set to PWM.
digitalWrite(PIN TO DIGITAL(pin), LOW);
}
pinMode(PIN TO DIGITAL(pin), OUTPUT);
Firmata.setPinMode(pin, OUTPUT);
}
break;
case PIN MODE PwWM:
if (IS PIN PWM(pin)) {
pinMode(PIN TO PWM(pin), OUTPUT);
analogWrite(PIN TO PWM(pin), 0);
Firmata.setPinMode(pin, PIN MODE PWM) ;
}
break;
case PIN_MODE_SERVO:
if (IS PIN DIGITAL(pin)) {
Firmata.setPinMode(pin, PIN MODE SERVO);
if (servoPinMap[pin] == 255 || !servos[servoPinMap[pin]].attached()) {
// pass -1 for min and max pulse values to use default values set
// by Servo library
attachServo(pin, -1, -1);
}
}
break;
case PIN_MODE_I2C:
if (IS PIN I2C(pin)) {
// mark the pin as i2c
// the user must call I2C CONFIG to enable I2C for a device
Firmata.setPinMode(pin, PIN MODE I2C);
}
break;
case PIN MODE SERIAL:
#1ifdef FIRMATA SERIAL FEATURE

carialCant+iira handl ADi nMAaAdA RN DTN MNNE CEDTAIL \ .
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#endif
break;
default:
Firmata.sendString("Unknown pin mode"); // TODO: put error msgs in EEPROM
}
// TODO: save status to EEPROM here, if changed
}
/*

* Sets the value of an individual pin. Useful if you want to set a pin value but
* are not tracking the digital port state.
* Can only be used on pins configured as OUTPUT.
* Cannot be used to enable pull-ups on Digital INPUT pins.
*/
void setPinValueCallback(byte pin, int value)
{
if (pin < TOTAL PINS && IS PIN DIGITAL(pin)) {
if (Firmata.getPinMode(pin) == OUTPUT) {
Firmata.setPinState(pin, value);
digitalWrite(PIN_TO DIGITAL(pin), value);

}
}
}
void analogWriteCallback(byte pin, int value)
{
if (pin < TOTAL PINS) {
switch (Firmata.getPinMode(pin)) {
case PIN MODE SERVO:
if (IS PIN DIGITAL(pin))
servos[servoPinMap[pin]].write(value);
Firmata.setPinState(pin, value);
break;
case PIN_MODE_PWM:
if (IS_PIN PWM(pin))
analogWrite(PIN TO PWM(pin), value);
Firmata.setPinState(pin, value);
break;
}
}
}

void digitalWriteCallback(byte port, int value)

{
byte pin, lastPin, pinValue, mask = 1, pinWriteMask = 0;

if (port < TOTAL PORTS) {
// create a mask of the pins on this port that are writable.
lastPin = port * 8 + 8;
if (lastPin > TOTAL PINS) lastPin = TOTAL PINS;
for (pin = port * 8; pin < lastPin; pin++) {
// do not disturb non-digital pins (eg, Rx & Tx)
if (IS _PIN DIGITAL(pin)) {
// do not touch pins in PWM, ANALOG, SERVO or other modes
if (Firmata.getPinMode(pin) == OUTPUT || Firmata.getPinMode(pin) == INPUT) {
pinValue = ((byte)value & mask) ? 1 : 0;
if (Firmata.getPinMode(pin) == OUTPUT) {
pinWriteMask |= mask;
} else if (Firmata.getPinMode(pin) == INPUT && pinValue == 1 && Firmata.getPinState(pin) != 1)
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// only handle INPUT here for backwards compatibility
#if ARDUINO > 100
pinMode(pin, INPUT PULLUP);

#else
// only write to the INPUT pin to enable pullups if Arduino v1.0.0 or earlier
pinWriteMask |= mask;
#endif
}
Firmata.setPinState(pin, pinValue);
}
}
mask = mask << 1;
}
writePort(port, (byte)value, pinWriteMask);

}
}
[/ s e s oeosoosoooio-ooooo--o--
/* sets bits in a bit array (int) to toggle the reporting of the analoglIns

*/
//void FirmataClass::setAnalogPinReporting(byte pin, byte state) {
s
void reportAnalogCallback(byte analogPin, int value)
{

if (analogPin < TOTAL ANALOG PINS) {
if (value == 0) {
analogInputsToReport = analogInputsToReport & ~ (1 << analogPin);
} else {
analogInputsToReport = analogInputsToReport | (1 << analogPin);
// prevent during system reset or all analog pin values will be reported
// which may report noise for unconnected analog pins
if (!isResetting) {
// Send pin value immediately. This is helpful when connected via
// ethernet, wi-fi or bluetooth so pin states can be known upon
// reconnecting.
Firmata.sendAnalog(analogPin, analogRead( ANALOG TO PIN(analogPin) ) );

}
}
}
// TODO: save status to EEPROM here, if changed
}
void reportDigitalCallback(byte port, int value)
{
if (port < TOTAL PORTS) {
reportPINs[port] = (byte)value;
// Send port value immediately. This is helpful when connected via
// ethernet, wi-fi or bluetooth so pin states can be known upon
// reconnecting.
if (value) outputPort(port, readPort(port, portConfigInputs[port]), true);
}
// do not disable analog reporting on these 8 pins, to allow some
// pins used for digital, others analog. Instead, allow both types
// of reporting to be enabled, but check if the pin is configured
// as analog when sampling the analog inputs. Likewise, while
// scanning digital pins, portConfigInputs will mask off values from any
// pins configured as analog
}
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/*
* SYSEX-BASED commands
*

void sysexCallback(byte command, byte argc, byte *argv)
{

byte mode;

byte stopTX;

byte slaveAddress;

byte data;

int slaveRegister;

unsigned int delayTime;

switch (command) {
case I2C REQUEST:
mode = argv[1] & I2C READ WRITE MODE MASK;
if (argv[1l] & I2C 10BIT ADDRESS MODE MASK) {
Firmata.sendString("10-bit addressing not supported");
return;
}
else {
slaveAddress = argv[0];

// need to invert the logic here since 0 will be default for client
// libraries that have not updated to add support for restart tx
if (argv[1] & I2C END TX MASK) {
stopTX = I2C RESTART TX;
}
else {
stopTX = I2C_STOP_TX; // default
}

switch (mode) {
case I2C WRITE:
Wire.beginTransmission(slaveAddress);
for (byte i = 2; i < argc; i += 2) {
data = argv[i] + (argv[i + 1] << 7);
wireWrite(data);
}
Wire.endTransmission();
delayMicroseconds(70);
break;
case I2C READ:
if (argc == 6) {
// a slave register is specified
slaveRegister = argv[2] + (argv[3] << 7);
data = argv[4] + (argv[5] << 7); // bytes to read
}
else {
// a slave register is NOT specified
slaveRegister = I2C REGISTER NOT SPECIFIED;
data = argv[2] + (argv[3] << 7); // bytes to read
}
readAndReportData(slaveAddress, (int)slaveRegister, data, stopTX);
break;
case I2C READ CONTINUOUSLY:
if ((queryIndex + 1) >= I2C MAX QUERIES) {
// too many queries, just ignore
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Firmata.sendString("too many queries");

break;
}
if (argc == 6) {
// a slave register is specified
slaveRegister = argv[2] + (argv[3] << 7);
data = argv[4] + (argv[5] << 7); // bytes to read
}
else {
// a slave register is NOT specified
slaveRegister = (int)I2C_REGISTER NOT SPECIFIED;
data = argv[2] + (argv[3] << 7); // bytes to read
}
queryIndex++;

query[queryIndex].addr = slaveAddress;
query[queryIndex].reg = slaveRegister;
query[queryIndex].bytes = data;
query[queryIndex].stopTX = stopTX;
break;

case I2C STOP READING:
byte queryIndexToSkip;

// if read continuous mode is enabled for only 1 i2c device, disable

// read continuous reporting for that device
if (queryIndex <= 0) {

queryIndex = -1;
} else {

queryIndexToSkip = 0;

// if read continuous mode is enabled for multiple devices,

// determine which device to stop reading and remove it's data from
// the array, shifiting other array data to fill the space

for (byte i = 0; i < queryIndex + 1; i++) {

if (query[i].addr == slaveAddress) {
queryIndexToSkip = i;
break;

for (byte i = queryIndexToSkip; i < queryIndex + 1; i++) {

if (i < I2C MAX QUERIES) {
query[i].addr = query[i + 1].addr;
query[il.reg = query[i + 1].reg;
query[i].bytes = query[i + 1].bytes;
query[i].stopTX = query[i + 1].stopTX;
}
}
queryIndex--;
}
break;
default:
break;
b
break;
case I2C CONFIG:
delayTime = (argv[0] + (argv[l] << 7));

if (delayTime > 0) {
i2cReadDelayTime = delayTime;
}

if (1ieT2CFnahled) {
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enableI2CPins();
}

break;
case SERVO CONFIG:
if (argc > 4) {

// these vars are here for clarity, they'll optimized away by the compiler

byte pin = argv[0];
int minPulse = argv[1l] + (argv[2] << 7);
int maxPulse = argv[3] + (argv[4] << 7);

if (IS _PIN DIGITAL(pin)) {

if (servoPinMap[pin] < MAX SERVOS && servos[servoPinMap[pin]].attached()) {

detachServo(pin);
}
attachServo(pin, minPulse, maxPulse);
setPinModeCallback(pin, PIN MODE SERVO);
b
}
break;
case SAMPLING INTERVAL:
if (argc > 1) {
samplingInterval = argv[0] + (argv[l] << 7);
if (samplingInterval < MINIMUM SAMPLING INTERVAL) {
samplingInterval = MINIMUM SAMPLING INTERVAL;
b
} else {
//Firmata.sendString("Not enough data");
}
break;
case EXTENDED ANALOG:
if (argc > 1) {
int val = argv[1l];
if (argc > 2) val |= (argv[2] << 7);
if (argc > 3) val |= (argv[3] << 14);
analogWriteCallback(argv[0], val);
b
break;
case CAPABILITY QUERY:
Firmata.write(START SYSEX);
Firmata.write(CAPABILITY RESPONSE);
for (byte pin = 0; pin < TOTAL PINS; pin++) {
if (IS _PIN DIGITAL(pin)) {
Firmata.write((byte)INPUT);
Firmata.write(1);
Firmata.write((byte)PIN MODE PULLUP);
Firmata.write(1);
Firmata.write((byte)OUTPUT);
Firmata.write(1);
b
if (IS _PIN ANALOG(pin)) {
Firmata.write(PIN_MODE_ANALOG);
Firmata.write(10); // 10 = 10-bit resolution
b
if (IS _PIN PWM(pin)) {
Firmata.write(PIN_MODE_PWM) ;
Firmata.write(DEFAULT PWM RESOLUTION);
b
if (IS _PIN DIGITAL(pin)) {
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Firmata.write(PIN MODE SERVO);
Firmata.write(14);

}

if (IS PIN I2C(pin)) {
Firmata.write(PIN MODE I2C);

Firmata.write(1l); // TODO: could assign a number to map to SCL or SDA

}
#ifdef FIRMATA SERIAL FEATURE
serialFeature.handleCapability(pin);
#endif
Firmata.write(127);
b
Firmata.write(END SYSEX);
break;
case PIN STATE QUERY:
if (argc > 0) {
byte pin = argv([0];
Firmata.write(START SYSEX);
Firmata.write(PIN STATE RESPONSE);
Firmata.write(pin);
if (pin < TOTAL PINS) {
Firmata.write(Firmata.getPinMode(pin));

Firmata.write((byte)Firmata.getPinState(pin) & Ox7F);

if (Firmata.getPinState(pin) & OxFF80) Firmata.write((byte)(Firmata.getPinState(pin) >> 7) & 0
if (Firmata.getPinState(pin) & 0xC000) Firmata.write((byte)(Firmata.getPinState(pin) >> 14) &

b
Firmata.write(END SYSEX);
b
break;
case ANALOG MAPPING QUERY:
Firmata.write(START SYSEX);
Firmata.write(ANALOG MAPPING RESPONSE);
for (byte pin = 0; pin < TOTAL PINS; pin++) {
Firmata.write(IS_PIN_ANALOG(pin) ? PIN_TO_ANALOG(pin)
b
Firmata.write(END SYSEX);
break;

case SERIAL MESSAGE:
#1ifdef FIRMATA SERIAL FEATURE
serialFeature.handleSysex(command, argc, argv);
#endif
break;

127);

/*

* SETUP()

*

void systemResetCallback()
{

isResetting = true;

// initialize a defalt state

// TODO: option to load config from EEPROM instead of default

#1ifdef FIRMATA SERIAL FEATURE
serialFeature.reset();
#endif
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if (isI2CEnabled) {
disableI2CPins();
}

for (byte i = 0; i < TOTAL PORTS; i++) {
reportPINs[i] = false; // by default, reporting off
portConfigInputs[i] = 0; // until activated
previousPINs[i] = 0;

}

for (byte i = 0; i < TOTAL _PINS; i++) {

// pins with analog capability default to analog input

// otherwise, pins default to digital output

if (IS PIN ANALOG(i)) {
// turns off pullup, configures everything
setPinModeCallback (i, PIN MODE ANALOG);

} else if (IS PIN DIGITAL(i)) {
// sets the output to 0, configures portConfigInputs
setPinModeCallback (i, OUTPUT);

servoPinMap[i] = 255;
}
// by default, do not report any analog inputs
analogInputsToReport = 0;

detachedServoCount = 0;
servoCount = 0;

/* send digital inputs to set the initial state on the host computer,
* since once in the loop(), this firmware will only send on change */
/*
TODO: this can never execute, since no pins default to digital input
but it will be needed when/if we support EEPROM stored config
for (byte i=0; i < TOTAL PORTS; i++) {
outputPort(i, readPort(i, portConfigInputs[i]), true);
}
*/
isResetting = false;

void setup()

{
Serial.begin(115200);
Serial.println("Bluefruit52 Standard Firmata via BLEUART Example");
Serial.println(M-----mmmm o \n");

// Config the peripheral connection with maximum bandwidth
// more SRAM required by SoftDevice
Bluefruit.configPrphBandwidth(BANDWIDTH MAX);

Bluefruit.begin();
Bluefruit.setName("Bluefruit52");

// Set max power. Accepted values are: -40, -30, -20, -16, -12, -8, -4, 0, 4
Bluefruit.setTxPower(4);

// try to go as fast as possible, could be rejected by some central, increase it if needed
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// 1i0S won't negotitate and will mostly use 30ms
Bluefruit.setConnInterval(9, 24); // min = 9*%1.25=11.25 ms, max = 23*1.25=30ms

// Configure and Start BLE Uart Service

// Firmata use several small write(l) --> buffering TXD is required to run smoothly
// Enable buffering TXD

bleuart.begin();

bleuart.bufferTXD(true);

Firmata.setFirmwareVersion(FIRMATA_ FIRMWARE_MAJOR_VERSION, FIRMATA FIRMWARE_MINOR VERSION);

Firmata.attach
Firmata.attach
Firmata.attach
Firmata.attach
Firmata.attach
Firmata.attach
Firmata.attach
Firmata.attach

ANALOG _MESSAGE, analogWriteCallback);
DIGITAL MESSAGE, digitalWriteCallback);
REPORT ANALOG, reportAnalogCallback);
REPORT DIGITAL, reportDigitalCallback);

SET PIN MODE, setPinModeCallback);

SET DIGITAL PIN VALUE, setPinValueCallback);
START SYSEX, sysexCallback);

SYSTEM RESET, systemResetCallback);

—_~ e~~~ o~~~ —~

// use bleuart as transportation layer
Firmata.begin(bleuart);

// to use a port other than Serial, such as Seriall on an Arduino Leonardo or Mega,

// Call begin(baud) on the alternate serial port and pass it to Firmata to begin like this:
// Seriall.begin(57600);

// Firmata.begin(Seriall);

// However do not do this if you are using SERIAL MESSAGE

//Firmata.begin(57600);

//while (!'Serial) {

// ; // wait for serial port to connect. Needed for ATmega32u4-based boards and Arduino 101
//}

systemResetCallback(); // reset to default config

// Set up and start advertising
startAdv();

void startAdv(void)

{
// Advertising packet
Bluefruit.Advertising.addFlags (BLE GAP ADV FLAGS LE ONLY GENERAL DISC MODE);
Bluefruit.Advertising.addTxPower();

// Include bleuart 128-bit uuid
Bluefruit.Advertising.addService(bleuart);

// Secondary Scan Response packet (optional)
// Since there is no room for 'Name' in Advertising packet
Bluefruit.ScanResponse.addName();

/* Start Advertising
* - Enable auto advertising if disconnected
* - Interval: fast mode = 20 ms, slow mode = 152.5 ms
* - Timeout for fast mode is 30 seconds
* - Start(timeout) with timeout = 0 will advertise forever (until connected)
*
*

For recommended advertisina interval
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* https://developer.apple.com/library/content/qa/qal931/ index.html

*/

Bluefruit.Advertising.restartOnDisconnect(true);

Bluefruit.Advertising.setInterval(32, 244); // in unit of 0.625 ms
Bluefruit.Advertising.setFastTimeout(30); // number of seconds in fast mode
Bluefruit.Advertising.start(0); // © = Don't stop advertising after n seconds

/*
* LOOP()
* */
void loop()
{
// Skip if not connected and bleuart notification is enabled
if ( !(Bluefruit.connected() && bleuart.notifyEnabled()) )
{
// go to low power mode since there is nothing to do
waitForEvent();
return;

byte pin, analogPin;

/* DIGITALREAD - as fast as possible, check for changes and output them to the
* FTDI buffer using Serial.print() */
checkDigitalInputs();

/* STREAMREAD - processing incoming messagse as soon as possible, while still
* checking digital inputs. */
while (Firmata.available())
Firmata.processInput();

// TODO - ensure that Stream buffer doesn't go over 60 bytes

currentMillis = millis();
if (currentMillis - previousMillis > samplingInterval) {
previousMillis += samplingInterval;
/* ANALOGREAD - do all analogReads() at the configured sampling interval */
for (pin = 0; pin < TOTAL PINS; pin++) {
if (IS PIN ANALOG(pin) && Firmata.getPinMode(pin) == PIN MODE ANALOG) {
analogPin = PIN TO ANALOG(pin);
if (analogInputsToReport & (1 << analogPin)) {
Firmata.sendAnalog(analogPin, analogRead( ANALOG TO PIN(analogPin) ));

¥
¥

// report i2c data for all device with read continuous mode enabled
if (queryIndex > -1) {
for (byte i = 0; i < queryIndex + 1; i++) {
readAndReportData(query[i].addr, query[i]l.reg, query[i].bytes, query[i].stopTX);
}

#ifdef FIRMATA SERIAL FEATURE
serialFeature.update();

#endif

}

4] EEEEEEE
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Central BLEUART

This example show you how to use Feather nRF52 as a Central to talk to other Bluefruit (nRF52 or nRF51) peripherals
exposing the bleuart (AKA 'NUS') service.

Client Services

Since the Central role accesses the GATT server on the peripheral, we first need to declare a client bleuart instance
using the BLEClientUart helper class. We can also conveniently read Device Information if BLEClientDis is also used.

BLEClientDis clientDis;
BLEClientUart clientUart;

Before we can configure client services, Bluefruit.begin() must be called with at least 1 for the number of concurrent
connections supported in central mode. Since we won't be running the nRF52 as a peripheral in this instance, we will
set the peripheral count to O:

// Initialize Bluefruit with maximum connections as Peripheral = 0, Central =1
Bluefruit.begin(0, 1);

Afterward this, the client service(s) must be initialized by calling their begin() function, and you can setup any callbacks
that you wish to use from the helper class:

// Configure DIS client
clientDis.begin();

// Init BLE Central Uart Serivce
clientUart.begin();
clientUart.setRxCallback(bleuart rx callback);

Scanner

Let's start the advertising scanner to find a peripheral.
We'll hook up the scan result callback with setRxCallback().

Whenever advertising data is found by the scanner, it will be passed to this callback handler, and we can examine the
advertising data there, and only connect to peripheral(s) that advertise the bleuart service.

Note: If the peripheral has multiple services and bleuart is not included in the UUID list in the advertising packet, you
could optionally use another check such as matching the MAC address, name checking, using "another service", etc.

Once we find a peripheral that we wish to communicate with, call Bluefruit.Central.connect() to establish connection with
it:
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void setup()

{
// Other set up .....

/* Start Central Scanning

* - Enable auto scan if disconnected

* - Interval = 100 ms, window = 80 ms

* - Don't use active scan

* - Start(timeout) with timeout = 0 will scan forever (until connected)
*/

Bluefruit.Scanner.setRxCallback(scan callback);
Bluefruit.Scanner.restartOnDisconnect(true);
Bluefruit.Scanner.setInterval (160, 80); // in unit of 0.625 ms
Bluefruit.Scanner.useActiveScan(false);

Bluefruit.Scanner.start(0); // // O = Don't stop scanning after n seconds

Vo
* Callback invoked when scanner pick up an advertising data
* @param report Structural advertising data
*/
void scan callback(ble gap evt adv report t* report)
{
// Check if advertising contain BleUart service
if ( Bluefruit.Scanner.checkReportForService(report, clientUart) )

{
Serial.print("BLE UART service detected. Connecting ... ");
// Connect to device with bleuart service in advertising
Bluefruit.Central.connect(report);
}
}

Central Role

You normally need to setup the Central mode device's connect callback, which fires when a connection is
established/disconnected with a peripheral device. Alternatively you could poll the connection status with connected(),
but callbacks help to simplify the code significantly:

// Callbacks for Central
Bluefruit.Central.setConnectCallback(connect callback);
Bluefruit.Central.setDisconnectCallback(disconnect callback);

In the connect callback, we will try to discover the bleuart service by browsing the GATT table of the peripheral. This
will help to determine the handle values for characteristics (e.g TXD, RXD, etc.). This is all done by BLEClientUart's
.discover() . Once the service is found, enable the TXD characteristic's CCCD to allow the peripheral to send data, and
we are ready to send data back and forth between the devices:
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void connect callback(uintl6 t conn_handle)

{

Serial.println("Connected");

Serial.print("Dicovering DIS ... ");
if ( clientDis.discover(conn handle) )

{
Serial.println("Found it");
char buffer[32+1];

// read and print out Manufacturer
memset (buffer, 0, sizeof(buffer));
if ( clientDis.getManufacturer(buffer, sizeof(buffer)) )
{
Serial.print("Manufacturer: ");
Serial.println(buffer);
}

// read and print out Model Number
memset (buffer, 0, sizeof(buffer));
if ( clientDis.getModel (buffer, sizeof(buffer)) )
{
Serial.print("Model: ");
Serial.println(buffer);
b

Serial.println();

Serial.print("Discovering BLE Uart Service ... ");

if ( clientUart.discover(conn handle) )

{

Serial.println("Found it");

Serial.println("Enable TXD's notify");
clientUart.enableTXD();

Serial.println("Ready to receive from peripheral");
}else
{

Serial.println("Found NONE");

// disconect since we couldn't find bleuart service
Bluefruit.Central.disconnect(conn handle);

}

Full Sample Code

The full sample code for this example can be seen below, but this maybe be out of sync with the latest code available
on Github. Please consult the Github code if you have any problems with the code below.

#include <bluefruit.h>

BLEClientDis clientDis;
BLEClientUart clientUart;
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void setup()

{
Serial.begin(115200);

Serial.println("Bluefruit52 Central BLEUART Example");
Serial.println("---------mmmmmmm o \n");

// Initialize Bluefruit with maximum connections as Peripheral = 0, Central =1
// SRAM usage required by SoftDevice will increase dramatically with number of connections
Bluefruit.begin(0, 1);

Bluefruit.setName("Bluefruit52 Central");

// Configure DIS client
clientDis.begin();

// Init BLE Central Uart Serivce
clientUart.begin();
clientUart.setRxCallback(bleuart rx callback);

// Increase Blink rate to different from PrPh advertising mode
Bluefruit.setConnLedInterval(250);

// Callbacks for Central
Bluefruit.Central.setConnectCallback(connect callback);
Bluefruit.Central.setDisconnectCallback(disconnect callback);

/* Start Central Scanning

* - Enable auto scan if disconnected

* - Interval = 100 ms, window = 80 ms

* - Don't use active scan

* - Start(timeout) with timeout = 0 will scan forever (until connected)
*/

Bluefruit.Scanner.setRxCallback(scan callback);
Bluefruit.Scanner.restartOnDisconnect(true);
Bluefruit.Scanner.setInterval (160, 80); // in unit of 0.625 ms
Bluefruit.Scanner.useActiveScan(false);

Bluefruit.Scanner.start(0); // // 0 = Don't stop scanning after n seconds

/**
* Callback invoked when scanner pick up an advertising data
* @param report Structural advertising data
*/
void scan callback(ble gap evt adv report t* report)
{
// Check if advertising contain BleUart service
if ( Bluefruit.Scanner.checkReportForService(report, clientUart) )

{
Serial.print("BLE UART service detected. Connecting ... ");

// Connect to device with bleuart service in advertising
Bluefruit.Central.connect(report);

}

/**
* Callback invoked when an connection is established
* @param conn handle
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*/
void connect callback(uintl6 t conn_handle)
{

Serial.println("Connected");

Serial.print("Dicovering DIS ... ");
if ( clientDis.discover(conn handle) )
{

Serial.println("Found it");
char buffer[32+1];

// read and print out Manufacturer
memset (buffer, 0, sizeof(buffer));
if ( clientDis.getManufacturer(buffer, sizeof(buffer)) )
{
Serial.print("Manufacturer: ");
Serial.println(buffer);
b

// read and print out Model Number
memset (buffer, 0, sizeof(buffer));
if ( clientDis.getModel (buffer, sizeof(buffer)) )
{
Serial.print("Model: ");
Serial.println(buffer);
}

Serial.println();

Serial.print("Discovering BLE Uart Service ... ");

if ( clientUart.discover(conn handle) )

{
Serial.println("Found it");
Serial.println("Enable TXD's notify");
clientUart.enableTXD();
Serial.println("Ready to receive from peripheral");
}else
{
Serial.println("Found NONE");
// disconect since we couldn't find bleuart service
Bluefruit.Central.disconnect(conn handle);
}
}
/**

* Callback invoked when a connection is dropped
* @param conn_handle
* @param reason
*/
void disconnect callback(uintl6 t conn handle, uint8 t reason)
{
(void) conn handle;
(void) reason;
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serial.printin(”bisconnected”);

}

/**
* Callback invoked when uart received data
* @param uart svc Reference object to the service where the data
* arrived. In this example it is clientUart
*/
void bleuart_rx_callback(BLEClientUart& uart_svc)

{
Serial.print("[RX]: ");

while ( uart svc.available() )
{
Serial.print( (char) uart svc.read() );

}

Serial.println();

}

void loop()
{
if ( Bluefruit.Central.connected() )
{
// Not discovered yet
if ( clientUart.discovered() )
{
// Discovered means in working state
// Get Serial input and send to Peripheral
if ( Serial.available() )

{

delay(2); // delay a bit for all characters to arrive

char str[20+1] = { 0 };
Serial.readBytes(str, 20);

clientUart.print( str );
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Dual Roles BLEUART

If you are not familiar with Central Role, it is advised to look at the "Central BLEUART" example first then

continue with this afterwards.

This example demonstrates how you can use a Feather nRF52 to connect to two other Bluefruit or BLE devices using
the bleuart (AKA 'NUS') service concurrently, with the device running at both a peripheral and a central at the same
time.

This dual role example acts as a BLE bridge that sits between a central and a peripheral forwarding bleuart messages
back and forth, as shown in the image below:

BLE Central

Bt nRFS2 |
{mobéle, PC) e

BLE Peripheral

r 3
L )
L

Server & Client Service Setup

Since the Bluefruit device will act as both a central and a peripheral, we will need to declare both server and client
instance of the bleuart helper class:

// Peripheral uart service
BLEUart bleuart;

// Central uart client
BLEClientUart clientUart;

Before we can configure client services, Bluefruit.begin() must be called with at least 1 for the number of concurrent
connection for both peripheral and central mode:

// Initialize Bluefruit with max concurrent connections as Peripheral = 1, Central =1
Bluefruit.begin(1l, 1);

After this, client services must be initialized by calling their begin() function, followed by any callbacks that you wish to
wire up as well:

// Configure and Start BLE Uart Service
bleuart.begin();
bleuart.setRxCallback(prph bleuart rx callback);

// Init BLE Central Uart Serivce

clientUart.begin();
clientUart.setRxCallback(cent bleuart rx callback);
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We are then ready to forward data from central to peripheral and vice versa using callbacks:

void cent bleuart rx callback(BLEClientUart& cent uart)

{
char str[20+1] = { 0 };
cent_uart.read(str, 20);

Serial.print("[Cent] RX: ");
Serial.println(str);

if ( bleuart.notifyEnabled() )
{
// Forward data from our peripheral to Mobile
bleuart.print( str );
}else
{
// response with no prph message
clientUart.println("[Cent] Peripheral role not connected");
}
}

void prph bleuart rx callback(void)
{

// Forward data from Mobile to our peripheral
char str[20+1] = { 0 };
bleuart.read(str, 20);

Serial.print("[Prph] RX: ");
Serial.println(str);

if ( clientUart.discovered() )
{

clientUart.print(str);
}else

{

bleuart.println("[Prph] Central role not connected");
}
}

Peripheral Role

The first thing to do for the peripheral part of our code is to setup the connect callback, which fires when a connection
is established/disconnected with the central. Alternatively you could poll the connection status with connected(), but
callbacks helps to simplify the code significantly:

// Callbacks for Peripheral
Bluefruit.setConnectCallback(prph_connect callback);
Bluefruit.setDisconnectCallback(prph disconnect callback);

Central Role

Next we setup the Central mode connect callback, which fires when a connection is established/disconnected with a
peripheral device:
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// Callbacks for Central
Bluefruit.Central.setConnectCallback(cent_connect callback);
Bluefruit.Central.setDisconnectCallback(cent disconnect callback);

Advertising and Scanner

It is possible to start both the scanner and advertising at the same time so that we can discover and be discovered by
other BLE devices. For the scanner, we use a filter that only fires the callback if a specific UUID is found in the

advertising data of the peer device:

/* Start Central Scanning
* - Enable auto scan if disconnected
* - Interval = 100 ms, window = 80 ms
* - Filter only accept bleuart service
* - Don't use active scan
* - Start(timeout) with timeout = 0 will scan forever (until connected)
*/

Bluefruit.Scanner.setRxCallback(scan callback);
Bluefruit.Scanner.restartOnDisconnect(true);
Bluefruit.Scanner.setInterval (160, 80); // in unit of 0.625 ms
Bluefruit.Scanner.filterUuid(bleuart.uuid);
Bluefruit.Scanner.useActiveScan(false);

Bluefruit.Scanner.start(0); // 0 = Don't stop scanning after n seconds

// Advertising packet
Bluefruit.Advertising.addFlags (BLE GAP ADV FLAGS LE ONLY GENERAL DISC MODE);
Bluefruit.Advertising.addTxPower();

// Include bleuart 128-bit uuid
Bluefruit.Advertising.addService(bleuart);

// Secondary Scan Response packet (optional)
// Since there is no room for 'Name' in Advertising packet
Bluefruit.ScanResponse.addName();

/* Start Advertising
* - Enable auto advertising if disconnected
* - Interval: fast mode = 20 ms, slow mode = 152.5 ms
* - Timeout for fast mode is 30 seconds
* - Start(timeout) with timeout = 0 will advertise forever (until connected)
*
*
*

For recommended advertising interval
https://developer.apple.com/library/content/qa/qal931/ index.html
*/
Bluefruit.Advertising.restartOnDisconnect(true);

Bluefruit.Advertising.setInterval(32, 244); // in unit of 0.625 ms
Bluefruit.Advertising.setFastTimeout(30); // number of seconds in fast mode
Bluefruit.Advertising.start(0); // 0 = Don't stop advertising after n seconds

Full Sample Code

The full sample code for this example can be seen below, but this maybe be out of sync with the latest code available

on Github. Please consult the Github code if you have any problems with the code below.

#include <bluefruit.h>
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// Peripheral uart service
BLEUart bleuart;

// Central uart client
BLEClientUart clientUart;

void setup()

{

Serial.begin(115200);

Serial.println("Bluefruit52 Dual Role BLEUART Example");

Serial.println("

// Initialize Bluefruit with max concurrent connections as Peripheral = 1, Central =1
// SRAM usage required by SoftDevice will increase with number of connections

Bluefruit.begin(1l, 1);
// Set max power. Accepted values are: -40, -30, -20, -16, -12, -8, -4, 0, 4
Bluefruit.setTxPower(4);
Bluefruit.setName("Bluefruit52 duo");

// Callbacks for Peripheral
Bluefruit.setConnectCallback(prph_connect_callback);
Bluefruit.setDisconnectCallback(prph disconnect callback);

// Callbacks for Central
Bluefruit.Central.setConnectCallback(cent_connect callback);
Bluefruit.Central.setDisconnectCallback(cent disconnect callback);

// Configure and Start BLE Uart Service
bleuart.begin();
bleuart.setRxCallback(prph bleuart rx callback);

// Init BLE Central Uart Serivce
clientUart.begin();
clientUart.setRxCallback(cent bleuart rx callback);

* X X X X ¥

*/

Bluefruit.
Bluefruit.
Bluefruit.
Bluefruit.
Bluefruit.
Bluefruit.

// Set up

Scanner

Scanner.
Scanner.
Scanner.
Scanner.

Start Central Scanning
- Enable auto scan if disconnected
- Interval = 100 ms, window = 80 ms
- Filter only accept bleuart service
- Don't use active scan
- Start(timeout) with timeout = 0 will scan forever (until connected)

.setRxCallback(scan callback);
Scanner.

restartOnDisconnect(true);

setInterval(160, 80); // in unit of 0.625 ms
filterUuid(bleuart.uuid);
useActiveScan(false);

start(0);

// 06 = Don't stop scanning

and start advertising
startAdv();

void startAdv(void)

{

// Advertising packet
Bluefruit.Advertising.addFlags (BLE GAP_ADV FLAGS LE ONLY GENERAL DISC MODE);
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Bluefruit.Advertising.addTxPower();

// Include bleuart 128-bit uuid
Bluefruit.Advertising.addService(bleuart);

// Secondary Scan Response packet (optional)
// Since there is no room for 'Name' in Advertising packet
Bluefruit.ScanResponse.addName();

/* Start Advertising

* - Enable auto advertising if disconnected
- Interval: fast mode = 20 ms, slow mode = 152.5 ms
- Timeout for fast mode is 30 seconds

For recommended advertising interval
https://developer.apple.com/library/content/qa/gqal931/ index.html
*/
Bluefruit.Advertising.restartOnDisconnect(true);

*
*
* - Start(timeout) with timeout = 0 will advertise forever (until connected)
*
*
*

Bluefruit.Advertising.setInterval(32, 244); // in unit of 0.625 ms
Bluefruit.Advertising.setFastTimeout(30); // number of seconds in fast mode
Bluefruit.Advertising.start(0); // © = Don't stop advertising after n seconds
}
void loop()
{
// do nothing, all the work is done in callback
}
/* __________________________________________________________________ */
/* Peripheral
K L o o e o o o e e e e e e e e e e e e e e e e — o — —— = */

void prph _connect callback(uintl6 t conn handle)

{
char peer name[32] = { 0 };
Bluefruit.Gap.getPeerName(conn handle, peer name, sizeof(peer name));
Serial.print("[Prph] Connected to ");
Serial.println(peer name);
}

void prph disconnect callback(uintl6 t conn handle, uint8 t reason)

{
(void) conn handle;
(void) reason;

Serial.println();
Serial.println("[Prph] Disconnected");

}

void prph bleuart rx callback(void)

{

// Forward data from Mobile to our peripheral
char str[20+1] = { 0 };
bleuart.read(str, 20);

Serial.print("[Prph] RX: ");
Serial.println(str);
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{
clientUart.print(str);
}else
{
bleuart.println("[Prph] Central role not connected");
}
}
/* __________________________________________________________________ */
/* Central
K o o e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e m e m e mmm e mm e m— e —— o —— - */

void scan callback(ble gap evt adv report t* report)

{
// Check if advertising contain BleUart service
if ( Bluefruit.Scanner.checkReportForService(report, clientUart) )
{
Serial.println("BLE UART service detected. Connecting ... ");
// Connect to device with bleuart service in advertising
Bluefruit.Central.connect(report);
}
}
void cent connect callback(uintl6 t conn handle)
{
char peer name[32] = { 0 };
Bluefruit.Gap.getPeerName(conn handle, peer name, sizeof(peer name));
Serial.print("[Cent] Connected to ");
Serial.println(peer name);;
if ( clientUart.discover(conn handle) )
{
// Enable TXD's notify
clientUart.enableTXD();
}else
{
// disconect since we couldn't find bleuart service
Bluefruit.Central.disconnect(conn handle);
}
}

void cent disconnect callback(uintl6 t conn handle, uint8 t reason)
{

(void) conn handle;

(void) reason;

Serial.println("[Cent] Disconnected");

}

Vo
* Callback invoked when uart received data
* @param cent uart Reference object to the service where the data
* arrived. In this example it is clientUart
*/
void cent bleuart rx callback(BLEClientUart& cent uart)
{
char str[20+1] = { 0 };
cent uart.read(str, 20);
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Serial.print("[Cent] RX: ");
Serial.println(str);

if ( bleuart.notifyEnabled() )
{
// Forward data from our peripheral to Mobile
bleuart.print( str );
}else
{
// response with no prph message
clientUart.println("[Cent] Peripheral role not connected");

}
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Bluefruit nRF52 API

The Adafruit nRF52 core defines a number of custom classes that aim to make it easy to work with BLE in your
projects.

The key classes are listed below, and examined in more detail elsewhere in this learning guide:

e AdafruitBluefruit is the main entry point to the Adafruit Bluefruit nRF52 API. This class exposes a number of
essential functions and classes, such as advertising, the list of GATT services and characteristics defined on your
device, and connection status.

® BLEService is a wrapper class for BLE GATT service records, and can be used to define custom service
definitions, or acts as the base class for any service helper classes.

o BLECharacteristic is a wrapper class for a BLE GATT characteristic record, and can be used to define custom
characteristics, or acts as the base class for any characteristic helper classes.

e BLEDis is a helper class for the DIS or 'Device Information Service'.

e BLEUart is a helper class for the NUS or 'Nordic UART Service'.

e BLEBeacon is a helper class to configure your nRF52 as a beacon using the advertising packet to send out
properly formatted beacon data.

e BLEMidiis a helper class to work with MIDI data over BLE.

e BLEHidAdafruit is a helper class to emulate an HID mouse or keyboard over BLE.

Details on each of these helper classes are found further in this learning guide.
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AdafruitBluefruit

The Bluefruit nRF52 Feather codebase is in an early BETA stage and is undergoing active development

based on customer feedback and testing. As such, the class documentation here is incomplete, and you
should consult the Github repo for the latest code and API developments:

This base class is the main entry point to the Adafruit Bluefruit nRF52 API, and exposes most of the helper classes and
functions that you use to configure your device.

API

AdafruitBluefruit has the following public API:

// Constructor
AdafruitBluefruit(void);

/* __________________________________________________________________ */
/* Lower Level Classes (Bluefruit.Advertising.*, etc.)
K L L o o o e o e e e e e e e e e e e e e e e e e e e — o m = */
BLEGap Gap;
BLEGatt Gatt;
BLEAdvertising Advertising;
BLEAdvertisingData ScanResponse;
BLEScanner Scanner;
BLECentral Central;
BLEDiscovery Discovery;
/* __________________________________________________________________ */

/* SoftDevice Configure Functions, must call before begin().
* These function affect the SRAM consumed by SoftDevice.

K o o e o e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e m e m m m m m m m m e mmm e —— - = */
void configServiceChanged (bool changed) ;
void configUuid128Count (uint8 t wuuid128 max);
void configAttrTableSize (uint32 t attr_table size);

// Config Bandwidth for connections
void configPrphConn (uintl6 t mtu max, uint8 t event len, uint8 t hvn gsize, uint8 t wrcmd gs:
void configCentralConn (uintl6 t mtu max, uint8 t event len, uint8 t hvn gsize, uint8 t wrcmd gs:

// Convenient function to config connection

void configPrphBandwidth (uint8 t bw);
void configCentralBandwidth(uint8 t bw);
err t begin(uint8 t prph count = 1, uint8 t central count = 0);
/* __________________________________________________________________ */
/* General Functions
K L L o o o e o e e e e e e e e e e e e e e e e e e e — o m = */
void setName (const char* str);
uint8 t getName (char* name, uintl6 t bufsize);
bool setTxPower (int8 t power);
int8 t  getTxPower (void);
bool setApperance (uintl6 t appear);
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uintl6e t getApperance (void);

void autoConnLed (bool enabled);
void setConnLedInterval (uint32 t ms);
/* __________________________________________________________________ */
/* GAP, Connections and Bonding
K o o e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e m e m e mmm e m e m— e ————— - */
bool connected (void);
bool disconnect (void);
bool setConnInterval (uintl6 t min, uintl6 t max);
bool setConnIntervalMS (uintl6 t min ms, uintl6 t max ms);
uintl6 t connHandle (void);
bool connPaired (void);
uintle t connInterval (void);
bool requestPairing (void);
void clearBonds (void);

ble gap addr t getPeerAddr (void);

uint8 t getPeerAddr (uint8 t addr[6]);
void printInfo(void);
/* __________________________________________________________________ */
/* Callbacks
K o o e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e m mmmmmmmm e ———— - - */

void setConnectCallback ( BLEGap::connect callback t fp);
void setDisconnectCallback( BLEGap::disconnect callback t fp);

/ | 2

These functions are generally available via 'Bluefruit.*'. For example, to check the connection status in your sketch you
could run "if (Bluefruit.connected()) { ... } .

Examples

For examples of how to work with the parent Bluefruit class, see the Examples section later in this guide. It's better to
examine this class in the context of a real world use case.

You can also browse the latest example code online via Github:

Browse the latest example code on Github

https://adafru.it/vaK
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BLEGap

This page is a work in progress as the APl is changing as we migrate to S132v5 and add better Central mode

support.

This GAP API for Bluefruit is accessible via Bluefruit.Gap.*** and has the following public functions:

typedef void (*connect callback t ) (uintlé t conn_handle);
typedef void (*disconnect callback t ) (uintl6_t conn_handle, uint8 t reason);

uint8 t getAddr (uint8 t mac[6]);

bool setAddr (uint8 t mac[6], uint8 t type);

bool connected (uintl6 t conn_handle);

uint8 t getRole (uintl6 t conn_handle);

uint8 t getPeerAddr (uintl6 t conn handle, uint8 t addr[6]);

ble gap addr t getPeerAddr (uintl6 t conn handle);

uintl6 t getPeerName (uintl6 t conn_handle, char* buf, uintl6 t bufsize);
uintl6 t getMTU (uintl6 t conn_handle);

uintl6 t getMaxMtuByConnCfg (uint8 t conn cfg);

uintl6 t getMaxMtu (uint8 t conn_handle);
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BLEAdvertising

The Bluefruit nRF52 Feather codebase is in an early BETA stage and is undergoing active development

based on customer feedback and testing. As such, the class documentation here is incomplete, and you
should consult the Github repo for the latest code and API developments:

'Advertising' is what makes your Bluetooth Low Energy devices visible to other devices in listening range. The radio
sends out specially formatter advertising packets that contain information like the device name, whether you can
connect to the device (or if it only advertises), etc.

You can also include custom data in the advertising packet, which is essential how beacons work.

The BLEAdvertisingData and BLEAdvertising classes exposes a number of helper functions to make it easier to create
well-formatted advertising packets, as well as to use the Scan Response option, which is an optional secondary
advertising packet that can be requested by a Central device. (This gives you another 27 bytes of advertising data, but
isn't sent out automatically like the main advertising packet.).

This two advertising packets are accessible via the parent AdafruitBluefruit class, calling 'Bluefruit.Advertising.” ' and
' Bluefruit.ScanResponse.* ' from your user sketches.

For examples of using these helper classes, see any of the examples later on in this guide, since all devices will
advertise as part of the startup process.

API

The BLEAdvertisingData class has the following public API:
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YA Adv Data ------------- */

bool addData(uint8 t type, const void* data, uint8 t len);
bool addFlags(uint8 t flags);

bool addTxPower(void);

bool addName(void);

bool addAppearance(uintl6 t appearance);

bool addManufacturerData(const void* data, uint8 t count);

fHmmeme e UUID -------mmmm-- */

bool addUuid (BLEUuid bleuuid);

bool addUuid (BLEUuid bleuuidl, BLEUuid bleuuid2);

bool addUuid(BLEUuid bleuuidl, BLEUuid bleuuid2, BLEUuid bleuuid3);

bool addUuid(BLEUuid bleuuidl, BLEUuid bleuuid2, BLEUuid bleuuid3, BLEUuid bleuuid4);

—_~ o~~~

bool addUuid(BLEUuid bleuuid[], uint8 t count);

A Service ------------- */

bool addService(BLEService& service);

bool addService(BLEService& servicel, BLEService& service2);

bool addService(BLEService& servicel, BLEService& service2, BLEService& service3);

bool addService(BLEService& servicel, BLEService& service2, BLEService& service3, BLEService& serviced);

[ Client Service ------------- */
bool addService(BLEClientService& service);

// Functions to work with the raw advertising packet
uint8 t count(void);
uint8 t* getData(void);

bool setData(const uint8 t* data, uint8 t count);

void clearData(void);

bool setData(Advertisable& adv able) { return adv able.setAdv(*this); }

« | ]

In addition to API from BLEAdvertisingData, The BLEAdvertising class also has functions that dictate the behavior of
advertising such as slow/fast timeout, adv intervals, and callbacks etc...

© Adafruit Industries https://learn.adafruit.com/bluefruit-nrf52-feather-learning-guide Page 89 of 158



typedef void (*stop callback t) (void);
typedef void (*slow callback t) (void);

void setType(uint8 t adv type);
void setFastTimeout(uintl6 t sec);

void setSlowCallback(slow callback t fp);
void setStopCallback(stop callback t fp);

void setInterval (uintl6 t fast, uintl6_t slow);
void setIntervalMS(uintl6 t fast, uintl6 t slow);

uintle t getInterval(void);

bool setBeacon(BLEBeacon& beacon);
bool setBeacon(EddyStoneUrl& eddy url);

bool isRunning(void);

void restartOnDisconnect(bool enable);
bool start(uintl6 t timeout = 0);
bool stop (void);

Related Information

® Generic Access Profile: This page contains the official list of assigned numbers for the 'Data’ type field. Data is
inserted into the advertising packet by supplying a valid 'data’ type, optionally followed by a properly formatted
payload corresponding to the selected value.

Example

For practical example code, see the Examples section later on in this guide. The snippet below is provided for
illustration purposes, but advertising should be examined in the context of a real use case since it varies from one
setup to the next!
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void setup(void)

{
// Other startup code
/] ...

// Set up Advertising
setupAdv();

// Start Advertising
Bluefruit.Advertising.

void startAdv(void)

{
// Advertising packet
Bluefruit.Advertising.
Bluefruit.Advertising.

here

Packet

start();

addFlags (BLE GAP ADV FLAGS LE ONLY GENERAL DISC MODE);
addTxPower();

// Include bleuart 128-bit uuid

Bluefruit.Advertising.

addService(bleuart);

// Secondary Scan Response packet (optional)
// Since there is no room for 'Name' in Advertising packet
Bluefruit.ScanResponse.addName();

/* Start Advertising

* - Enable auto advertising if disconnected
- Interval: fast mode = 20 ms, slow mode = 152.5 ms

- Timeout for fast

mode is 30 seconds

For recommended advertising interval

*
*
* - Start(timeout) with timeout = 0 will advertise forever (until connected)
*
*
*

https://developer.apple.com/library/content/qa/gqal931/ index.html

*/
Bluefruit.Advertising.
Bluefruit.Advertising.
Bluefruit.Advertising.
Bluefruit.Advertising.

© Adafruit Industries

restartOnDisconnect(true);

setInterval(32, 244); // in unit of 0.625 ms
setFastTimeout(30); // number of seconds in fast mode
start(0); // 0 = Don't stop advertising after n seconds
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BLEScanner

The Bluefruit nRF52 Feather codebase is in an early BETA stage and is undergoing active development
based on customer feedback and testing. As such, the class documentation here is incomplete, and you
should consult the Github repo for the latest code and API developments:

This documentation is based on BSP 0.7.0 and higher. Please make sure you have an up to date version
before using the code below.

The BLEScanner class is used in Central Mode, and facilitates scanning for BLE peripherals in range and parsing the
advertising data that is being sent out by the peripherals.

The BLEScanner class is normally accessed via the Bluefruit class (instantiated at startup), as shown below:

/* Start Central Scanning
* - Enable auto scan if disconnected

* - Filter for devices with a min RSSI of -80 dBm

* - Interval = 100 ms, window = 50 ms

* - Use active scan (requests the optional scan response packet)

* - Start(0) = will scan forever since no timeout is given

*/

Bluefruit.Scanner.setRxCallback(scan_callback);
Bluefruit.Scanner.restartOnDisconnect(true);

Bluefruit.Scanner.filterRssi(-80); // Only invoke callback when RSSI >= -80 dBm
Bluefruit.Scanner.setInterval(160, 80); // in units of 0.625 ms
Bluefruit.Scanner.useActiveScan(true); // Request scan response data
Bluefruit.Scanner.start(0); // 0 = Don't stop scanning after n seconds

API

BLEScanner has the following public API:

© Adafruit Industries

https://learn.adafruit.com/bluefruit-nrf52-feather-learning-guide Page 92 of 158


https://goo.gl/LdEx62

typedef void (*rx callback t) (ble gap evt adv report t*);
typedef void (*stop callback t) (void);

BLEScanner(void);

ble gap scan params t* getParams(void);
bool isRunning(void);

void useActiveScan(bool enable);

void setInterval(uintl6 t interval, uintl6 t window);
void setIntervalMS(uintl6 t interval, uintl6 t window);
void restartOnDisconnect(bool enable);

void filterRssi(int8 t min_rssi);
void filterMSD(uintl6 t manuf id);

void filterUuid(BLEUuid ble uuid);

void filterUuid(BLEUuid ble uuidl, BLEUuid ble uuid2);

void filterUuid(BLEUuid ble uuidl, BLEUuid ble uuid2, BLEUuid ble uuid3);

void filterUuid(BLEUuid ble uuidl, BLEUuid ble uuid2, BLEUuid ble uuid3, BLEUuid ble uuid4);
void filterUuid(BLEUuid ble uuid[], uint8 t count);

void clearFilters(void);

bool start(uintl6 t timeout = 0);
bool stop(void);

F A Callbacks ------------- */
void setRxCallback(rx callback t fp);
void setStopCallback(stop callback t fp);

A Data Parser ------------- */
uint8 t parseReportByType(const uint8 t* scandata, uint8 t scanlen, uint8 t type, uint8 t* buf, uint8 t
uint8 t parseReportByType(const ble gap evt adv report t* report, uint8 t type, uint8 t* buf, uint8 t bu

bool checkReportForUuid(const ble gap evt adv report t* report, BLEUuid ble uuid);
bool checkReportForService(const ble gap evt adv report t* report, BLEClientService svc);
bool checkReportForService(const ble gap evt adv report t* report, BLEService svc);

1

setRxCallback(rx_callback_t fp)

Whenever a valid advertising packet is detected (based on any optional filters that are applied in the BLEScanner
class), a dedicated callback function (see rx_callback_t ) will be called.

The callback function has the following signature:

NOTE: ble_gap_evt_adv_report_t is part of the Nordic nRF52 SDK and is defined inble_gap.h.

void scan callback(ble gap evt adv report t* report)
{
/* Display the timestamp and device address */
if (report->scan_rsp)
{
/* This is a Scan Response packet */
Serial.printf("[SR%10d] Packet received from ", millis());
1
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Fl

else
{
/* This is a normal advertising packet */
Serial.printf("[ADV%9d] Packet received from ", millis());
}
Serial.printBuffer(report->peer addr.addr, 6, ':');
Serial.print("\n");

/* Raw buffer contents */

Serial.printf("%14s %d bytes\n", "PAYLOAD", report->dlen);

if (report->dlen)

{
Serial.printf("%15s", " ");
Serial.printBuffer(report->data, report->dlen, '-');
Serial.println();

}

/* RSSI value */
Serial.printf("%14s %d dBm\n", "RSSI", report->rssi);

/* Adv Type */
Serial.printf("%14s ", "ADV TYPE");
switch (report->type)
{
case BLE GAP _ADV TYPE ADV IND:
Serial.printf("Connectable undirected\n");
break;
case BLE GAP_ADV TYPE ADV DIRECT IND:
Serial.printf("Connectable directed\n");
break;
case BLE GAP _ADV TYPE ADV SCAN IND:
Serial.printf("Scannable undirected\n");
break;
case BLE GAP_ADV TYPE ADV_NONCONN IND:
Serial.printf("Non-connectable undirected\n");
break;

/* Check for BLE UART UUID */
if ( Bluefruit.Scanner.checkReportForUuid(report, BLEUART UUID SERVICE) )

{
Serial.printf("%14s %s\n", "BLE UART", "UUID Found!");

}

/* Check for DIS UUID */
if ( Bluefruit.Scanner.checkReportForUuid(report, UUID16 SVC DEVICE INFORMATION) )
{
Serial.printf("%1l4s %s\n", "DIS", "UUID Found!");
}

Serial.println();

void useActiveScan(bool enable);

Enabling 'Active Scan' by setting the enable parameter to 1 will cause the device to request the optional Scan
Response advertising packet, which is a second 31 byte advertising packet that can be used to transmit additional
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information.

By default active scanning is disabled, so no Scan Response packets will be received by BLEScanner unless this
function is called and set to 1 before calling Bluefruit.Scanner.start(0) .

void filterRssi(int8_t min_rssi);

void filterMSD(uint16_t manuf_id);

void filterUuid(BLEUuid ble_uuid);

void filterUuid(BLEUuid ble_uuid1, BLEUuid ble_uuid?2);

void filterUuid(BLEUuid ble_uuid1, BLEUuid ble_uuid2, BLEUuid ble_uuid3);

void filterUuid(BLEUuid ble_uuid1, BLEUuid ble_uuid2, BLEUuid ble_uuid3, BLEUuid
ble_uuid4);

void filterUuid(BLEUuid ble_uuid[], uint8_t count);

Filters can be applied to BLEScanner to narrow down the data sent to the callback handler, and make processing
advertising packets easier for you.

As of BSP 0.7.0 the following three filters are present:

e filterRssi(int8_t min_rssi) : Filters advertising results to devices with at least the specified RSSI value, which allows
you to ignore devices that are too far away or whose signal is too weak. The higher the number, the strong the
signal so -90 is a very weak signal, and -60 is a much stronger one.

e filterUuid(BLEUuid ble_uuid) : Filters advertising results to devices that advertise themselves as having the
specified service UUID. If multiple UUIDs are entered, they will be filtered with boolean OR logic, meaning any
single UUID present will be considered a match.

e void filterMSD(uint16_t manuf_id) : Fitlers advertising results to devices that contain a Manufacturer Specific Data
data type, and who use the specifed Bluetooth Customer ID ( manuf_id) . This can be useful to filter iBeacon
versus Eddystone devices, for example, which both used the MSD field, or to look for custom MSD data
matching your own CID.

When multiple UUIDs are added via one of the filterUuid(...) functions, they UUIDs will be filtered using

boolean 'OR' logic, meaning that the callback will fire when ANY of the specified UUIDs are detected in the
advertising packet.

void clearFilters(void);

This function clears and filter values set using the functions above.

bool start(uint16_t timeout = 0);
bool stop(void);

The .start and .stop functions can be used to start and stop scanning, and should be called after all of the main
parameters (timing, filters, etc.) have been set.

The .start function has a single parameter called timeout, which sets the number of seconds to scan for advertising
packets. Setting this to '0' (the default value) will cause the device to scan forever.

Make sure you set any filters of BLEScanner parameters before calling .start!
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void restartOnDisconnect(bool enable);

Setting this function to "' will cause the scanning process to start again as soon as you disconnect from a peripheral
device. The default behaviour is to automatically restart scanning on disconnect.

Examples

For an example that uses almost all of the BLEScanner and advertising APl in Central mode, see
central_scan_advanced.ino in the Central examples folder.

central_scan_advanced.ino on Github

https://adafru.it/y5a

This example is only available in BSP 0.7.0 and higher!
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BLEService

The Bluefruit nRF52 Feather codebase is in an early BETA stage and is undergoing active development

based on customer feedback and testing. As such, the class documentation here is incomplete, and you
should consult the Github repo for the latest code and API developments:

This base class is used when defining custom BLE Gatt Services, such as the various service helper classes that make
up the Adafruit Bluefruit nRF52 API described here.

Unless you are implementing a custom GATT service and characteristic, you normally won't use this base class

directly, and would instantiate and call a higher level helper service or characteristic included in the Bluefruit nRF52
API.

Basic Usage
There are normally only two operation required to use the BLEService class:

You need to declare and instantiate the class with an appropriate 16-bit or 128-bit UUID in the constructor:

BLEService myService = BLEService(0x1234);

You then need to call the .begin() method on the instance before adding any BLECharacteristics to it (via the
BLECharacteristic's respective .begin() function call):

myService.begin();

Order of Operations (Important!)

One very important thing to take into consideration when working with BLEService and BLECharacteristic, is that any
BLECharacteristic will automatically be added to the last BLEService that had it's ".begin()’ function called. As such, you
must call yourService.begin() before adding any characteristics!

See the example at the bottom of this page for a concrete example of how this works in practice.

API

BLEService has the following overall class structure:

This documentation may be slightly out of date as bugs are fixed, and the API develops. You should always

consult the Github repo for the definitive latest code release and class definitions!
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BLEUuid uuid;

static BLEService* lastService;
BLEService(void);
BLEService(uintl6 t uuidl6);

BLEService(uint8 t const wuid128[]);

void setUuid(uintl6 t uuidl6);
void setUuid(uint8 t const wuuid128[]);

virtual err t begin(void);

Example

The following example declares a HRM (Heart Rate Monitor) service, and assigns some characteristics to it:

Note that this example code is incomplete. For the full example open the 'custom_hrm' example that is part

of the nRF52 BSP! The code below is for illustration purposes only.

/* HRM Service Definitions
* Heart Rate Monitor Service: 0x180D
* Heart Rate Measurement Char: Ox2A37
* Body Sensor Location Char: Ox2A38
*/
BLEService hrms
BLECharacteristic hrmc
BLECharacteristic bslc

BLEService(UUID16_SVC HEART_RATE);
BLECharacteristic(UUID16_CHR HEART_RATE_MEASUREMENT) ;
BLECharacteristic(UUID16_CHR BODY_ SENSOR_LOCATION);

void setupHRM(void)

{
// Configure the Heart Rate Monitor service
// See: https://www.bluetooth.com/specifications/gatt/viewer?attributeXmlFile=org.bluetooth.service.hec
// Supported Characteristics:

// Name UuID Requirement Properties
AR LT

// Heart Rate Measurement 0x2A37 Mandatory Notify

// Body Sensor Location 0x2A38 Optional Read

// Heart Rate Control Point 0x2A39 Conditional Write <-- Not used here

hrms.begin();

// Note: You must call .begin() on the BLEService before calling .begin() on
// any characteristic(s) within that service definition.. Calling .begin() on
// a BLECharacteristic will cause it to be added to the last BLEService that
// was 'begin() 'ed!

// Configure the Heart Rate Measurement characteristic
// See: https://www.bluetooth.com/specifications/gatt/viewer?attributeXmlFile=org.bluetooth.characteris
// Permission = Notify

// Min Len =1

// Max Len =8

// BO = UINT8 - Flag (MANDATORY)

// b5:7 = Reserved

// b4 = RR-Internal (0 = Not present, 1 = Present)

// b3 Energy expended status (0 = Not present, 1 = Present)
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// Dl:Z = 5ensor contacCt Sstatus (u+l = NOT supportea, £ = >Supportea but contact notT aetectea, 3 =

// b0O = Value format (0@ = UINT8, 1 = UINT16)

// Bl = UINT8 - 8-bit heart rate measurement value in BPM
// B2:3 = UINT16 - 16-bit heart rate measurement value in BPM
// B4:5 = UINT16 - Energy expended in joules

// B6:7 = UINT16 - RR Internal (1/1024 second resolution)

hrmc.setProperties (CHR _PROPS NOTIFY);

hrmc.setPermission (SECMODE OPEN, SECMODE NO ACCESS);

hrmc.setFixedLen(2);

hrmc.setCccdWriteCallback(ccecd_callback); // Optionally capture CCCD updates

hrmc.begin();

uint8 t hrmdata[2] = { 0b00000110, 0x40 }; // Set the characteristic to use 8-bit values, with the sen:
hrmc.notify(hrmdata, 2); // Use .notify instead of .write!

// Configure the Body Sensor Location characteristic
// See: https://www.bluetooth.com/specifications/gatt/viewer?attributeXmlFile=org.bluetooth.characteris
// Permission = Read

// Min Len =1

// Max Len =1

// BO = UINT8 - Body Sensor Location
// 0 = Other

// 1 = Chest

// 2 = Wrist

// 3 = Finger
// 4 = Hand

// 5 = Ear Lobe
// 6 = Foot

// 7:255 = Reserved

bslc.setProperties (CHR PROPS READ);
bslc.setPermission(SECMODE OPEN, SECMODE NO ACCESS);
bslc.setFixedLen(1);

bslc.begin();

bslc.write8(2); // Set the characteristic to 'Wrist' (2)
}
void cccd callback(BLECharacteristic& chr, uintl6 t cccd value)
{
// Display the raw request packet
Serial.print("CCCD Updated: ");
//Serial.printBuffer(request->data, request->len);
Serial.print(cccd value);
Serial.println("");
// Check the characteristic this CCCD update is associated with in case
// this handler is used for multiple CCCD records.
if (chr.uuid == hrmc.uuid) {
if (chr.notifyEnabled()) {
Serial.println("Heart Rate Measurement 'Notify' enabled");
} else {
Serial.println("Heart Rate Measurement 'Notify' disabled");
}
}
}
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BLECharacteristic

The Bluefruit nRF52 Feather codebase is in an early BETA stage and is undergoing active development

based on customer feedback and testing. As such, the class documentation here is incomplete, and you
should consult the Github repo for the latest code and API developments:

This base class is used when defining custom BLE GATT characteristics, and is used throughput the Adafruit Bluefruit
nRF52 APl and helper classes.

Unless you are implementing a custom GATT service and characteristic, you normally won't use this base class
directly, and would instantiate and call a higher level helper service or characteristic included in the Bluefruit nRF52
API.

Basic Usage

There are two main steps to using the BLECharacteristic class.

First, you need to declare and instantiate your BLECharacteristic class with a 16-bit or 128-bit UUID:

BLECharacteristic myChar = BLECharacteristic(OxABCD);

Then you need to set the relevant properties for the characteristic, with the following values at minimum:

myChar.setProperties (CHR PROPS READ);

myChar.setPermission (SECMODE OPEN, SECMODE NO ACCESS);
myChar.setFixedLen(1l); // Alternatively .setMaxLen(uintl6 t len)
myChar.begin();

e _setProperties can be set to one or more of the following macros, which correspond to a single bit in the eight bit
'properties' field for the characteristic definition:

CHR_PROPS_BROADCAST = bit(0),
CHR_PROPS_READ = bit(1),
CHR_PROPS_WRITE_WO_RESP = bit(2),
CHR_PROPS_WRITE = bit(3),
CHR_PROPS_NOTIFY = bit(4),
CHR_PROPS_INDICATE = bit(5)

O O O O O o

e _setPermission sets the security level for the characteristic, where the first value sets the read permissions, and
the second value sets the write permissions, where both fields can have one of the following values:

SECMODE_NO_ACCESS = 0x00,
SECMODE_OPEN = Ox1,
SECMODE_ENC_NO_MITM = 0x21,
SECMODE_ENC_WITH_MITM = 0x31,
SECMODE_SIGNED_NO_MITM = 0x12,
SECMODE_SIGNED_WITH_MITM = 0x22

O O O O O o

e _setFixedLen() indicates how many bytes this characteristic has. For characteristics that use 'notify' or 'indicate'
this value can be from 1..20, other characteristic types can be set from 1..512 and values >20 bytes will be sent
across multiple 20 byte packets. If the characteristic has a variable len, you set the .setMaxLen() value to the
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maximum value it will hold (up to 20 bytes).
e .begin() will cause this characteristic to be added to the last BLEService that had it's .begin() method called.

Order of Operations (Important!)

One very important thing to take into consideration when working with BLEService and BLECharacteristic, is that any
BLECharacteristic will automatically be added to the last BLEService that had it's ".begin() function called. As such, you
must call yourService.begin() before adding any characteristics!

See the example at the bottom of this page for a concrete example of how this works in practice.

API

BLECharacteristic has the following overall class structure:

This documentation may be slightly out of date as bugs are fixed, and the API develops. You should always

consult the Github repo for the definitive latest code release and class definitions!

VAR R R R Callback Signatures ---------- */

typedef void (*read authorize cb t) BLECharacteristic& chr, ble gatts evt read t * request);

typedef void (*write authorize cb t) (BLECharacteristic& chr, ble gatts evt write t* request);

typedef void (*write cb t) BLECharacteristic& chr, uint8 t* data, uintl6 t len, uintl6_t offs:
typedef void (*write cccd cb t) BLECharacteristic& chr, uintl6 t value);

BLEUuid uuid;

// Constructors
BLECharacteristic(void);
BLECharacteristic(BLEUuid bleuuid);

// Destructor
virtual ~BLECharacteristic();

BLEService& parentService(void);
void setTempMemory(void);

YA Configure ------------- */

void setUuid(BLEUuid bleuuid);

void setProperties(uint8 t prop);

void setPermission(BleSecurityMode read perm, BleSecurityMode write perm);
void setMaxLen(uintl6 t max len);

void setFixedLen(uintl6 t fixed len);

A Descriptors ------------- */

void setUserDescriptor(const char* descriptor); // aka user descriptor

void setReportRefDescriptor(uint8 t id, uint8 t type); // TODO refactor to use addDescriptor()

void setPresentationFormatDescriptor(uint8 t type, int8 t exponent, uintl6 t unit, uint8 t name_space = !

Y Callbacks ------------- */

void setWriteCallback write cb t fp);

void setCccdWriteCallback write cccd cb t fp);
void setReadAuthorizeCallback(read authorize cb t fp);
void setWriteAuthorizeCallbak(write authorize cb t fp);

—_— o~~~

© Adafruit Industries https://learn.adafruit.com/bluefruit-nrf52-feather-learning-guide Page 101 of 158



Virtual err_tT pegin(volia);

// Add Descriptor function must be called right after begin()
err t addDescriptor(BLEUuid bleuuid, void const * content, uintl6 t len, BleSecurityMode read perm = SECI

ble gatts char handles t handles(void);

A Write ------------- */

uintl6e t write(const void* data, uintl6 t len);
uintlée t write(const char* str);

uintle t write8 (uint8 t num);

uintle t writel6 (uintl6 t num);

uintle t write32 (uint32 t num);

uintle t write32 (int num) ;
A Read ------------- */

uintlée t read(void* buffer, uintl6 t bufsize);
uint8 t read8 (void);

uintle t readl6(void);

uint32 t read32(void);

[ Notify ------------- */

bool notifyEnabled(void);

bool notify(const void* data, uintl6 t len);
bool notify(const char* str);

bool notify8 (uint8 t num);

bool notifyl6 (uintl6 t num);
bool notify32 (uint32 t num)
bool notify32 (int num) ;

’

Example

The following example configures an instance of the Heart Rate Monitor (HRM) Service and it's related characteristics:

Note that this example code is incomplete. For the full example open the 'custom_hrm' example that is part

of the nRF52 BSP! The code below is for illustration purposes only.

/* HRM Service Definitions

* Heart Rate Monitor Service: 0x180D
* Heart Rate Measurement Char: Ox2A37
* Body Sensor Location Char: 0x2A38

*/
BLEService hrms
BLECharacteristic hrmc
BLECharacteristic bslc

void setupHRM(void)
{

// Configure the Heart Rate Monitor service

BLEService(UUID16_SVC HEART_RATE);
BLECharacteristic(UUID16_CHR HEART_RATE_MEASUREMENT) ;
BLECharacteristic(UUID16_CHR BODY_ SENSOR_LOCATION);

// See: https://www.bluetooth.com/specifications/gatt/viewer?attributeXmlFile=org.bluetooth.service.hec

1/ Ciimimnn +nd Clhmmmdtnvdcdd ~m
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//
//
//
//
//
hr

//
//
//
//

//
//
//
//
//
//
//
//
//
//
//
//
//
//
//
hr
hr
hr
hr
hr

DUMPUI LEU LlldidlLel 1L5LLL>.,

Name UUID Requirement Properties

Heart Rate Measurement 0x2A37 Mandatory Notify

Body Sensor Location 0x2A38 Optional Read

Heart Rate Control Point 0x2A39 Conditional Write <-- Not used here
ms.begin();

Note: You must call .begin() on the BLEService before calling .begin() on

any characteristic(s) within that service definition.. Calling .begin() on
a BLECharacteristic will cause it to be added to the last BLEService that
was ‘'begin()'ed!

Configure the Heart Rate Measurement characteristic
See: https://www.bluetooth.com/specifications/gatt/viewer?attributeXmlFile=org.bluetooth.characteris

Permission
Min Len
Max Len
BO
b5:7
b4
b3
bl:2
b0
B1
B2:3
B4:5
B6:7

Notify

1

8

UINT8 - Flag (MANDATORY)

Reserved

RR-Internal (0 = Not present, 1 = Present)

Energy expended status (0 = Not present, 1 = Present)
Sensor contact status (0+1 = Not supported, 2 = Supported but contact not detected, 3 =
Value format (0 = UINT8, 1 = UINT16)

UINT8 - 8-bit heart rate measurement value in BPM
UINT16 - 16-bit heart rate measurement value in BPM
UINT16 - Energy expended in joules

UINT16 - RR Internal (1/1024 second resolution)

mc.setProperties (CHR PROPS NOTIFY);

mc.setPermission (SECMODE OPEN, SECMODE NO ACCESS);

mc.setFixedLen(2);

mc.setCccdWriteCallback(cccd callback); // Optionally capture CCCD updates

mc.begin();

uint8 t hrmdata[2] = { 0b0000O110, 0x40 }; // Set the characteristic to use 8-bit values, with the sen:
hrmc.notify(hrmdata, 2); // Use .notify instead of .write!

// Configure the Body Sensor Location characteristic
// See: https://www.bluetooth.com/specifications/gatt/viewer?attributeXmlFile=org.bluetooth.characteris

//
//
//
//
//
//
//
//
//
//
//
//
bs
bs
bs
bs
bs

Permission
Min Len
Max Len

BO

U s WN R~ O

6
7:255

Read

1

1

UINT8 - Body Sensor Location
Other
Chest
Wrist
Finger
Hand

Ear Lobe
Foot
Reserved

lc.setProperties (CHR PROPS READ);
lc.setPermission (SECMODE OPEN, SECMODE NO ACCESS);
lc.setFixedLen(1);

lc.begin();

lc.write8(2);

// Set the characteristic to 'Wrist' (2)

void cccd callback(BLECharacteristic& chr, uintl6 t cccd value)

{
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Serial.print("CCCD Updated: ");
//Serial.printBuffer(request->data, request->len);
Serial.print(cccd value);

Serial.println("");

// Check the characteristic this CCCD update is associated with in case
// this handler is used for multiple CCCD records.
if (chr.uuid == hrmc.uuid) {
if (chr.notifyEnabled()) {
Serial.println("Heart Rate Measurement 'Notify' enabled");
} else {
Serial.println("Heart Rate Measurement 'Notify' disabled");
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BLEDiscovery

This page is a work in progress as the APl is changing as we migrate to S132v5 and add better Central mode

support.

BLEDiscovery is a helper class to make finding characteristics on a Gatt server (hosted on a BLE peripheral) easier. For
service discovery, the BLEClientService's discover() APl must be used, as shown below:

API

BLEDiscovery(void); // Constructor

void begin(void);
bool begun(void);
void setHandleRange(ble gattc handle range t handle range);

ble gattc handle range t getHandleRange(void);

uint8 t discoverCharacteristic(uintl6 t conn _handle, BLEClientCharacteristic* chr[], uint8 t count);
uint8 t discoverCharacteristic(uint1l6 t conn handle, BLEClientCharacteristic& chrl);

uint8 t discoverCharacteristic(uint1l6 t conn handle, BLEClientCharacteristic& chrl, BLEClientCharacteri
uint8 t discoverCharacteristic(uint16 t conn handle, BLEClientCharacteristic& chrl, BLEClientCharacteri
uint8 t discoverCharacteristic(uintl6 t conn _handle, BLEClientCharacteristic& chrl, BLEClientCharacteri
uint8 t discoverCharacteristic(uint1l6 t conn handle, BLEClientCharacteristic& chrl, BLEClientCharacteri

1 SO

For concrete examples of how to use this API see the 'Central' folder in the examples that are part of the

BSP.
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BLEDis

The Bluefruit nRF52 Feather codebase is in an early BETA stage and is undergoing active development

based on customer feedback and testing. As such, the class documentation here is incomplete, and you
should consult the Github repo for the latest code and API developments:

This helper class acts as a wrapper for the Bluetooth Device Information Service (Ox180A). This official GATT service
allows you to publish basic information about your device in a generic manner.

The Bluefruit BLEDis helper class exposes the following characteristics:

Model Number String (0x2A24), exposed via .setModel(const char*)

Serial Number String (Ox2A25), private

Firmware Revision String (Ox2A26), private

Hardware Revision String (Ox2A27), exposed via .setHardwareRev(const char*)
Software Revision String (Ox2A28), exposed via .setSoftwareRev(const char*)
Manufacturer Name String (Ox2A29), exposed via .setManufacturer(const char*)

The Serial Number String is private and is populated with a unique device ID that nRF52832 SoCs are programmed
with during manufacturing.

The Firmware Revision String is also private and is populated with the following fields (to help us track issues and offer
better feedback in the support forums):

o Softdevice Name (Sxxx)

o Softdevice Version (x.x.x)
o Bootloader Version (x.x.x)

Note: The Softdevice and Bootloader fields are separated by a single comma, meaning the final output will

resemble the following string: 'S132 2.0.1, 0.5.0'

The remaining characteristics are all public and can be set to an value (up to 20 chars in length) using the appropriate
helper function, but they have the following default values:

Model Number String: Bluefruit Feather 52

Hardware Revision String: NULL

Software Revision String: The nRF52 BSP version number
Manufacturer Name String: Adafruit Industries

Setting a public value to NULL will prevent the characteristic from being present in the DIS service.

API

The following functions and constructors are defined in the BLEDis class:
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BLEDis(void);

void setModel(const char* model);

void setHardwareRev(const char* hw rev);

void setSoftwareRev(const char* sw rev);

void setManufacturer(const char* manufacturer);

err t begin(void);

The individual characteristic values are set via the .set*() functions above, and when all values have been set you call
the .begin() function to add the service to the device's internal GATT registry.

Example

The following bare bones examples show how to setup the device information service with user-configurable strings
for values:

#include <bluefruit.h>

BLEDis bledis;

void setup()

{

Serial.begin(115200);
Serial.println("Bluefruit52 DIS Example");

Bluefruit.begin();
Bluefruit.setName("Bluefruit52");

// Configure and Start Device Information Service
bledis.setManufacturer("Adafruit Industries");
bledis.setModel ("Bluefruit Feather52");
bledis.begin();

// Set up Advertising Packet
setupAdv();

// Start Advertising
Bluefruit.Advertising.start();

void setupAdv(void)

{

Bluefruit.Advertising.addFlags (BLE GAP ADV FLAGS LE ONLY GENERAL DISC MODE);
Bluefruit.Advertising.addTxPower();

// There isn't enough room in the advertising packet for the
// name so we'll place it on the secondary Scan Response packet
Bluefruit.ScanResponse.addName();

void loop()

{
}
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Output

If you examine the device using the Bluefruit LE Connect app on iOS, Android or OS X you should see something
resembling the following output:

uuID Value

¥ Device Information
Model Number Bluefruit Feather52
Serial Mumber 8BOCES1BB50F75A7
Firmware Revision 0.5.0,5132,2.0.1
Software Revision 0.4.5
Manufacturer Name Adafruit Industries
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BLEUart

The Bluefruit nRF52 Feather codebase is in an early BETA stage and is undergoing active development

based on customer feedback and testing. As such, the class documentation here is incomplete, and you
should consult the Github repo for the latest code and API developments:

BLEUart is a wrapper class for NUS (Nordic UART Service), which is a proprietary service defined by Nordic
Semiconductors that we use as a baseline transport mechanism between Bluefruit modules and our mobile and
desktop Bluefruit LE Connect applications. You can use it to easily send ASCII or binary data in both directions,
between the peripheral and the central device.

API

BLEUart has the following public API:

// RX Callback signature (fires when data was written by the central)
typedef void (*rx callback t) (void);

// Constructor
BLEUart(uintle t fifo depth = BLE UART DEFAULT FIFO DEPTH);

virtual err t begin(void);
bool notifyEnabled(void);
void setRxCallback( rx callback t fp);

// Stream API

virtual int read ( void );

virtual int read ( uint8 t * buf, size t size );
virtual size t write (uint8 t b );

virtual size t write ( const uint8 t *content, size t len );
virtual int available ( void );

virtual int peek ( void );

virtual void flush ( void );

// Pull in write(str) and write(buf, size) from Print
using Print::write;

Example

The following example shows how to use the BLEUart helper class.

This example may be out of date, and you should always consult the latest example code in the nRF52 BSP!

#include <bluefruit.h>
BLEDis bledis;
BLEUart bleuart;
BLEBas blebas;

#define STATUS_LED (17)
#define BLINKY_ MS (2000)
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uint32_t blinkyms;

void setup()

{
Serial.begin(115200);

Serial.println("Bluefruit52 BLEUART Example");

// Setup LED pins and reset blinky counter
pinMode(STATUS LED, OUTPUT);
blinkyms = millis();

// Setup the BLE LED to be enabled on CONNECT

// Note: This is actually the default behaviour, but provided
// here in case you want to control this manually via PIN 19
Bluefruit.autoConnLed(true);

Bluefruit.begin();

Bluefruit.setName("Bluefruit52");
Bluefruit.setConnectCallback(connect callback);
Bluefruit.setDisconnectCallback(disconnect_ callback);

// Configure and Start Device Information Service
bledis.setManufacturer("Adafruit Industries");
bledis.setModel ("Bluefruit Feather52");
bledis.begin();

// Configure and Start BLE Uart Service
bleuart.begin();

// Start BLE Battery Service
blebas.begin();
blebas.update(100);

// Set up Advertising Packet
setupAdv();

// Start Advertising
Bluefruit.Advertising.start();

void setupAdv(void)

{
Bluefruit.Advertising.addFlags (BLE GAP_ADV FLAGS LE ONLY GENERAL DISC MODE);
Bluefruit.Advertising.addTxPower();

// Include bleuart 128-bit uuid
Bluefruit.Advertising.addService(bleuart);

// There is no room for Name in Advertising packet
// Use Scan response for Name
Bluefruit.ScanResponse.addName();

void loop()
{
// Blinky!
if (blinkyms+BLINKY MS < millis()) {
blinkyms = millis();

A Ll 1T S/ CTATIIC PR
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}

// Forward from Serial to BLEUART
if (Serial.available())

{
// Delay to get enough input data since we have a
// limited amount of space in the transmit buffer
delay(2);
uint8 t buf[64];
int count = Serial.readBytes(buf, sizeof(buf));
bleuart.write( buf, count );

}

// Forward from BLEUART to Serial

if ( bleuart.available() )

{
uint8 t ch;
ch = (uint8 t) bleuart.read();
Serial.write(ch);

}

}

void connect callback(void)

{

Serial.println("Connected");

}

void disconnect callback(uint8 t reason)

{

(void) reason;
Serial.println();

Serial.println("Disconnected");
Serial.println("Bluefruit will start advertising again");
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BLEClientUart

The Bluefruit nRF52 Feather codebase is in an early BETA stage and is undergoing active development

based on customer feedback and testing. As such, the class documentation here is incomplete, and you
should consult the Github repo for the latest code and API developments:

BLECIlientUart is a wrapper class for the client side of the NUS or 'Nordic UART Service' (aka 'BLE UART'). It is only
required when your Bluefruit nRF52 board is acting as Central communicating to other BLE peripherals that expose
the BLEUart service.

API

BLECIlientUart has the following public API:

// Callback Signatures
typedef void (*rx callback t) (BLEClientUart& svc);

BLEClientUart (uint16 t fifo depth = BLE UART DEFAULT FIFO DEPTH);

virtual bool begin(void);
virtual bool discover(uintl6 t conn _handle);

void setRxCallback( rx callback t fp);

bool enableTXD(void);
bool disableTXD(void);

// Stream API

virtual int read ( void );
virtual int read ( uint8 t * buf, size t size );
int read ( char * buf, size t size ) { return read( (uint8 t*) buf, size); }
virtual size t write (uint8 t b );
virtual size t write ( const uint8 t *content, size t len );
virtual int available ( void );
virtual int peek ( void );
virtual void flush ( void );
Examples

The following example shows how to use the BLEClientUart helper class.

#include <bluefruit.h>

BLEClientDis clientDis;
BLEClientUart clientUart;

void setup()
{
Serial.begin(115200);

Serial.println("Bluefruit52 Central BLEUART Example");
Serial.println("---------mmmmmmmmm e \n");

// Initialize Bluefruit with maximum connections as Peripheral = 0, Central =1
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// SRAM usage required by SoftDevice will increase dramatically with number of connections

Bluefruit.begin(0, 1);
Bluefruit.setName("Bluefruit52 Central");

// Configure DIS client
clientDis.begin();

// Init BLE Central Uart Serivce
clientUart.begin();
clientUart.setRxCallback(bleuart rx callback);

// Increase Blink rate to different from PrPh advertising mode
Bluefruit.setConnLedInterval(250);

// Callbacks for Central
Bluefruit.Central.setConnectCallback(connect callback);
Bluefruit.Central.setDisconnectCallback(disconnect callback);

/* Start Central Scanning

* - Enable auto scan if disconnected

* - Interval = 100 ms, window = 80 ms

* - Don't use active scan

* - Start(timeout) with timeout = 0 will scan forever (until connected)
*/

Bluefruit.Scanner.setRxCallback(scan callback);
Bluefruit.Scanner.restartOnDisconnect(true);
Bluefruit.Scanner.setInterval (160, 80); // in unit of 0.625 ms
Bluefruit.Scanner.useActiveScan(false);

Bluefruit.Scanner.start(0); // // 0 = Don't stop scanning after n seconds

/**
* Callback invoked when scanner pick up an advertising data
* @param report Structural advertising data
*/
void scan callback(ble gap evt adv report t* report)
{
// Check if advertising contain BleUart service
if ( Bluefruit.Scanner.checkReportForService(report, clientUart) )
{
Serial.print("BLE UART service detected. Connecting ... ");

// Connect to device with bleuart service in advertising
Bluefruit.Central.connect(report);

}

/**
* Callback invoked when an connection is established
* @param conn_handle

*/
void connect callback(uintl6 t conn_handle)
{
Serial.println("Connected");
Serial.print("Dicovering DIS ... ");
if ( clientDis.discover(conn handle) )
{

Serial.println("Found it"):
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char buffer[32+1];

// read and print out Manufacturer
memset(buffer, 0, sizeof(buffer));
if ( clientDis.getManufacturer(buffer, sizeof(buffer)) )
{
Serial.print("Manufacturer: ");
Serial.println(buffer);
b

// read and print out Model Number
memset(buffer, 0, sizeof(buffer));
if ( clientDis.getModel (buffer, sizeof(buffer)) )

{
Serial.print("Model: ");
Serial.println(buffer);

}

Serial.println();
}

Serial.print("Discovering BLE Uart Service ... ");

if ( clientUart.discover(conn handle) )

{
Serial.println("Found it");
Serial.println("Enable TXD's notify");
clientUart.enableTXD();
Serial.println("Ready to receive from peripheral");
}else
{
Serial.println("Found NONE");
// disconect since we couldn't find bleuart service
Bluefruit.Central.disconnect(conn handle);
}
}
Vo

* Callback invoked when a connection is dropped
* @param conn_handle
* @param reason
*/
void disconnect callback(uintl6 t conn handle, uint8 t reason)
{
(void) conn_handle;
(void) reason;

Serial.println("Disconnected");

}

/**

* Callback invoked when uart received data

* @param uart svc Reference object to the service where the data
* arrived. In this example it is clientUart

*/
void bleuart_rx_callback(BLEClientUart& uart_svc)
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Serial.print("[RX]: ");

while ( uart svc.available() )

{

Serial.print( (char) uart svc.read() );

}

Serial.println();

void loop()
{

if ( Bluefruit.Central.connected() )
{
// Not discovered yet
if ( clientUart.discovered() )
{
// Discovered means in working state
// Get Serial input and send to Peripheral
if ( Serial.available() )
{
delay(2); // delay a bit for all characters to arrive

char str[20+1] = { 0 };
Serial.readBytes(str, 20);

clientUart.print( str );
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BLEBeacon

The Bluefruit nRF52 Feather codebase is in an early BETA stage and is undergoing active development

based on customer feedback and testing. As such, the class documentation here is incomplete, and you
should consult the Github repo for the latest code and API developments:

The BLEBeacon helper class allows you to easily configure the nRF52 as a 'Beacon', which uses the advertising packet
to send out a specifically format chunk of data to any devices in listening range.

The following values must be set in order to generate a valid 'Beacon' packet:

Manufacturer ID: A 16-bit value (registered with the Bluetooth SIG!) that identifies the manufacturer.

Major: A 16-bit 'Major' number, used to differentiate beacon nodes.

Minor: A 16-bit 'Minor' number, used to differentiate beacon nodes.

RSSI @ 1M: A signed 8-bit value (int8_t) indicating the RSSI measurement at 1m distance from the node, used to
estimate distance to the beacon itself.

These values can either be set in the constructor, or via the individual functions exposed as part of this helper class.

API

BLEBeacon has the following public API:

// Constructors

BLEBeacon(void);

BLEBeacon(uint8 t const uuid128[16]);

BLEBeacon(uint8 t const uuid128[16], uintl6 t major, uintl6 t minor, int8 t rssi);

// Set the beacon payload values

void setManufacturer(uintl6é t manfacturer);

void setUuid(uint8 t const uuidl28[16]);

void setMajorMinor(uintl6 t major, uintl6 t minor);
void setRssiAtlm(int8 t rssi);

// Start advertising

bool start(void);
bool start(BLEAdvertising& adv);

In addition to these functions, the BLEAdvertising class (accessible via ‘Bluefruit.Advertising.*) exposes the following
function to assign Beacon payload to the advertising payload:

bool setBeacon(BLEBeacon& beacon);

See the example below for a concrete usage example.

Example

The following example will configure the nRF52 to advertise a 'Beacon' payload:
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#include <bluefruit.h>

// Beacon uses the Manufacturer Specific Data field in the advertising
// packet, which means you must provide a valid Manufacturer ID. Update
// the field below to an appropriate value. For a list of valid IDs see:

// https://www.bluetooth.com/specifications/assigned-numbers/company-identifiers

// 0x004C is Apple (for example)
#define MANUFACTURER ID  0x004C

// AirLocate UUID: E2C56DB5-DFFB-48D2-B060-DOF5A71096E0
uint8 t beaconUuid[16] =
{
OxE2, OxC5, Ox6D, 0xB5, OxDF, OxFB, 0x48, 0xD2,
0xB0O, 0x60, 0xDO, OxF5, OxA7, 0x10, 0x96, OxEO,
b

// A valid Beacon packet consists of the following information:
// UUID, Major, Minor, RSSI @ 1M
BLEBeacon beacon(beaconUuid, 0x0001, 0x0000, -54);

void setup()

{
Serial.begin(115200);

Serial.println("Bluefruit52 Beacon Example");

Bluefruit.begin();
Bluefruit.setName("Bluefruit52");

// Manufacturer ID is required for Manufacturer Specific Data
beacon.setManufacturer(MANUFACTURER ID);

// Setup the advertising packet
setupAdv();

// Start advertising
Bluefruit.Advertising.start();

void setupAdv(void)

{
// Set the beacon payload using the BLEBeacon class populated
// earlier in this example
Bluefruit.Advertising.setBeacon(beacon);

// char* adv = Bluefruit.Advertising.getData();

// There is no room left for 'Name' in the advertising packet
// Use the optinal secondary Scan Response packet for 'Name' instead
Bluefruit.ScanResponse.addName();

void loop()

{
// Toggle both LEDs every second
digitalToggle(LED BUILTIN);
delay(1000);

}
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Testing

If you test with the nRF Beacons application (iOS or Android) you can configure the app to look for the UUID,
Manufacturer ID, Major and Minor values you provided, and you should be able to see the beacon, as shown in the two
screenshots below:

Make sure that the UUID, Major and Minor values match or the application won't detect your beacon node!

£ Beacons Configuration Beacons

Apple Beacon Apple Beacon

IDENTITY ' Near

UUID Ezcsepes-DFFB-48D2-BO60-DOFSAT10

Major 1
Minor 0
Event At beacon
Action Show Mona Lisa

STATUS

m
=,
4i]
g
o

‘Wirelass by Nordic ‘Wirelass by Nordic

N M N M

Beacons Update Beacons Update
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BLEMidi

The Bluefruit nRF52 Feather codebase is in an early BETA stage and is undergoing active development

based on customer feedback and testing. As such, the class documentation here is incomplete, and you
should consult the Github repo for the latest code and API developments:

BLEMidi is a helper class that adds support for sending and receiving MIDI Messages using the MIDI over Bluetooth LE
specification. BLEMidi supports the full standard MIDI protocol (including SysEx messages), and it also can act as the
hardware interface for the Arduino MIDI Library.

API

BLEMidi has the following public API.

// Constructor
BLEMidi(uintl6 t fifo_depth = 128);

err_t begin (void);
bool notifyEnabled (void);

// Stream API for Arduino MIDI Library Interface

int read (void);

size t write (uint8 t b);

int available (void);

int peek (void);

void flush (void);

size t write (const char *str);

size t write (const uint8 t *buffer, size t size);

Installing the Arduino MIDI Library

BLEMidi is easiest to use when combined with the Arduino MIDI Library. You will need version 4.3.0 or higher installed
before continuing with the example code.

@ Arduino File Edit Tools Help -
Verify/Compile ®R
Upload £
blemidi § Upload Using Programmer {136

-------------------------- “  Export compiled Binary KES

Manage Libraries...

Show Sketch Folder HEK
Gl Include Library >
Add File...

et S ————

Next, select Communication from the topic dropdown, and enter MIDI Library into the search box. Click the Install
button to install version 4.3.0 or higher of the MIDI Library.
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Type Al % Topic Q!I & Filter your search.

Arduine Uno WiFi Dev Ed Library &, Arduine

This library allows users to use network features like rest and mgtt. Includes some tools for the ESPE2EE. Use this library only with
Arduing Uno WiFi Developer Edition.

HMare info

! ArduinoCloud by Arduing
Easly connact your Arduino/Genuino board to the Arduino Cloud Easly connect your Arduino/Genuing board to the Arduing Cloud
Hore infg

ArduinoHttpClient by Arduino Version 0.1.0 INSTALLED

[EXPERIMENTAL] Easlly interact with web servers from Arduino, using HTTP and WebSocket's. This library can be used for HTTP (GET,
POST, PUT, DELETE) requests to a web server. It also supports exchanging messages with WebSocket servers. Based on Adrian McEwen's |
HitpClient library.

Hare info |

ArduinoSound by Arduing |
_TEXPERTMENTALLA simnle wav ta nine and analvee asdio dats uging Arduine. Coooentlv only sinnoms SAMO21 boards and 125 aodin. ]

Close

Example

The blemidi example demonstrates how to use the BLEMidi helper class with the Arduino MIDI Library. The example
sends a looping arpeggio, and prints any incoming MIDI note on and note off messages to the Arduino Serial Monitor.

Central | 2
Hardware >
Peripheral

Adafruit BLE Libraries for Bluefruit52
Newtron Flash Filesystem

SPI

Wire

YvY VYol

blemidi
las iart

This example may be out of date, and you should always consult the latest example code in the Bluefruit52 example
folder!

/*********************************************************************

This is an example for our nRF52 based Bluefruit LE modules
Pick one up today in the adafruit shop!

Adafruit invests time and resources providing this open source code,
please support Adafruit and open-source hardware by purchasing
products from Adafruit!

MIT license, check LICENSE for more information

All text above, and the splash screen below must be included in

any redistribution
*********************************************************************/
#include <bluefruit.h>
#include <MIDI.h>

BLEDis bledis;
BLEMidi blemidi;

// Create a new instance of the Arduino MIDI Library,

// and attach BluefruitLE MIDI as the transport.
MIDI CREATE BLE INSTANCE(blemidi);
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// Variable that holds the current position in the sequence.
int position = 0;

// Store example melody as an array of note values

byte note sequence[] = {
74,78,81,86,90,93,98,102,57,61,66,69,73,78,81,85,88,92,97,100,97,92,88,85,81,78,
74,69,66,62,57,62,66,69,74,78,81,86,90,93,97,102,97,93,90,85,81,78,73,68,64,61,
56,61,64,68,74,78,81,86,90,93,98,102

+i

void setup()

{
Serial.begin(115200);
Serial.println("Adafruit Bluefruit52 MIDI over Bluetooth LE Example");

Bluefruit.begin();
Bluefruit.setName("Bluefruit52 MIDI");

// Setup the on board blue LED to be enabled on CONNECT
Bluefruit.autoConnLed(true);

// Configure and Start Device Information Service
bledis.setManufacturer("Adafruit Industries");
bledis.setModel("Bluefruit Feather52");
bledis.begin();

// Initialize MIDI, and listen to all MIDI channels
// This will also call blemidi service's begin()
MIDI.begin(MIDI CHANNEL OMNI);

// Attach the handleNoteOn function to the MIDI Library. It will
// be called whenever the Bluefruit receives MIDI Note On messages.
MIDI.setHandleNoteOn(handleNoteOn);

// Do the same for MIDI Note Off messages.
MIDI.setHandleNoteOff(handleNoteOff);

// Set General Discoverable Mode flag
Bluefruit.Advertising.addFlags (BLE GAP ADV FLAGS LE ONLY GENERAL DISC MODE);

// Advertise TX Power
Bluefruit.Advertising.addTxPower();

// Advertise BLE MIDI Service
Bluefruit.Advertising.addService(blemidi);

// Advertise device name in the Scan Response
Bluefruit.ScanResponse.addName();

// Start Advertising
Bluefruit.Advertising.start();

// Start MIDI read loop

Scheduler.startLoop(midiRead) ;

void handleNoteOn(byte channel, byte pitch, byte velocity)
{

// Loa when a note is pressed.
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Serial.printf("Note on: channel = %d, pitch = %d, velocity - %d", channel, pitch, velocity);
Serial.println();

}

void handleNoteOff(byte channel, byte pitch, byte velocity)

{
// Log when a note is released.
Serial.printf("Note off: channel = %d, pitch = %d, velocity - %d", channel, pitch, velocity);
Serial.println();

}

void loop()
{
// Don't continue if we aren't connected.
if (! Bluefruit.connected()) {
return;

// Don't continue if the connected device isn't ready to receive messages.
if (! blemidi.notifyEnabled()) {
return;

// Setup variables for the current and previous
// positions in the note sequence.

int current = position;

int previous = position - 1;

// If we currently are at position 0, set the
// previous position to the last note in the sequence.
if (previous < 0) {

previous = sizeof(note sequence) - 1;

}

// Send Note On for current position at full velocity (127) on channel 1.
MIDI.sendNoteOn(note sequence[current], 127, 1);

// Send Note Off for previous note.
MIDI.sendNoteOff(note sequence[previous], 0, 1);

// Increment position
position++;

// If we are at the end of the sequence, start over.
if (position >= sizeof(note sequence)) {
position = 0;

}

delay(286);

void midiRead()
{
// Don't continue if we aren't connected.
if (! Bluefruit.connected()) {
return;
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// bon't continue 1T the connected device 1sn't ready to recelve messages.
if (! blemidi.notifyEnabled()) {
return;

}

// read any new MIDI messages
MIDI.read();

Usage

You will need to do a small bit of setup on your selected platform to connect to the BLE MIDI enabled Bluefruit52.
Click on a platform below to view BLE MIDI setup instructions for your device:

macOS (OS X)
iO0S

Android
Windows

The arpeggio should automatically play once the Bluefruit52 is connected to your software synth. The video below
shows the Bluefruit52 connected to Moog's Animoog on iOS.

Note: The board used in the video was a pre-release prototype. The production boards are standard Adafruit

Black.
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BLEHidAdafruit

The Bluefruit nRF52 Feather codebase is in an early BETA stage and is undergoing active development

based on customer feedback and testing. As such, the class documentation here is incomplete, and you
should consult the Github repo for the latest code and API developments:

BLEHidAdafruit allows you to simulate a mouse or keyboard using the HID (Human Interface Device) profile that is part
of the Bluetooth Low Energy standard.

Most modern mobile devices with Bluetooth Low Energy support, and the latest operating systems generally support
Bluetooth Low Energy mice and keyboards out of the box, once you pair your Bluefruit nRF52 Feather and run an
appropriate sketch.

API

The BLEHidAdafruit helper class has the following public API:

// Constructor
BLEHidAdafruit(void);

// Call this once to start the HID service
virtual err t begin(void);

// Keyboard

err t keyboardReport(hid keyboard report t* report);

err t keyboardReport(uint8 t modifier, uint8 t keycode[6]);

err t keyboardReport(uint8 t modifier, uint8 t keycode®, uint8 t keycodel=0, uint8 t keycode2=0, uint8 t

err t keyPress(char ch);
err t keyRelease(void);
err t keySequence(const char* str, int interal=5);

// Consumer Media Keys

err t consumerReport(uintl6é t usage code);
err t consumerKeyPress(uintl6 t usage code);
err t consumerKeyRelease(void);

// Mouse
err t mouseReport(hid mouse report t* report);
err t mouseReport(uint8 t buttons, int8 t x, int8 t y, int8 t wheel=0, int8 t pan=0);

err t mouseButtonPress(uint8 t buttons);
err_t mouseButtonRelease(void);

err t mouseMove(int8 t x, int8 t y);
err t mouseScroll(int8 t scroll);
err t mousePan(int8 t pan);

1

Example Sketches

There are a variety of example sketches showing how to use the BLEHidAdafruit class. You can browse the latest
source code on Github with the following links:
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e hid_keyboard: This example will simulate an HID keyboard, waiting for data to arrive via the nRF52's serial port
(via USB serial), and send that data over the air to the bonded Central device.

® hid_mouse: This example will simulate an HID mouse. To use it run the sketch and open the Serial Monitor, then
enter the appropriate characters to move the mouse or trigger/release the mouse buttons.

Bonding HID Devices

In order to use your HID mouse or keyboard, you will first need to bond the two devices. The bonding process involves
the following steps:

® The two devices will connect to each other normally

® A set of security keys are exchanged between the two devices, and stores in non-volatile memory on each side.
This is to ensure that each side is reasonably confident it is talking to the device it thinks it is for future
connections, and to encrypt over the air communication between the devices (so that people can 'sniff' your
keyboard data, etc.).

e On the nRF52 side this key data will be stored in a section of flash memory reserved for this purpose using an
internal file system.

e The process of storing these security keys is referred to as bonding, and allows bonded devices to securely
communicate without user interaction in the future.

® To cancel the bonding agreement, you can simply delete the keys on the nRF52 via the clearbonds sketch, or
delete the bonding data on your mobile device of computer.

If you run into any bonding problems, try running the clearbonds sketch to remove and old bonding data from

local non-volatile memory!

Setting up your Bluefruit device for bonding

To bond an device, run an appropriate HID sketch on the nRF52 to emulate either an HID mouse or an HID keyboard.
In the event that you use the HID mouse example you may need to open the Serial Monitor to use it.

In this example we'll run the hid_keyboard example sketch, flashing it to the nRF52, which should give you the
following results:

© Adafruit Industries https://learn.adafruit.com/bluefruit-nrf52-feather-learning-guide Page 125 of 158


https://github.com/adafruit/Adafruit_nRF52_Arduino/blob/master/libraries/Bluefruit52Lib/examples/Peripheral/hid_keyboard/hid_keyboard.ino
https://github.com/adafruit/Adafruit_nRF52_Arduino/blob/master/libraries/Bluefruit52Lib/examples/Peripheral/hid_mouse/hid_mouse.ino
https://github.com/adafruit/Adafruit_nRF52_Arduino/blob/master/libraries/Bluefruit52Lib/examples/Peripheral/clearbonds/clearbonds.ino

L ] L ] hid_keryboarnd | Arduing 1.8.1

o0 BERn

fe <bluefruit.h-
bledis;
bleuart;
t blehid;

hasKeyPressed

tup()

(115208} ;

Bluefiruit
Bluefruit

Configure and
bledis

bledis
bledis

Adatruit Bluedruit Feather. Lewel 0 Release) on fdev/cuSLAE USBroUART

Opening the Serial Monitor will give you the following output (though it may differ depending on the debug level you
have selected):

o ® [devfcu.SLAB_USBtoUART
Send
Bluefruit52 HID Keyboard Example
Autoscroll No line ending &) 115200 baud &)

Bonding on iOS

To bond to an iOS device, make sure the sketch is running (as described above) and go into yourSettings app and
Select Bluetooth.

You should see a device at the bottom of this page called Bluefruit52 (this may vary depending on the version of the
sketch you are using!):
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eee00 Tuenti & 19:40 71790 M)

£ Settings Bluetooth

Bluetooth O

Now discoverable as “iPhone de Kevin”.

‘\\ ! 'I‘

OTHER DEVICES

Bluefruit52

Click the device, and you will get a pairing request like this:

Bluetooth Pairing Request

“Bluefruit52" would like to pair with
your iPhone.

Cancel

Click the Pair button, and the devices will be paired and bonded, and will automatically connect to each other in the
future.

If everything went will, you will see the device in your MY DEVICES list, as follows:

Bluefruit52 Connected @

Testing the HID Keyboard and Bonding
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To test the HID keyboard sketch and bonding process, open the Serial Monitor (or your favorite terminal emulator),
enter some text, and if you are using the Serial Monitor click the Send button. This will send some text over the air to
whatever textbox or text control has focus in your app.

| BON | fdevfcu.SLAB_USBtoUART
http:/ fwww.adafruit.com Send
Bluefruit5Z HID Keyboard Example

The text will then appear in your mobile app or bonded device.

If the characters don't match exactly what you send, be sure to check your keyboard language settings, since you may
be sending data to a device with a different keyboard setup!
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BLEANcs

The Bluefruit nRF52 Feather codebase is in an early BETA stage and is undergoing active development

based on customer feedback and testing. As such, the class documentation here is incomplete, and you
should consult the Github repo for the latest code and API developments:

BLEAnNCcs is a helper class that enables you to receive notifications from the Apple Notification Center Service from
devices such as an iPhone or iPad. It can be used to receive alerts such as incoming or missed calls, email messages,
or most alerts that appear on the mobile device's screen when locked.

API

Because the BLEANCs class is a work in progress, the latest public API for the BLEANncs helper class should be
viewed here.

ANCS OLED Example

The ancs_oled example uses the Adafruit FeatherWing OLED to display any incoming alerts.

Sketch Requirements

In order to use this example sketch the following libraries must be installed on your system:

e Adafruit_GFX (Github source)
e Adafruit_SSD1306 (Github source)
e Version 0.6.0 or higher of the Bluefruit nRF52 BSP

Loading the Sketch

The ancs_oled sketch can be loaded via the examples menu under Peripheral > ancs_oled:

Adafruit BLE Libraries for Bluefruit52 > Central >
Newtron Flash Filesystem > Hardware >

SPI > Peripheral > ancs
Wire [ 0 G LT H ancs_oled
E1al ™ p i A ?"N =

With the sketch loaded, you can build the firmware and then flash it to your device via the Upload button or menu
option:
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LN ] anca_oled | Arduine 1.8.1

e <Nire e

e cAdafruit_GFX. he

e cAdafruit 5501386, h-
e <bluefruit.h

BUTTORN_& i1
e BUTTON_B L
BUTTON_C 7

OLED_RESET 4
Adafruit 5501306 oled(OLED_RESET);

M COUNT 2
BUFSITE o4

Make sure that the Adafruit_SSD1306.h file has the 'SSD1306_128_32' macro enabled. Running the sketch
with 'SSD1306_128_64"' set will cause corrupted data to appear on the OLED display.

Once the sketch is running on the nRF52 Feather you can proceed with the one-time pairing process, described
below.

Pairing to your Mobile Device

Before you can start receiving notifications, you will need to 'pair' the nRF52 Feather and the mobile device.

The pairing process causes a set of keys to be exchanged and stored on the two devices so that each side knows it is
talking to the same device it originally bonded with, and preventing any devices in the middle from eavesdropping on
potentially sensitive data.

The one-time pairing process is described below, and assumes you are already running the ancs_oled sketch on your
NRF52 device.

1. In the Settings app go to Bluetooth:
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Bluetooth On

2. Scroll to the bottom of the list of "My Devices' and click on Bluefruit52 under Other Devices:

OTHER DEVICES -,

Bluefruitb2

3. When the pairing dialog box comes up, click the Pair button:

Bluetooth Pairing Request

“Bluefruit52" would like to pair with
your iPhone.

Cancel

4. Wait for the pairing process to complete, at which point Bluefruit52 should appear in the My Devices list with
the Connected status:
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Bluefruit52 Connected @

Once two devices have been paired, they will automatically reconnect to each other whenever they are in
range and have their Bluetooth radios enabled.

Wait for Alerts

At this point, any alerts that the mobile device generates will be displayed on the OLED display along with the
notification category and date:

Certain alerts (such as incoming calls) can also have actions associated with them, making use of the three buttons on
the left-hand side of the display to decide which action to take.

In the ancs_oled example, we have a special section of code for incoming calls where you can accept or decline a call
with an appropriate button press:
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// Check buttons
uint32 t presedButtons = readPressedButtons();

if ( myNotifs[activeIndex].ntf.categoryID == ANCS_CAT_INCOMING_CALL )
{
/* Incoming call event
* - Button A to accept call
* - Button C to decline call
*/
if ( presedButtons & bit(BUTTON A) )
{
bleancs.actPositive(myNotifs[activeIndex].ntf.uid);

}

if ( presedButtons & bit(BUTTON C) )
{

bleancs.actNegative (myNotifs[activeIndex].ntf.uid);
b
}
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BLECIlientCts

The Bluefruit nRF52 Feather codebase is in an early BETA stage and is undergoing active development

based on customer feedback and testing. As such, the class documentation here is incomplete, and you
should consult the Github repo for the latest code and API developments:

BLECIlientCts is a helper class that implements adopted Current Time Service , which enables you to receive time from
devices such as an iPhone or iPad.

API

// Callback Signatures
typedef void (*adjust callback t) (uint8 t reason);

BLEClientCts(void);

virtual bool begin(void);
virtual bool discover(uintl6 t conn _handle);

bool getCurrentTime(void);
bool getLocalTimeInfo(void);

bool enableAdjust(void);
void setAdjustCallback(adjust callback t fp);

// https://www.bluetooth.com/specifications/gatt/viewer?attributeXmlFile=org.bluetooth.characteristic.cur
struct ATTR_PACKED {
uintl6 t year;
uint8 t month;
uint8 t day;
uint8 t hour;
uint8 t minute;
uint8 t second;
uint8 t weekday;
uint8 t subsecond;
uint8 t adjust reason;
} Time;

// https://www.bluetooth.com/specifications/gatt/viewer?attributeXmlFile=org.bluetooth.characteristic.loc
struct ATTR PACKED {

int8 t timezone;

uint8 t dst offset;
}Locallnfo;

1

Client CTS OLED Example

The client_cts_oled example uses the Adafruit FeatherWing OLED to display received time.

Sketch Requirements

In order to use this example sketch the following libraries must be installed on your system:

e Adafruit_GFX (Github source)
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e Adafruit_SSD1306 (Github source)
Loading the Sketch
The client_cts_oled sketch can be loaded via the examples menu under Peripheral > client_cts_oled:

Firmata

jardFirmataBLE

throughpat

With the sketch loaded, you can build the firmware and then flash it to your device via the Upload button or menu
option. Once the sketch is running on the nRF52 Feather you can proceed with the one-time pairing process,
described below.

Make sure that the Adafruit_SSD1306.h file has the 'SSD1306_128_32' macro enabled. Running the sketch

with 'SSD1306_128_64' set will cause corrupted data to appear on the OLED display.

Pairing to your Mobile Device

Before you can start receiving notifications, you will need to 'pair' the nRF52 Feather and the mobile device.
The pairing process causes a set of keys to be exchanged and stored on the two devices so that each side knows it is
talking to the same device it originally bonded with, and preventing any devices in the middle from eavesdropping on

potentially sensitive data.

The one-time pairing process is described below, and assumes you are already running the ancs_oled sketch on your
nRF52 device.

1. In the Settings app go to Bluetooth:

Bluetooth On

2. Scroll to the bottom of the list of 'My Devices' and click on Bluefruit52 under Other Devices:
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OTHER DEVICES .,

Bluefruit52

3. When the pairing dialog box comes up, click the Pair button:

Bluetooth Pairing Request

“Bluefruit52” would like to pair with
your iPhone.

Cancel

4. Wait for the pairing process to complete, at which point Bluefruit52 should appear in the My Devices list with
the Connected status:

Bluefruit52 Connected @

Once two devices have been paired, they will automatically reconnect to each other whenever they are in
range and have their Bluetooth radios enabled.

Wait for Time Data

At this point, time data from the mobile device will be read and display on the the OLED. For demo purpose the sketch
will read time data from mobile once every second. However, in reality, nRF52 should have an internal timer that keep
track of second, and only read/sync with mobile after several hours or days, similar to how IP device got time from NTP
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BLECentral

This page is a work in progress as the APl is changing as we migrate to S132v5 and add better Central mode

support.

The Central mode APl is accessible via Bluefruit.Central.* and has the following public functions:

void begin(void);

) */
/* GAP
K o e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e m e e mmmmm e ———— - - */
bool setConnInterval(uintl6 t min, uintl6 t max);
bool setConnIntervalMS (uintl6 t min ms, uintl6 t max ms);
bool connect(const ble gap evt adv report t* adv report);
bool connect(const ble gap addr t *peer addr);
bool disconnect(uintl6 t conn_handle);
bool connected (uintl6 t conn handle); // If connected to a specific peripheral
bool connected (void); // If connected to any peripherals
YA Callbacks ------------- */

void setConnectCallback ( BLEGap::connect callback t fp);
void setDisconnectCallback( BLEGap::disconnect callback t fp);

For examples of how to use the Central mode API, see the Central examples folder.
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nRF52 ADC

The nRF52832 includes an adjustable 'successive-approximation ADC' which can be configured to convert data with
up to 14-bit resolution (0..16383), and the reference voltage can be adjusted up to 3.6V internally.

The default values for the ADC are 10-bit resolution (0..1023) with a 3.6V reference voltage, meaning every digit
returned from the ADC = 3600mV/1024 = 3.515625mV.

Analog Reference Voltage

The internal reference voltage is 0.6V with a variable gain setting, and can be adjust via theanalogReference(...)
function, providing one of the following values:

AR_INTERNAL (0.6V Ref * 6 = 0..3.6V) <-- DEFAULT
AR_INTERNAL_3_0 (0.6V Ref * 5 =0.3.0V)
AR_INTERNAL_2_4 (0.6V Ref * 4 =0..2.4V)
AR_INTERNAL_1_8 (0.6V Ref * 3 =0..1.8V)
AR_INTERNAL_1_2 (0.6V Ref * 2 =0..1.6V)
AR_VDD4 (VDD/4 REF * 4 = 0..VDD)

For example:

// Set the analog reference to 3.0V (default = 3.6V)
analogReference(AR INTERNAL 3 0);

Analog Resolution

The ADC resolution can be set to 8, 10, 12 or 14 bits using the analogReadResolution(...) function, with the default value
being 10-bit:

// Set the resolution to 12-bit (0..4095)
analogReadResolution(12); // Can be 8, 10, 12 or 14

Default ADC Example (10-bit, 3.6V Reference)

The original source for this code is included in the nRF52 BSP and can be viewed online here.
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int adcin = A5;
int adcvalue = 0;

float mv_per lsb = 3600.0F/1024.0F; // 10-bit ADC with 3.6V input range

void setup() {
Serial.begin(115200);
}

void loop() {
// Get a fresh ADC value
adcvalue = analogRead(adcin);

// Display the results
Serial.print(adcvalue);
Serial.print(" [");

Serial.print((float)adcvalue * mv_per lsb);

Serial.println(" mV]");

delay (100);

Advanced Example (12-bit,

3.0V Reference)

The original source for this code is included in the nRF52 BSP and can be viewed online here.

#define VBAT PIN (A7)

#define VBAT_MV_PER LSB  (0.73242188F) // 3.0V ADC range and 12-bit ADC resolution = 3000mV/4096
#define VBAT_DIVIDER (0.71275837F) // 2M + 0.806M voltage divider on VBAT = (2M / (0.806M + 2M))

#define VBAT_DIVIDER _COMP (1.403F)

int readVBAT(void) {
int raw;

// Compensation factor for the VBAT divider

// Set the analog reference to 3.0V (default = 3.6V)

analogReference (AR INTERNAL 3 0)

// Set the resolution to 12-bit

’

(0..4095)

analogReadResolution(12); // Can be 8, 10, 12 or 14

// Let the ADC settle
delay(1);

// Get the raw 12-bit, 0..3000mV ADC value

raw = analogRead (VBAT PIN);

// Set the ADC back to the default settings

analogReference (AR DEFAULT);
analogReadResolution(10);

return raw;

uint8 t mvToPercent(float mvolts) {

uint8 t battery level;

if (mvolts >= 3000)
{

[P S | 1nn.

© Adafruit Industries https://learn.adafruit.com/bluefruit-nrf52-feather-learning-guide Page 140 of 158


https://github.com/adafruit/Adafruit_nRF52_Arduino/blob/master/libraries/Bluefruit52Lib/examples/Hardware/adc_vbat/adc_vbat.ino

pdLLery LeveL = 1uu;

b
else if (mvolts > 2900)
{
battery level = 100 - ((3000 - mvolts) * 58) / 100;
}
else if (mvolts > 2740)
{
battery level = 42 - ((2900 - mvolts) * 24) / 160;
b
else if (mvolts > 2440)
{
battery level = 18 - ((2740 - mvolts) * 12) / 300;
b
else if (mvolts > 2100)
{
battery level = 6 - ((2440 - mvolts) * 6) / 340;
}
else
{
battery level = 0;
b

return battery level;

void setup() {
Serial.begin(115200);

// Get a single ADC sample and throw it away
readVBAT();

void loop() {
// Get a raw ADC reading
int vbat raw = readVBAT();

// Convert from raw mv to percentage (based on LIPO chemistry)
uint8 t vbat per = mvToPercent(vbat raw * VBAT MV_PER LSB);

// Convert the raw value to compensated mv, taking the resistor-

// divider into account (providing the actual LIPO voltage)

// ADC range is 0..3000mV and resolution is 12-bit (0..4095),

// VBAT voltage divider is 2M + 0.806M, which needs to be added back
float vbat mv = (float)vbat raw * VBAT MV_PER LSB * VBAT DIVIDER COMP;

// Display the results

Serial.print("ADC = ");
Serial.print(vbat_raw * VBAT_MV_PER LSB);
Serial.print(" mV (");
Serial.print(vbat raw);

Serial.print(") ");

Serial.print("LIPO = ");
Serial.print(vbat mv)
Serial.print(" mV (")
Serial.print(vbat per
Serial.println("%)");

’

)
delay(1000);
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Memory Map

This page applies to BSP 0.8.0 and higher, which introduced bootloader v5.1.0 and S132 v5.x.x. For earlier

releases (BSP release < 0.8.0) see bootloader v0.5.0 and S132 v2.x.x at the bottom of this page.

Flash Memory

The nRF52832 has 512KB flash memory. The flash layout varies depending on the version of the softdevice (S132v2 or
S132v5) and/or bootloader (single/dual bank) used as follows:

Bootloader v5.1.0 with $132 v5.x.x Dual and Single Bank

... 0x80000
Bootloader
48 KB
..0x74000
_ 28K8 | oxep000
Reserved
296 KB
148 KB
...0x23000 _..0x23000
140 KB 140 KB
OO . udoa0
Bluefruit nRF52 S132 v5.x.x Dual Bluefruit nRF52 $132 v5.x.x Single

Bootloader v0.5.0 with S132 v2.x.x Dual banks

Bootloader 0.5.0 with S132 v2.0.1is obsolete. 0.8.x is last release that will support it. Check the "Using the

Bootloader" page for instructions on how to upgrade the bootloader.
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... 0x80000

Bootloader

48 KB
0x74000

User Data
28KE | oxeD000

Reserved

Application
162 KB

0x1C000

SoftDevice
112 KB

Bluefruit nRF52 $132 v2.x.x Dual

e SoftDevice: This section of flash memory contains the Soft Device, which is Nordic's black box Bluetooth Low
Energy stack.

e Application: This section of flash memory stores the user sketches that you compile in the Arduino IDE.

® Reserved: This section of flash memory is kept empty to enable dual banks safe firmware updates. Whenever
you try to update the Application are, the new application data will first be written to the free memory section,
and the verified before it is swapped out with the current application code. This is to ensure that DFU complete
successfully and that the entire image is safely store on the device to avoid losing the application code.

e User Data: This 28KB section of flash memory is reserved for config settings. It uses an open source file system
called the Newtron Flash File System, which is part of the OpenSource Mynewt operating system. Bonding data
is stored here, for example, when you bond the nRF52 with another Central device.

e DFU Bootloader: This section of flash memory stores the actual bootloader code that will be executed by the
MBR described earlier.

SRAM Layout

The nRF52832 has 64KB of SRAM available, and actual memory use will depend on your project, although the stack
and heap memory locations are described below:

e Soft Device: amount of SRAM exclusive allocated for SoftDevice by Linker script. The size is subject to change
and varies by releases. For BSP release 0.8.0 it is 12.5 KB. However, the actual memory required by the
SoftDevice depends on the run-time configuration determined by Bluefruit's configNNN() API.

e Sketch BSS: static and global data used by your sketch.

e Heap Memory: The largest memory region, this is used for allocating the real time operating systems (RTOS)
thread stack, malloc() etc. The size, based on the variables shown below, is Y =64 -12.5 - X - 2 (KB ), where
12.5KB will vary depending on the SoftDevice used.

e Stack Memory: Used by non RTOS thread code, this is mostly for Interrupt Service Routines (ISRs) and
SoftDevice API calls. The current size is 2 KB.

Functions affecting SoftDevice SRAM usage
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The Bluefruit nRF52 configNNN() functions set the behavior of SoftDevice, thus determining the total SRAM usage.
These functions must be called before begin().

e configUuid128Count() : Defines the number of UUID128 entries that the SoftDevice supports, e.g Bleuart,
BleMidi, or other services and characteristics. Default value is 10.

e configAttrTableSize(): The total size of the attribute table, which holds services and characteristics. If your
application needs lots of characteristics you may need to increase this. Default value is 2048 bytes.

e configPrphConn(), configPrphBandwidth(): These function set the parameters that determine the bandwidth for
peripheral's connections. configPrphBandwidth() is a convenient helper that calls configPrphConn() with
appropriate parameters.

e configCentralConn(), configCentralBandwidth(): These functions set the parameters that determine the
bandwidth for central mode connections. configCentralBandwidth() is a convenient helper that calls
configCentralConn() with appropriate parameters.

e begin(): Bluefruit nRF52's begin() function also affects the bandwidth since it takes 2 (optional) parameters. The
first one is the number of concurrent connections for peripheral links (to mobile phones, your computer, etc.), the
second one is the number of central links (to BLE accessories, or another feather52 running in peripheral mode).
The maximum number of concurrent connections for SoftDevice v5.x is 20.

0x2000 FFFF

Actual usage depend
on configuration®®

Bluefruit nRF52 §132 v5.x.x SRAM Usage

If you run into an error message saying "SoftDevice require more SRAM than provided by linker", try altering
your system config -- for ex. lower bandwidth, fewer connection or a smaller attribute table size. Another

advanced option is to modify the linker script, but this should be done with care and knowledge of what you
are changing.

[CFG] SoftDevice config requires more SRAM than provided by the linker.
App Ram Start must be at least 0x20004180 (provided 0x20003200).
Please update linker file or re-config SoftDevice.

© Adafruit Industries https://learn.adafruit.com/bluefruit-nrf52-feather-learning-guide Page 145 of 158



© Adafruit Industries https://learn.adafruit.com/bluefruit-nrf52-feather-learning-guide Page 146 of 158



Software Resources

To help you get your Bluefruit LE module talking to other Central devices, we've put together a number of open source
tools for most of the major platforms supporting Bluetooth Low Energy.

Bluefruit LE Client Apps and Libraries

Adafruit has put together the following mobile or desktop apps and libraries to make it as easy as possible to get your
Bluefruit LE module talking to your mobile device or laptop, with full source available where possible:

Bluefruit LE Connect (Android/Java)

Bluetooth Low Energy support was added to Android starting with Android 4.3 (though it was only really stable starting
with 4.4), and we've already released Bluefruit LE Connect to the Play Store.

The full source code for Bluefruit LE Connect for Android is also available on Github to help you get started with your
own Android apps. You'll need a recent version of Android Studio to use this project.

Ny Adafruit Bluefruit LE Connect

Adafruit Industries Education (a8 8 8 FYN)
—
El PEGI 3

"
hl u Efru It © This app is compatible with some of your devices
m

Bluefruit LE Connect (iOS/Swift)

Apple was very early to adopt Bluetooth Low Energy, and we also have an iOS version of the Bluefruit LE Connect app
available in Apple's app store.

The full swift source code for Bluefruit LE Connect for iOS is also available on Github. You'll need XCode and access to
Apple's developper program to use this project:

e Version 1.x source code: https://github.com/adafruit/Bluefruit_LE_Connect
® Version 2.x source code: https://github.com/adafruit/Bluefruit_LE_Connect_v2

Version 2.x of the app is a complete rewrite that includes iOS, OS X GUI and OS X command-line tools in a

single codebase.
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View More by This Developer

Adafruit Bluefruit LE Connect
By Adafruit Industries

Open iTunes to buy and download apps.

Description

Adafruit Industries Web Site » Adafruit Bluefruit LE Connect Support » Mare

What's New in Version 1.7

« Apple Wa

View in iTunes RN TEER L S e T S vCh
» Bugfixes for XML pa n DFU mode

bioth iPhio

Bluefruit LE Connect for OS X (Swift)

This OS X desktop application is based on the same V2.x codebase as the iOS app, and gives you access to BLE
UART, basic Pin I/0O and OTA DFU firmware updates from the convenience of your laptop or mac.

This is a great choice for logging sensor data locally and exporting it as a CSV, JSON or XML file for parsing in another
application, and uses the native hardware on your computer so no BLE dongle is required on any recent mac.

The full source is also available on Github.

I Lt s e o s

e 1

Bluefruit LE Command Line Updater for OS X (Swift)

This experimental command line tool is unsupported and provided purely as a proof of concept, but can be used to
allow firmware updates for Bluefruit devices from the command line.

This utility performs automatic firmware updates similar to the way that the GUI application does, by checking the
firmware version on your Bluefruit device (via the Device Information Service), and comparing this against the firmware
versions available online, downloading files in the background if appropriate.

Simply install the pre-compiled tool via the DMG file and place it somewhere in the system path, or run the file locally
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via './bluefruit' to see the help menu:

$ ./bluefruit
bluefruit v0.3
Usage:
bluefruit <command> [options...]

Commands :

Scan peripherals: scan

Automatic update: update [--enable-beta] [--uuid <uuid>]

Custom firmware: dfu --hex <filename> [--init <filename>] [--uuid <uuid>]

Show this screen: --help

Show version: --version
Options:

--uuid <uuid> If present the peripheral with that uuid is used. If not present a list of peripherals
--enable-beta If not present only stable versions are used

Short syntax:
-u = --uuid, -b = --enable-beta, -h = --hex, -i = --init, -v = --version, -? = --help

1 | >

Deprecated: Bluefruit Buddy (OS X)

This native OS X application is a basic proof of concept app that allows you to connect to your Bluefruit LE module
using most recent macbooks or iMacs. You can get basic information about the modules and use the UART service to
send and receive data.

The full source for the application is available in the github repo at Adafruit_BluefruitLE_OSX.

W Feer P D Ve 08 Wi L) f T e IR OO Tedmie O

ABLE (Cross Platform/Node+Electron)

ABLE (Adafruit Bluefruit LE Desktop) is a cross-platform desktop application based on Sandeep Misty's noble
library and the Electron project from Github (used by Atom).
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It runs on OS X, Windows 7+ and select flavours of Linux (Ubuntu tested locally). Windows 7 support is particularly
interesting since Windows 7 has no native support for Bluetooth Low Energy but the noble library talks directly to
supported Bluetooth 4.0 USB dongles to emulate BLE on the system (though at this stage it's still in early BETA and
drops the connection and takes more care to work with).

This app allows you to collect sensor data or perform many of the same functionality offered by the mobile Bluefruit LE
Connect apps, but on the desktop.

The app is still in BETA, but full source is available in addition to the easy to use pre-compiled binaries.

HAdairuit Bhoefnas LE

¥ Bluefruit LE

Adafruit
Bluefruit LE

UART

Information
Caontrol

Calor

Bluefruit LE Python Wrapper

As a proof of concept, we've played around a bit with getting Python working with the native Bluetooth APIs on OS X
and the latest version of Bluez on certain Linux targets.

There are currently example sketches showing how to retreive BLE UART data as well as some basic details from the
Device Information Service (DIS).

This isn't an actively support project and was more of an experiment, but if you have a recent Macbook or a Raspberry
Pi and know Python, you might want to look at Adafruit_Python_BluefruitLE in our github account.

Debug Tools

If your sense of adventure gets the better of you, and your Bluefruit LE module goes off into the weeds, the following
tools might be useful to get it back from unknown lands.
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These debug tools are provided purely as a convenience for advanced users for device recovery purposes,

and are not recommended unless you're OK with potentially bricking your board. Use them at your own risk.

AdaLink (Python)

This command line tool is a python-based wrapper for programming ARM MCUs using either aSegger J-Link or an
STLink/V2. You can use it to reflash your Bluefruit LE module using the latest firmware from the Bluefruit LE firmware
repo.

Details on how to use the tool are available in the readme.md file on the main Adafruit_Adalink repo on Github.

Completely reprogramming a Bluefruit LE module with AdaLink would require four files, and would look something like
this (using a JLink):

adalink nrf51822 --programmer jlink --wipe
--program-hex "Adafruit BluefruitLE Firmware/softdevice/s110 nrf51 8.0.0 softdevice.hex"
--program-hex "Adafruit BluefruitLE Firmware/bootloader/bootloader 0002.hex"
--program-hex "Adafruit BluefruitLE Firmware/0.6.7/blefriend32/blefriend32 s110 xxac 0 6 7 150917 bleft
--program-hex "Adafruit BluefruitLE Firmware/0.6.7/blefriend32/blefriend32 s110 xxac 0 6 7 150917 blefr

/ | i3

You can also use the Adalink tool to get some basic information about your module, such as which SoftDevice is
currently programmed or the IC revision (16KB SRAM or 32KB SRAM) via the --info command:

$ adalink nrf51822 -p jlink --info
Hardware ID : QFACA10 (32KB)
Segger ID : nRF51822 xxAC

SD Version : S110 8.0.0

Device Addr : ¥k pdkpsoksok ok
DeViCe ID : 3k 3k 5k 3k >k >k K 3k ok 5k >k >k ok kK ok

Adafruit nRF51822 Flasher (Python)

Adafruit's nRF51822 Flasher is an internal Python tool we use in production to flash boards as they go through the test
procedures and off the assembly line, or just testing against different firmware releases when debugging.

It relies on AdaLink or OpenOCD beneath the surface (see above), but you can use this command line tool to flash
your nRF51822 with a specific SoftDevice, Bootloader and Bluefruit firmware combination.

It currently supports using either a Segger J-Link or STLink/V2 via AdaLink, orGPIO on a Raspberry Piif you don't have
access to a traditional ARM SWD debugger. (A pre-built version of OpenOCD for the RPi is included in the repo since

building it from scratch takes a long time on the original RPi.)

We don't provide active support for this tool since it's purely an internal project, but made it public just in case it might
help an adventurous customer debrick a board on their own.
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$ python flash.py --jtag=jlink --board=blefriend32 --softdevice=8.0.0 --bootloader=2 --firmware=0.6.7
jtag : jlink

softdevice : 8.0.0

bootloader : 2

board : blefriend32

firmware : 0.6.7

Writing Softdevice + DFU bootloader + Application to flash memory

adalink -v nrf51822 --programmer jlink --wipe --program-hex "Adafruit BluefruitLE Firmware/softdevice/sl

/ | i3
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Downloads

The following resources may be useful working with the Bluefruit nRF52 Feather:

Adafruit_nRF52_Arduino: The core code for this device (hosted on Github)

nRF52 Example Sketches: Browse the example code from the core repo on Github
nRF52832 Product Specification: Key technical documentation for the nRF52832 SoC
EagleCAD PCB files on GitHub

Feather Bluefruit NRF52 Pinout Diagram

https://adafru.it/z4c

Module Details

The Bluefruit nRF52 Feather uses the MDBT42Q module from Raytac. Details on the module, including FCC and other
certifications are available in the document below:

MDBT42Q-Version_B.pdf

https://adafru.it/vbb
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FAQs

NOTE: For FAQs relating to the BSP, see the dedicated BSP FAQ list.

What are the differences between the nRF51 and nRF52 Bluefruit boards? Which one should | be using?
The two board families take very different design approaches.

All of the nRF51 based modules are based on an AT command set (over UART or SPI), and require two MCUs to run:
the nRF51 hosting the AT command parser, and an external MCU sending AT style commands.

The nRF52 boards run code directly on the nRF52, executing natively and calling the Nordic S132 SoftDevice (their
proprietary Bluetooth Low Energy stack) directly. This allows for more efficient code since there is no intermediate
AT layer or transport, and also allows for lower overall power consumption since only a single device is involved.

The nRF52 will generally give you better performance, but for situation where you need to use an MCU with a
feature the nRF52 doesn't have (such as USB), the nRF51 based boards will still be the preferable solution.

Can | run nRF51 Bluefruit sketches on the nRF52?
No. The two board families are fundamentally different, and have entirely separate APIs and programming models. If
you are migrating from the nRF51 to the nRF52, you will need to redesign your sketches to use the newer API,
enabling you to build code that runs natively on the nRF52832 MCU.

Can | use the nRF52 as a Central to connect to other BLE peripherals?
The S132 Soft Device and the nRF52832 HW support Central mode, so yes this is possible. At this early
development stage, though, there is only bare bones support for Central mode in the Adafruit nRF52 codebase,
simply to test the HW and S132 and make sure that everything is configured properly. An example is provided of
listening for incoming advertising packets, printing the packet contents and meta-data out to the Serial Monitor. We
hope to add further Central mode examples in the future, but priority has been given to the Peripheral APl and
examples for the initial release.

How are Arduino sketches executed on the nRF528327? Can | do hard real time processing (bit-banging NeoPixels,
etc.)?

In order to run Arduino code on the nRF52 at the same time as the low level Bluetooth Low Energy stack, the
Bluefruit nRF52 Feather uses FreeRTOS as a task scheduler. The scheduler will automatically switch between tasks,
assigning clock cycles to the highest priority task at a given moment. This process is generally transparent to you,
although it can have implications if you have hard real time requirements. There is no guarantee on the nRF52832
to meet hard timing requirements when the radio is enabled an being actively used for Bluetooth Low Energy. This
isn't possible on the nRF52832 even without FreeRTOS, though, since the SoftDevice (Nordic's propietary binary
blob stack) has higher priority than any user code, including control over interrupt handlers.

Can | use GDB to debug my nR528327
You can, yes, but it will require a Segger J-Link (that's what we've tested against anyway, other options exist), and
it's an advanced operation. But if you're asking about it, you probably know that.

Assuming you have the Segger J-Link drivers installed, you can start Segger's GDB Server from the command line
as follows (OSX/Linux used here):

$ JLinkGDBServer -device nrf52832_xxaa -if swd -speed auto

Then open a new terminal window, making sure that you have access to gcc-arm-none-eabi-gdb from the command
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line, and enter the following command:

$ ./arm-none-eabi-gdb something.ino.elf

" something.ino.elf " is the name of the .elf file generated when you built your sketch. You can find this by enabling
'Show verbose output during: [x] compilation' in the Arduino IDE preferences. You CAN run GDB without the .elf file,
but pointing to the .elf file will give you all of the meta data like displaying the actual source code at a specific
address, etc.

Once you have the (gdb) prompt, enter the following command to connect to the Segger GDB server (updating
your IP address accordingly, since the HW isn't necessarily local!):

(gdb) target remote 127.0.0.1:2331

If everything went well, you should see the current line of code where the device is halted (normally execution on
the nRF52 will halt as soon as you start the Segger GDB Server).

At this point, you can send GDB debug commands, which is a tutorial in itself! As a crash course, though:

® To continue execution, type ' monitor go ' then 'continue '

e To stop execution (to read register values, for example.), type ' monitor halt '

e To display the current stack trace (when halted) enter 'bt '

e To get information on the current stack frame (normally the currently executing function), try these:
info frame : Display info on the current stack frame

o info args : Display info on the arguments passed into the stack frame

o info locals : Display local variables in the stack frame

o info registers : Dump the core ARM register values, which can be useful for debugging specific fault
conditions

Are there any other cross platform or free debugging options other than GDB?
If you have a Segger J-Link, you can also use Segger's OZone debugger GUI to interact with the device, though
check the license terms since there are usage restrictions depending on the J-Link module you have.

You will need to connect your nRF52 to the J-Link via the SWD and SWCLK pins on the bottom of the PCB, or if you
are OK with fine pitch soldering via the SWD header.

You can either solder on a standard 2x5 SWD header on the pad available in the board, or you can solder wires to
the SWD and SWCLK pads on the bottom of the PCB and use an SWD Cable Breakout Board, or just connect cables
directly to your J-Link via some other means.

You will also need to connect the VTRef pin on the JLink to 3.3V on the Feather to let the J-Link know what voltage
level the target has, and share a common GND by connecting the GND pins on each device.

Before you can start to debug, you will need to get the .elf file that contains all the debug info for your sketch. You
can find this file by enabling Show Verbose Output During: compilation in the Arduino Preferences dialogue box.
When you build your sketch, you need to look at the log output, and find the .elf file, which will resemble something
like this (it will vary depending on the OS

used): /var/folders/86/hb2vp14n5_5_yvdz_z8w9x_c0000gn/T/arduino_build_118496/ancs_oled.ino.elf

In the OZone New Project Wizard, when prompted to select a target device in OZone select nRF52832_xxAA, then
make sure that you have set the Target Interface for the debugger to SWD, and finally point to the .elf file above:
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# New Project Wizard

Target Device
Choose a Target Device

Device

nRFS2832 _ouhn,

Peripherals (optional)

Cancel < Back MNext >

® @ Z New Project Wizard

Connection Settings
Choose a Target and Host Interface

Target Interface Target Interface Speed

| SWD 1 MHz

Host Interface

uss

Serial No (optional)

Cancel < Back —

® @ Z New Project Wizard

Data File
Choose the Program to be debugged

Data File (optional)

l_zsng_cﬂﬂﬂﬂgn}ﬂarduinn_huild_113495,‘ancs_nled,inn.elf |

Cancel < Back “

Next select the Attach to running program option in the top-left hand corner, or via the menu system, which will cause
the debugger to connect to the nRF52 over SWD:

© Adafruit Industries https://learn.adafruit.com/bluefruit-nrf52-feather-learning-guide Page 156 of 158



o0 e®
O~-liker-at ¢
Fund () Download & Reset Program  in.
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L N ] < Ozone - The J-Link Debugger V2,32 - jvar/folders/B6/hb2vp1 4nS_5_yvdz_z8wi_c0000gn) Tlarduina_build_118496/ancs_oled.ing.olf
Gl dt
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__dmabi_atexit 4 2 Ivaid) arg; = am Current
Adiart_fune 13 3 RO e
_cxa_atexit 0 L L a1
—€xa_pure_vimual 1 35 #11 CFG_DEBUG LF]
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# BB ] :?‘ M RE
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B ] a3 1
o ] A4E loapld; ]
~ 45
8 et MAStr : a8 #if CFG_DEBUG = 1 ff Full L
= Detug
# _set CONTROL 1 47 static wint3Z_t meminfo_ms = @ : L
# _set_FPSCA 2 48 Af (meminfo_ms + MEMINFO_INTERVAL < millis i} RiZ
® s 1 a { LY
sRuthy e | W meainfo_ms += millisdl; ; Xid
- 51 Serial.printf( "Mesory Iafo (prist every % ecoads)\n™ , MEMIN &
—sfmoreglue 17 57 dbgeslafe [); RIS
—sfp 52 53 ¥ ¥ AFR
_shpute_r 2 54 Bendif Y| om e
shputs 18 35
_‘] o i 38 #f To compatible with most code where loog is not rtos-aware ] sk
it 578 taskYIELD (}; /7 vTaskDelay(1); i
—Smakebud ¢ 1 8 } BasePri
—sread 14 % ) FauhMask
ek 14 :‘ i # Contral
SpUts ¢ k] sl = [
= - 62 1 Ma A 1
- i " - :F\hnt in emtry point of Arduime application =
u | Consele x
| Project SetDevice (nRFSIBI2_xxAA'
SetHostIF (USE", "k
Project.SetTargetiF (SWO'L
Project.SetTiFSpeed "1 MHZT);

Praject. AddSvdFile ' /Volumes/Ozore_MacO
File.Open (" jvar lfolders/ 86/ Mb2vpl4n3 5 y
File.Open: completed in 308 my
Debuwg. SetConnectiode ICM_ATTACH),
Debuag Startd;

J-Link: conmected to target device
execwted J-Link command “ReadimtoTraceCa
exscuted J-Link command “ReadimoTraceCa

LnG4 Ch1  Conmected @ 1 MHZ

At this point, you can click the PAUSE icon to stop program execution, and then analyze variables, or set breakpoints
at appropriate locations in your program execution, and debug as you would with most other embedded IDEs!
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- L Rasl HE as H
T smakebed_r o Tn " g Wegisvers § 50011158 X
sread 14 52} | Narme Wahoe
sveek 14 g‘ = am Currend
1 Je | LELLEE LN
:IWF‘_{ :; :i :}\brl:f Main entry point of Arduino applicatiosm . : e —
iy [F] LERTDE ] o]
Memoryl @ 0 % | Comole x
@4 20 8 E5 @8 B0 79 B3 0@ B0 (3 B2 W W [Progect. SettioselF CUSE, ™),
BlpERRld B3 @5 00 BB B0 @5 00 97 85 00 Be B9 B0 0 M (Pregeet. SetTangenif
Laiarll 80 oR o0 BB 00 B0 B 0 B B9 B9 W W Progect-SetTiFSpend 1 Mz
BepRREIR AL @5 00 B 00 0B 00 AB 05 09 B0 BS RS W W ProgectAddSwdfile © MVolumes /Orone_MacO
BDRRRAR BF @5 00 @0 L9 @5 00 D3 85 99 00 DD B85 W0 W [File.Open [ fvar ffolders [B8/hb2valdns 5 _y
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BODEORTE 37 B6 00 B0 41 06 00 45 06 00 09 55 6 0 W
BODOORED SF O6 00 0B &9 06 00 73 06 09 09 7D 06 0 W J=Limic: connectsd to target device
B7 @6 20 80 91 06 00 98 BE B9 B AS B4 M W eneCubed |- Link command “ReadintsTraceCa
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Clicking on the left-hand side of the text editor will set a breakpoint on line 69 in the image below, for example, and
the selecting Debug > Reset > Reset & Run from the menu or icon will cause the board to reset, and you should stop
at the breakpoint you set:

| N ] ‘<, Ozone - The J-Link Debugger v2.32 -mrmm1mjmwwﬂﬁwmm
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s 3 |eEEE » DHPUT_PULLUP )5 Sled. Begin B
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You can experiment with adding some of the other debug windows and options via the View menu item, such as
the Call Stack which will show you all of the functions that were called before arriving at the current breakpoint:

© Adafruit Industries Last Updated: 2018-01-05 07:00:48 AM UTC Page 158 of 158



m “ “mqm mmm m
wha kb : i - m
G |

i 4
i

1 iy : i

fi g .
ik 1 .
HISEE

g i i wm w

§ 53 4 0y g

HIE TE B R
Loh ﬂmw_.mmmmmﬁw_w

o - ol Il | EaL i
AN ]
B I (EE R R
m__ B FEs = =8 M WEEE N 2§ @ ENEN W ““““n“HMM“M

SUREREREEREIRIE

RARARISASISIsIRECREECERBE
35 Wit % &T

_uuﬂmuuuummuu_uum“

¢n||u|||:==||:|u|

| Oeene

LR

Dedidand
sy

L )

zzzzIIIEG

-m:mm $.la srzzzzess
srEEsEEss

_E_:_:_::E_E_ e

TIEIT
ILCITLTTTET

: ! ll _“mw :m; ik m_w il

._._. BELRLL T T T e T




	Guide Contents
	Introduction
	nRF52832 Technical Details
	nRF51 or nRF52 Bluefruit Devices?
	Device Pinout
	Special Notes
	Power Pins
	Analog Inputs
	PWM Outputs
	I2C Pins
	Assembly
	Header Options!
	Soldering in Plain Headers
	Prepare the header strip:
	Add the breakout board:
	And Solder!

	Soldering on Female Header
	Tape In Place
	Flip & Tack Solder
	And Solder!

	Arduino BSP Setup
	1. BSP Installation
	Recommended: Installing the BSP via the Board Manager

	2. Third Party Tool Installation
	nrfutil (OS X and Linux Only)

	3. Advanced Option: Manually Install the BSP via 'git'
	Adafruit nRF52 BSP via git (for core development and PRs only)

	BSP FAQs
	Windows Related
	OS X Related
	I can compile and link sketches on OS X, but nrfutil gives me the following error: 'AttributeError: 'int' object has no attribute 'value''?
	Linux Related
	On Linux I'm getting 'arm-none-eabi-g++: no such file or directory', even though 'arm-none-eabi-g++' exists in the path specified. What should I do?

	Arduino Board Setup
	1. Select the Board Target
	2. Select the USB CDC Serial Port
	Non OS X Operating Systems
	OS X Only

	3. Run a Test Sketch
	Using the Bootloader
	Forcing Serial Boot Mode
	Factory Reset
	Advanced: OTA DFU Bootloader
	Advanced: Upgrading an Existing Bootloader
	Flashing the Bootloader
	Third Party Tool Requirements
	JLink Drivers and Tools

	Burning the Bootloader from the Arduino IDE
	Manually Burning the Bootloader via nrfjprog
	Manually Burning the Bootloader via AdaLink
	Examples
	Example Source Code
	Documented Examples
	Advertising: Beacon
	Complete Code
	Output
	BLE UART: Controller
	Setup
	Complete Code
	Custom: HRM
	HRM Service Definition
	Implementing the HRM Service and Characteristics
	Service + Characteristic Setup Code Analysis

	Full Sample Code
	BLE Pin I/O
	Setup
	Complete Code
	Central BLEUART
	Client Services
	Scanner
	Central Role
	Full Sample Code
	Dual Roles BLEUART
	Server & Client Service Setup
	Peripheral Role
	Central Role
	Advertising and Scanner
	Full Sample Code
	Bluefruit nRF52 API
	AdafruitBluefruit
	API
	Examples
	BLEGap
	BLEAdvertising
	API
	Related Information
	Example
	BLEScanner
	API
	setRxCallback(rx_callback_t fp)
	void useActiveScan(bool enable);
	void filterRssi(int8_t min_rssi); void filterMSD(uint16_t manuf_id); void filterUuid(BLEUuid ble_uuid); void filterUuid(BLEUuid ble_uuid1, BLEUuid ble_uuid2); void filterUuid(BLEUuid ble_uuid1, BLEUuid ble_uuid2, BLEUuid ble_uuid3); void filterUuid(BLEUuid ble_uuid1, BLEUuid ble_uuid2, BLEUuid ble_uuid3, BLEUuid ble_uuid4); void filterUuid(BLEUuid ble_uuid[], uint8_t count);
	void clearFilters(void);
	bool start(uint16_t timeout = 0); bool stop(void);
	void restartOnDisconnect(bool enable);

	Examples
	BLEService
	Basic Usage
	Order of Operations (Important!)
	API
	Example
	BLECharacteristic
	Basic Usage
	Order of Operations (Important!)
	API
	Example
	BLEDiscovery
	API
	BLEDis
	API
	Example
	Output
	BLEUart
	API
	Example
	BLEClientUart
	API
	Examples
	BLEBeacon
	API
	Example
	Testing
	BLEMidi
	API
	Installing the Arduino MIDI Library
	Example
	Usage

	BLEHidAdafruit
	API
	Example Sketches
	Bonding HID Devices
	Setting up your Bluefruit device for bonding
	Bonding on iOS
	Testing the HID Keyboard and Bonding

	BLEAncs
	API
	ANCS OLED Example
	Sketch Requirements
	Loading the Sketch
	Pairing to your Mobile Device
	Wait for Alerts

	BLEClientCts
	API
	Client CTS OLED Example
	Sketch Requirements
	Loading the Sketch
	Pairing to your Mobile Device
	Wait for Time Data

	BLECentral
	nRF52 ADC
	Analog Reference Voltage
	Analog Resolution
	Default ADC Example (10-bit, 3.6V Reference)
	Advanced Example (12-bit, 3.0V Reference)
	Memory Map
	Flash Memory
	Bootloader v5.1.0 with S132 v5.x.x Dual and Single Bank
	Bootloader v0.5.0 with S132 v2.x.x Dual banks

	SRAM Layout
	Functions affecting SoftDevice SRAM usage

	Software Resources
	Bluefruit LE Client Apps and Libraries
	Bluefruit LE Connect (Android/Java)
	Bluefruit LE Connect  (iOS/Swift)

	Bluefruit LE Connect for OS X (Swift)
	Bluefruit LE Command Line Updater for OS X (Swift)
	Deprecated: Bluefruit Buddy (OS X)
	ABLE (Cross Platform/Node+Electron)
	Bluefruit LE Python Wrapper

	Debug Tools
	AdaLink (Python)
	Adafruit nRF51822 Flasher (Python)

	Downloads
	Module Details
	Schematic
	FAQs
	What are the differences between the nRF51 and nRF52 Bluefruit boards? Which one should I be using?
	Can I run nRF51 Bluefruit sketches on the nRF52?
	Can I use the nRF52 as a Central to connect to other BLE peripherals?
	How are Arduino sketches executed on the nRF52832? Can I do hard real time processing (bit-banging NeoPixels, etc.)?
	Can I use GDB to debug my nR52832?
	Are there any other cross platform or free debugging options other than GDB?


